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Preface 

This preface provides supporting information for the Oracle Financial Services Data Management 

(OFS DM) Pack Installation Guide and includes the following topics: 

• Summary 

• Audience 

• Documentation Accessibility 

• Related Documents 

• Conventions and Acronyms 

Summary 

You can find the latest copy of this document in OHC Documentation Library which includes all 

the recent additions/revisions (if any) done till date. 

Before you begin the installation, ensure that you have an access to the Oracle Support Portal 

with the required login credentials to quickly notify us of any issues at any stage. You can obtain 

the login credentials by contacting Oracle Support. 

Audience 

The OFS DM pack Installation and Configuration Guide is intended for Administrators, Business 

User, Strategists, and Data Analyst, who are responsible for installing and maintaining the 

application pack components.  

The document assumes you have experience in installing Enterprise components. Basic 

knowledge about the OFS DM pack components, OFSAA Architecture, UNIX commands, 

Database concepts and Web Server/ Web Application Server is recommended. 

Prerequisites for the Audience 

Following are the expected preparations from the administrator before starting the actual 

installation: 

The document assumes that you have experience in installing Enterprise components and 

basic knowledge about the following is recommended: 

• Oracle Financial Services Data Management pack components 

• OFSAA Architecture 

• UNIX Commands 

• Database Concepts 

• Web Server/ Web Application Server 

https://docs.oracle.com/cd/E93133_01/install.htm
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Documentation Accessibility 

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility 

Program website at 

http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc 

Access to Oracle Support 

Oracle customers have access to electronic support through My Oracle Support. For 

information, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info  

Or, 

Visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are 

hearing impaired. 

Related Documents 

This section identifies additional documents related to OFS DM Infrastructure. You can access 

Oracle documentation online from OHC Documentation Library. 

• Oracle Financial Services Analytical Applications Reconciliation Framework User Guide 

Release 8.0.6.0.0 (OHC) 

• Oracle Financial Services Data Foundation Installation Guide Release 8.0.6.0.0 (OHC) 

• Oracle Financial Services Data Foundation Release User Guide 8.0.6.0.0 (OHC) 

• Oracle Financial Services Data Governance for US FED Regulatory User Guide Reporting 

Release 8.0.6.0.0 (OHC) 

• Oracle Financial Services Data Governance for European Central Reporting User Guide 

Release 8.0.6.0.0 (OHC) 

• Oracle Financial Services Analytical Applications Infrastructure User Guide Release 8.0.6.0.0 

(OHC) 

Conventions and Abbreviations 

The following text conventions are used in this document: 

Conventions Description 

boldface 
Boldface type indicates graphical user interface elements associated 
with an action, or terms defined in text or the glossary. 

italic 
Italic type indicates book titles, emphasis, or placeholder variables for 
which you supply particular values. 

monospace 
Monospace type indicates commands within a paragraph, URLs, code in 
examples, text that appears on the screen, or text that you enter. 

 

The following table lists the abbreviations used in this document: 

http://www.oracle.com/pls/topic/lookup?ctx=acc&amp;id=docacc
http://www.oracle.com/pls/topic/lookup?ctx=acc&amp;id=info
http://www.oracle.com/pls/topic/lookup?ctx=acc&amp;id=trs
https://docs.oracle.com/cd/E93133_01/homepage.htm
https://docs.oracle.com/cd/E92917_01/install.htm
https://docs.oracle.com/cd/E92917_01/homepage.htm
https://docs.oracle.com/cd/E93133_01/homepage.htm
https://docs.oracle.com/cd/E93133_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
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Abbreviation Meaning 

AIX Advanced Interactive executive 

DEFQ Data Entry Forms and Queries 

DML Data Manipulation Language 

EAR Enterprise Archive 

EJB Enterprise JavaBean 

ERM Enterprise Resource Management 

FTP File Transfer Protocol 

GUI Graphical User Interface 

HTTPS Hypertext Transfer Protocol Secure 

J2C J2EE Connector 

J2EE Java 2 Enterprise Edition 

JDBC Java Database Connectivity 

JDK Java Development Kit 

JNDI Java Naming and Directory Interface 

JRE Java Runtime Environment 

JVM Java Virtual Machine 

LDAP Lightweight Directory Access Protocol 

LHS Left Hand Side 

MOS My Oracle Support 

OFS Oracle Financial Services 

OFSAAI Oracle Financial Services Analytical Application Infrastructure OLAP 

OSDC Oracle Software Delivery Cloud 

OS Operating System 

RAM Random Access Memory 

RDMS Relational Database Management System 

SFTP Secure File Transfer Protocol 

SID System Identifier 
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Abbreviation Meaning 

SSL Secure Sockets Layer 

TNS Transparent Network Substrate 

URL Uniform Resource Locator 

VM Virtual Machine 

Web Archive WAR 

XML Extensible Markup Language 
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1 Introduction to OFS DM Application Pack 

This chapter includes the following topics: 

About Oracle Financial Services Analytical Applications (OFSAA) 

About Oracle Financial Services Analytical Applications (OFSAA) Applications Pack 

About Oracle Financial Services Data Management 8.0.6.0.0 Applications Pack 

1.1 About Oracle Financial Services Analytical Applications (OFSAA) 

In today's turbulent markets, financial institutions require a better understanding of their risk-return, while strengthening 

competitive advantage and enhancing long-term customer value. Oracle Financial Services Analytical Applications 

(OFSAA) enable financial institutions to measure and meet risk adjusted performance objectives, cultivate a risk 

management culture through transparency, lower the costs of compliance and regulation, and improve insight into 

customer behavior. 

OFSAA uses industry-leading analytical methods, shared data model and applications architecture to enable 

integrated risk management, performance management, customer insight, and compliance management. OFSAA 

actively incorporates risk into decision making, enables to achieve a consistent view of performance, promote a 

transparent risk management culture, and provide pervasive intelligence. 

Oracle Financial Services Analytical Applications delivers a comprehensive, integrated suite of financial services 

analytical applications for both banking and insurance domain.  

1.2 About Oracle Financial Services Analytical Applications (OFSAA) Pack 

OFSAA applications are packaged, and released as Application Packs starting from 8.0 release. An Application Pack 

is a group of OFSAA products packaged together in a single installer and addresses specific functional area via its 

products that are grouped together. Packaging applications in a group ensures simplified installation, maintenance, 

development and integration in an integrated deployment. 

The following figure depicts the various application packs that are available across the OFSAA Banking and Insurance 

domains: 
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1.3 About Oracle Financial Services Data Management Application Pack 8.0.6.0.0 

This is a fresh installer of Data Management Pack. It installs three applications OFS Reconciliation Framework 

8.0.6.0.0, OFS Data Governance for European Central Reporting 8.0.6.0.0, and OFS Data Governance for US FED 

Regulatory Reporting 8.0.6.0.0. 

OFS DM Application Pack includes the following applications: 

 

• Oracle Financial Services Reconciliation Framework: Reconciles the balances from the operational systems of 

a bank with the balances as maintained in the General Ledger (hereinafter referred to as GL) of the bank. With this 

application banks can also reconcile between General Ledgers maintained in the bank. The balances in the GL of 

a bank are the ones which are audited and duly certified by the internal and external auditors. The GL balances 

are considered to be the final version of truth in a bank. Therefore, all data extracted from any other operational 

systems of a bank must be reconciled with the balances maintained in the GL to ensure that they are complete, 

accurate, and comprehensive. It then acts as an authentic and reliable base for any further decision making. 

• Oracle Financial Services Data Governance for US Regulatory Reporting: Oracle Financial Services Data 

Governance for US Regulatory Reporting operationalizes the data governance process. The OFSAA Data 

Governance for US Regulatory Reporting (DGUSRR) enables financial institutions to map multiple data sources to 

a standard, common business glossary. Oracle Financial Services Data Governance for US Regulatory Reporting 

automates and operationalizes governance for US regulatory reports to support the Data Management Office, 

Chief Data Officer, Chief Financial Officer, and Regulatory Reporting teams in their efforts to implement effective 

data management program to comply with internal and external regulatory standards. It is a content based 

governance solution with an active repository themed around regulatory reporting in the United States. The 

solution ensures accuracy and confidence on the data and the processes used for US regulatory reporting.  

The solution provides:  

o Pre-packaged controls on data elements and processes around it to monitor quality and timeliness of 

data 

o Pre-packaged key indicators to monitor exceptions and variances in values of data elements early in the 

life cycle 

o Pre-packaged plans for regulatory report submissions and ability to track them to completion 

o Pre-packaged OFSAA Glossary and critical data elements 

o Issue and Action workflow to capture, manage and resolve exceptions in data life cycle 

o Metadata browser to show complete relationship and lineage of metadata with ability to perform impact 

analysis 

• Oracle Financial Services Data Governance for European Central Reporting: Oracle Financial Services Data 

Governance for European Central Reporting automates and operationalizes governance for regulatory reports to 

support the Data Management Office, Chief Data Officer, Chief Financial Officer, and Regulatory Reporting teams 
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in their efforts to implement effective data management program to comply with internal and external regulatory 

standards. It is a content based governance solution with an active repository themed around European Central 

Reporting. The solution ensures accuracy and confidence on the data and the processes used for European 

Central Reporting.  

The solution provides:  

o Pre-packaged controls on data elements and processes around it to monitor quality and timeliness of 

data 

o Pre-packaged key indicators to monitor exceptions and variances in values of data elements early in the 

life cycle 

o Pre-packaged plans for regulatory report submissions and ability to track them to completion 

o Pre-packaged OFSAA Glossary and critical data elements 

o Issue and Action workflow to capture, manage and resolve exceptions  in data life cycle 

o Metadata browser to show complete relationship and lineage of metadata with ability to perform impact 

analysis 

NOTE:  OFSAA DM Pack has to be used with other Application Packs such as: 

• Credit Risk Management Pack 

• Capital Adequacy Pack 

• Treasury Pack 

• Profitability Pack 

 

1.4 About OFSAA Infrastructure 

Oracle Financial Services Analytical Applications Infrastructure (OFS AAI) powers the Oracle Financial Services 

Analytical Applications family of products to perform the processing, categorizing, selection and manipulation of data 

and information needed to analyze, understand and report on specific performance, risk, compliance and customer 

insight issues by providing a strong foundation for the entire family of Oracle Financial Services Analytical Applications 

across the domains of Risk, Performance, Compliance and Customer Insight. 

1.4.1 Components of OFSAAI 

The OFSAA Infrastructure is comprised of a set of frameworks that operates on and with the Oracle Financial Services 

Analytical Applications Data Model and form the array of components within the Infrastructure.  

The OFSAA Infrastructure components/ frameworks are installed in two layers; primarily the Metadata Server and 

Infrastructure services run on one layer, and the UI and presentation logic runs on the other. The UI and presentation 

layer is deployed on any of the supported J2EE Servers. 

The following figure depicts the various frameworks and capabilities that make up the OFSAA Infrastructure:  
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2 Understanding OFS DM Application Pack Installation 

This chapter includes the following topics: 

• Installation Overview 

• Deployment Topology 

• Hardware and Software Requirements 

• Verifying the System Environment 

• Understanding Installation Modes 
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2.1 Installation Overview 

This section gives an overview of the OFS DM Application Pack Installation. The following figure shows the order of 

procedures you need to follow:  

 

 

Tasks Details and Documentation 

Verify Systems Environment To verify that your system meets the minimum necessary requirements for 
installing and hosting the OFS DM Application Pack, see Verifying System 
Environment. 

Obtain the software To access and download the OFS DM  Application Pack,  see Obtaining the 
software. 

Configure and Execute the Schema 
Creator Utility 

For instructions on creating the database schemas, see Configuring and Executing 
the Schema Creator Utility. 

Install OFS DM Application Pack For instructions on Installing OFS DM Application Pack , see Installing the OFS DM 
Pack Installer. 
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Tasks Details and Documentation 

Configure OFS DM Setup See Post Installation Configuration and Post Deployment. 

2.2 Deployment Topology 

The following figure depicts the typical deployment topology implemented for OFSAA applications.  

 

2.3 Hardware and Software Requirements 

This section describes the various Operating Systems, Database, Web Server, and Web Application Server versions, 

and other variant details on which this release of the Oracle Financial Services DM Application Pack has been 

qualified.  

NOTE:  OFS DM Application Pack installation can be performed on both Virtual and Physical servers. 

2.3.1 Configurations Supported for Java 7 

The following table shows the minimum hardware and software requirements for installing OFS DM Application Pack 

(for Java 7). 
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Requirement Sub-Category Value 

Operating System 
 

Oracle Linux / Red Hat Enterprise Linux (x86-64) 

Oracle Linux Server release 5.3 up to 5.10 - 64 bit 

Oracle Linux Server release 6.0 and above - 64 bit 

Note: Same versions of RHEL is supported 

Oracle Solaris (SPARC)/Solaris x86 
Oracle Solaris v5.10 Update 11 and above - 64 bit 

Oracle Solaris v5.11 update 1 and above – 64 bit 

IBM AIX (PowerPC) AIX 6.1 (TL 09 and above) - 64 bit  

Shell KORN Shell (KSH) 

Note: If the OS is IBM AIX 6.1, configure the size parameter setting for “Large File Support”. Refer link http://www-
01.ibm.com/support/docview.wss?uid=isg3T1000290 for more details. 

If the operating system is RHEL, install the package lsb_release using one of the following commands by logging in as root user: 

▪ yum install redhat-lsb-core 

▪ yum install redhat-lsb 

Java Runtime 
Environment 

Oracle Linux / Red Hat Enterprise Linux 

Oracle Solaris 

Oracle Java Runtime Environment (JRE) 1.7.x - 64 bit 

IBM AIX IBM AIX Runtime, Java Technology JRE 1.7.x - 64 bit 

Oracle Database 
Server and Client 

 

• Oracle Database Server Enterprise Edition 11g 

Release 2 (11.2.0.3.0 +) - 64 bit RAC/ Non-RAC 

with/ without partitioning option 

• Oracle Database Server Enterprise Edition 11g 

Release 2 (11.2.0.4.0 +) - 64 bit RAC/Non-RAC 

with/ without partitioning option, Advanced 

Security Option**. 

• Oracle Database Server Enterprise Edition 12c 

Release 1 (12.1.0.1.0 +) - 64 bit RAC/ Non-RAC 

with/ without partitioning option, Advanced 

Security Option** 

Note: See the “Additional Notes” section in the 806 
Tech Matrix for details. 

• Oracle Client 11g Release 2 (11.2.0.3.0+) - 64 bit 

http://www-01.ibm.com/support/docview.wss?uid=isg3T1000290
http://www-01.ibm.com/support/docview.wss?uid=isg3T1000290
https://docs.oracle.com/cd/E55339_01/homepage.htm
https://docs.oracle.com/cd/E55339_01/homepage.htm
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Requirement Sub-Category Value 

• Oracle Client 12c Release 1 (12.1.0.1.0+) - 64 bit 

• Oracle 11g Release 2 (11.2.0.3+) JDBC driver 

(Oracle thin driver) 

• Oracle 12C Release 1 (12.1.0.1+) JDBC driver 

(Oracle thin driver) 

• Oracle R Distribution (ORD) version 3.2.0/3.3.0 

3.0.1 (Optional) 

• Oracle R Enterprise (Server) version 1.5 with 

ORD 3.2.0 and version 1.5.1 with ORD 3.3.01.4 

(Optional). 

Note: 

Ensure that the following patches are applied: 

• For Oracle DB Server 12.1.0.1 and 12.1.0.2, 

download the patches 27010930 and 22205607 

from My Oracle Support and apply them.  

• For Oracle DB Server 11.2.0.4, download the 

patch 22205607 from My Oracle Support and 

apply.   

 
 

ORD and ORE versions compatible along with Oracle DB version 

 

No. Oracle R Enterprise Oracle R Advanced 
Analytics for 
Hadoop 

Open source R 
or Oracle R 
Distribution 

Oracle Database 
Enterprise Edition 

1 1.5.1 2.7.1 3.3.0 11.2.0.4, 12.1.0.1, 
12.1.0.2, 12.2.0.1 

2 1.5.0 2.5.1, 2.6.0, 2.7.0 3.2.0 11.2.0.4, 12.1.0.1, 
12.1.0.2 

 

OLAP 

Oracle Hyperion Essbase V 11.1.2.1+ (Server and Client) with Oracle 11g Database 

V 11.1.2.3+ (Server and Client) with Oracle 12c Database 

Oracle OLAP 

 

V 11.2.0.3+ with Oracle 11g Database 

V 12.1.0.1+ with Oracle 12c Database 
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Requirement Sub-Category Value 

Note: Oracle Hyperion Essbase & Oracle OLAP is required only if you are using the OLAP feature of OFSAAI. For Oracle 
OLAP, ensure that you have configured the Oracle Database server with OLAP option. 

Web Server/ Web 
Application Server 
 

Oracle Linux / Red Hat Enterprise Linux/ IBM AIX 

 

Oracle Solaris 

 

Oracle HTTP Server 11.1.1.1/ Apache HTTP Server 2.2.x/ 
IBM HTTP Server 

• Oracle WebLogic Server 12.1.2.0.0 (64 bit) 

• IBM WebSphere Application Server 8.5+  with bundled 

IBM Java Runtime (64 bit) 

• Apache Tomcat 8.0.x (64 bit) 

Note: OFSAA Infrastructure web component deployment on Oracle WebLogic Server with Oracle JRockit is not supported. 

Desktop 
Requirements 

 MS Windows 7 / Windows 8 / Windows 10 

Browser 
• Microsoft Internet  Browser 11.x 

• Chrome 57.x 

• FireFox 52.x 

• Oracle Java plug-in 1.7.0+ (64- bit) / Oracle Java 

plug-in 1.8.0+ (64- bit) 

Turn off Pop-up blocker settings. For more information, refer 
Internet Explorer Settings 

Office Tools MS Office 2007/ 2010/2013 

Adobe Acrobat Reader 8 or above 

Screen Resolution 1024*768 or 1280*1024 

Directory Services  

- 

OFSAAI is qualified on both OPEN LDAP 2.2.29+ and 
Oracle Internet Directory v 11.1.1.3.0. However, it can be 
integrated with other directory services software like MS 
Active Directory. 

Note: Configuration of Directory services software for OFSAAI installation is optional. For more information on 
configuration, see Infrastructure LDAP Configuration.  

Open LDAP needs to be installed on MS Windows Server machine only. 
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Requirement Sub-Category Value 

ETL Tool Oracle Data Integrator 11.1.1.7.0/11.1.1.9.0 

 

2.3.2 Configurations Supported for Java 8 

The following table shows the minimum hardware and software requirements for installing Oracle Financial Services 

Data Management Application Pack (Java 8) on each machine. 
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Requirement Sub-Category Value 

Operating System 

Oracle Linux / Red Hat Enterprise Linux (x86-64) 

Oracle Linux Server release 5.3 up to 5.10 - 64 bit 

Oracle Linux Server release 6.0 and above - 64 bit 

Note: Same versions of RHEL is supported 

Oracle Solaris (SPARC)/Solaris x86 
Oracle Solaris v5.10 Update 11 and above - 64 bit 

Oracle Solaris v5.11 update 1 and above – 64 bit 

IBM AIX (POWERPC) AIX 6.1 (TL 09 and above) - 64 bit  

Shell KORN Shell (KSH) 

Note: If the OS is IBM AIX 6.1, configure the size parameter setting for “Large File Support”. Refer link http://www-
01.ibm.com/support/docview.wss?uid=isg3T1000290 for more details. 

If the operating system is RHEL, install the package lsb_release using one of the following commands by logging in as root user: 

▪ yum install redhat-lsb-core 

▪ yum install redhat-lsb 

Java Runtime 
Environment 

Oracle Linux / Red Hat Enterprise Linux 

Oracle Solaris 

Oracle Java Runtime Environment (JRE) 1.8.x - 64 bit 

IBM AIX IBM AIX Runtime, Java Technology JRE 1.8.x - 64 bit 

Oracle Database 
Server and Client 

• Oracle Database Server Enterprise Edition 11g Release 2 (11.2.0.3.0 +) - 64 bit RAC/ Non-RAC with/ without 

partitioning option 

• Oracle Database Server Enterprise Edition 11g Release 2 (11.2.0.4.0 +) - 64 bit RAC/Non-RAC with/ without 

partitioning option, Advanced Security Option**. 

• Oracle Database Server Enterprise Edition 12c Release 1 (12.1.0.1.0 +) - 64 bit RAC/ Non-RAC with/ without 

partitioning option, Advanced Security Option**. 

Note: See the "Additional Notes" section in the 806 Tech Matrix for details. 

• Oracle Client 11g Release 2 (11.2.0.3.0+) - 64 bit 

• Oracle Client 12c Release 1 (12.1.0.1.0+) - 64 bit 

• Oracle 11g Release 2 (11.2.0.3+) JDBC driver (Oracle thin driver) 

• Oracle 12C Release 1 (12.1.0.1+) JDBC driver (Oracle thin driver) 

• Oracle R Distribution (ORD) version 3.2.0/3.3.0 (Optional) 

http://www-01.ibm.com/support/docview.wss?uid=isg3T1000290
http://www-01.ibm.com/support/docview.wss?uid=isg3T1000290
https://docs.oracle.com/cd/E55339_01/homepage.htm
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Requirement Sub-Category Value 

• Oracle R Enterprise (Server) version 1.5 with ORD 3.2.0 and version 1.5.1 with ORD 3.3.0(Optional). 

• ver) 

 

Note: Ensure that the following patches are applied: 

• Oracle Server 12c, v12.1.0.1 – 17082699 

• Oracle Server 12c, v12.1.0.2 - 19392604, 19649591 

• For Oracle DB Server 12.1.0.1 and 12.1.0.2, download the patches 27010930 and 22205607 from My Oracle 

Support and apply them.  

• For Oracle DB Server 11.2.0.4, download the patch 22205607 from My Oracle Support and apply.  Also for latest 

information, refer http://support.oracle.com/, 12.1.0.2 Bundle Patches for Engineered Systems and DB In-

Memory - List of Fixes in each Bundle (Doc ID 1937782.1). 

• Oracle R Enterprise 1.5 and 1.5.1 requires Oracle Database Enterprise Edition / 11.2.0.4/ 12.1.0.1/12.1.0.2/12.2.0.1. 

ORD and ORE versions compatible along with Oracle DB version 

No. Oracle R 
Enterprise 

Oracle R 
Advanced 
Analytics for 
Hadoop 

Open source R or Oracle R 
Distribution 

Oracle Database 
Enterprise Edition 

1 1.5.1 2.7.1 3.3.0 11.2.0.4, 12.1.0.1, 
12.1.0.2, 12.2.0.1 

2 1.5.0 2.5.1, 2.6.0, 
2.7.0 

3.2.0 11.2.0.4, 12.1.0.1, 
12.1.0.2 

 

 

Note: Oracle Hyperion Essbase & Oracle OLAP is required only if you are using the OLAP feature of OFSAAI. For Oracle 
OLAP, ensure that you have configured the Oracle Database server with OLAP option. 

Web Server/ Web 
Application Server 
 

Oracle Linux / Red Hat Enterprise Linux  

Oracle Solaris 

IBM AIX 

 

Oracle HTTP Server 11.1.1.1/ Apache HTTP Server 
2.2.x/ IBM HTTP Server 

• Apache Tomcat 8.0.x (64 bit) 

• Oracle Weblogic Server 12.1.3.0.0 

Note: 

• IBM WebSphere 8.5.x (Full Profile) on Java 8 

is not available. 

Note: OFSAA Infrastructure web component deployment on Oracle WebLogic Server with Oracle JRockit is not supported. 

http://support.oracle.com/
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Requirement Sub-Category Value 

Desktop 
Requirements 

Operating System MS Windows 7 / Windows 8 / Windows 10 

Browser 
• Microsoft Internet  Browser 11.x 

• Chrome 57.x 

• FireFox 52.x 

Turn off Pop-up blocker settings. For more information, 
refer Internet Explorer Settings 

Office Tools MS Office 2007/ 2010/2013 

Adobe Acrobat Reader 8 or above 

Screen Resolution 1024*768 or 1280*1024 

Other Software 

Directory Services 

OFSAAI is qualified on both OPEN LDAP 2.2.29+ and 
Oracle Internet Directory v 11.1.1.3.0. However, it can be 
integrated with other directory services software like MS 
Active Directory. 

Note: Configuration of Directory services software for OFSAAI installation is optional. For more information on 
configuration, see Infrastructure LDAP Configuration. Open LDAP needs to be installed on MS Windows Server machine 
only. 

ETL Tool 

Oracle Data Integrator 

11.1.1.7.0/11.1.1.9.0  - supported for Tomcat 8.x 

12.2.1.0.0 – supported for Oracle Weblogic Server 
12.1.3.0.0 

 

 

NOTE:  To upgrade an existing OFSAA 8.0.x Java 7 instance to Java 8, refer Appendix P. 

The following table shows the minimum software requirements for running OFS DM Application Pack on each 

machine. 

Operating System Database Web Application Server Web Server 

Oracle Linux 5.3 up to 5.10/ 
6.0 and above 

Oracle Database  Oracle WebLogic Server / 
Apache Tomcat Server 

Oracle HTTP Server/ 
Apache HTTP Server 
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Oracle Solaris 5.10/ 5.11 Oracle Database  Oracle WebLogic Server/ 
Apache Tomcat Server 

Oracle HTTP Server/ 
Apache HTTP Server 

IBM AIX 6.1 Oracle Database  IBM WebSphere 
Application Server/ Apache 
Tomcat Server 

IBM HTTP Server/ 
Apache HTTP Server 

2.4 Verifying the System Environment 

To verify if your system environment meets the minimum requirements for the installation, a Pre-Install Check utility 

(Environment Check) is available within the Install Kit archive file. This utility can also be obtained separately by 

contacting Oracle Support. 

Though the system environment verification is an integral and automated part of the installation of this software 

product, Oracle strongly recommends running this utility prior to beginning the installation as part of your organization’s 

"Installation Readiness Verification Process". 

NOTE:  For more details on download and usage of this utility, see Oracle Financial Services Analytical 

Applications Infrastructure Environment Check Utility Guide given in the Related Documents section. 

2.5 Understanding Installation Modes 

The following modes of installation are available for the OFS DM Application Pack. 

2.5.1 GUI Mode 

This mode launches the product installation in a Graphical User Interface (GUI) Mode. You need to enter the 

required information on various panels within the UI in a user interaction format at various stages. 

NOTE:  For more information on configuration required for GUI Mode installation, refer Configuration for GUI Mode 

Installation. 

2.5.2 Silent Mode 

This mode mandates updating the installation configuration files with required details and performs installation in a 

‘Silent’ non user interactive format. 

2.6 Installer and Installation Prerequisites 

Prerequisites for Installing OFSDM 8.0.6.0.0 are: 

• If AAI 8.0.6.0.0 is installed on the environment, ensure to apply the patch 28595665. 

• Ensure that OFSDF 8.0.6.0.0 is installed in the setup.  

NOTE:  This step is applicable only for DGS 8.0.6.0.0.  
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The following table mentions the list of prerequisites required before beginning the installation for OFS DM Application 

Pack. The Installer/ Environment Check utility notifies you if any requirements are not met. 

Requirement Sub-Category Expected Value 

Environment 

Settings 

 

Java Settings PATH in .profile to be set to include the Java Runtime Environment 

absolute path. The path should include java version (java 7, or Java 8) 

based on the configuration. 

Note: Ensure the absolute path to JRE/bin is set at the beginning of 

PATH variable. 

For example, 

PATH=/usr/java/jre1.7/bin:$ORACLE_HOME/bin:$PATH 

Ensure no SYMBOLIC links to JAVA installation is being set in the PATH 

variable. 

Oracle Database 

Settings 

 

 

 

 

 

Oracle Database Server 

• TNS_ADMIN must be set in .profile file pointing to appropriate 

tnsnames.ora file. 

• Enable Transparent Data Encryption (TDE) and/ or Data 

Redaction. 

Note: For more information, see Appendix R: Configuring Transparent 

Data Encryption (TDE) and, Data Redaction in OFSAA. 

OFSAA Processing Server 

• ORACLE_HOME must be set in .profile file pointing to 

appropriate Oracle DB Client installation. 

• PATH in .profile must be set to include appropriate 

$ORACLE_HOME/bin path.  

• Ensure that an entry (with SID/ SERVICE NAME) is added in the 

tnsnames.ora file. 

Oracle Essbase 

Settings 

ARBORPATH, ESSBASEPATH, HYPERION_HOME to be set in the 

.profile pointing to an appropriate Oracle Essbase Client installation. 

Note: These settings are required only if you want to use Oracle Hyperion 

Essbase OLAP features. 
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Requirement Sub-Category Expected Value 

OS/ File System 

Settings 

 

File Descriptor 

Settings 

Greater than 15000 

Total Number of 

Process Settings 

Greater than 4096 

Port Settings Default port numbers to be enabled on the system are 6500, 6501, 6505, 

6507, 6509, 6510, 6666, 9999, and 10101. 

.profile 

permissions 

User to have 755 permission on the .profile file. 

 

Installation 

Directory  

A directory where the installation files will be installed. 

Set 755 permission on this directory.  

This directory needs to be set as FIC_HOME. 

Temporary 

Directory 

Default temporary directory where installation files are stored for a short 

period of time to support faster installation. 

• For installation on UNIX OS, your UNIX administrator must give 

you the required read-write permissions for the /tmp directory and 

disable the NOEXEC option 

• Configure adequate space on the /tmp directory. It is 

recommended that you allocate more than 10 GB of space. 

Note: If NOEXEC is enabled, the extraction of files by the installer into 

the /tmp directory is prevented and the binaries will not execute in the 

directory, which will fail the installation. 

Staging Area/ 

Metadata 

Repository 

Directory 

A directory to hold the application metadata artifacts and additionally act 

as staging area for flat files.  

The directory should exist on the same system as the OFSAA Installation. 

This directory can be configured on different mount or under a different 

user profile. 

Set 777 permission on this directory. 
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Requirement Sub-Category Expected Value 

Download 

Directory 

A directory where the product installer files will be downloaded/ copied. 

Set 755 permission on this directory. 

Database 

Settings 

 

Database Instance 

Settings 

NLS_CHARACTERSET to be AL32UTF8 

NLS_LENGTH_SEMANTICS to be BYTE 

OPEN CURSORS limit to be greater than 1000 

Web Application 

Server 

WebSphere/ 

WebLogic/  

Tomcat 

Web Application Server should be installed and profile /domain created. 

You will be prompted to enter the WebSphere Profile path or WebLogic 

Domain path or Tomcat Deployment path during OFSAAI installation. 

Note: Refer Appendix A for WebSphere Profile Creation and WebLogic 

Domain Creation. 

Web Server Apache HTTP 

Server/  

Oracle HTTP 

Server/ 

IBM HTTP Server 

This is an optional requirement. 

HTTP Server Installation to be present.  

You will be required to enter the Web Server IP/ Hostname and Port 

details during installation. 

Note: Refer Appendix A for Web Server installation. 

Big Data Cloudera CDH 

and Cloudera 

JDBC Connectors 

This is an optional requirement and required if Oracle Financial Services - 

Big Data Processing license is enabled. For more information, see 

Installing Cloudera CDH. 

OFS AAI One-off Download the consolidated one- off patch for bug number 27938294 and 

28079607 from http://support.oracle.com 

Download the compatibility patch 28033582 from My Oracle Support, 

which needs to be mandatorily applied. This patch enables you to 

upgrade selected packs in your OFSAA instance to 8.0.6.0.0 and makes 

the existing packs from earlier versions compatible with 8.0.6.0.0. 

 Others To install this release on Oracle Solaris OS, refer to the following list for 

version specific information: 

• Solaris 11 – Upgrade to Oracle Solaris 11.3 with SRU09 or 

http://support.oracle.com/
https://support.oracle.com/
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Requirement Sub-Category Expected Value 

higher. See 

https://docs.oracle.com/cd/E60778_01/html/E60743/gouaw.html#

scrolltoc to upgrade to SRU09 if you have a lower SRU version. 

Additionally, install the required runtime libraries. For more 

information, see Installing Only the Runtime Libraries on Oracle 

Solaris 11.  

• Solaris 10 – Install the required OS patches. For more 

information, see Installing the Required Oracle Solaris 10 

Patches. Additionally, install the required runtime libraries. For 

more information, see Installing Only the Runtime Libraries on 

Oracle Solaris 10. 

NOTE: In an OFSAA instance where multiple OFSAA application 

packs have been installed/ deployed, it is mandatory to upgrade 

all OFSAA application packs to 8.0.6.0.0 release. You should 

start the upgrade of OFS AAAI pack only after confirming that all 

of the application packs in your OFSAA instance are available for 

upgrade to 8.0.4.0.0 version. For information on availability of the 

required OFSAA Application Packs, see 2246606.1.  

 

Others Oracle R/ Oracle 

R Enterprise 

 

This is an optional requirement. 

 

Oracle Data 

Integrator 

This is a mandatory requirement. For compatibility details refer Oracle 

8.0.6 Tech Matrix.  

 
Following step is applicable only if existing OFSAA setup version is 8.0.6.x.x and Configuration and Atomic Schema(s) were 
restored from exported dumps of other environment:  
Login to Configuration Schema and execute the following SQL statements:  
alter table AAI_AOM_APP_COMP_ATTR_MAPPING drop constraint AOM_APP_COMP_ATTR_PK drop index  

/ 

alter table AAI_AOM_APP_COMP_ATTR_MAPPING add constraint AOM_APP_COMP_ATTR_PK primary key 

(APP_COMP_ATTR_MAP_ID) 

 

Note: Ensure that the tablespace (s) used for the database user (s) is set to AUTOEXTEND ON. 
 

https://docs.oracle.com/cd/E60778_01/html/E60743/gouaw.html#scrolltoc
https://docs.oracle.com/cd/E60778_01/html/E60743/gouaw.html#scrolltoc
https://docs.oracle.com/cd/E60778_01/html/E60743/gozsu.html#scrolltoc
https://docs.oracle.com/cd/E60778_01/html/E60743/gozsu.html#scrolltoc
https://docs.oracle.com/cd/E60778_01/html/E60743/gimhj.html#scrolltoc
https://docs.oracle.com/cd/E60778_01/html/E60743/gimhj.html#scrolltoc
https://docs.oracle.com/cd/E60778_01/html/E60743/gimhj.html#scrolltoc
https://docs.oracle.com/cd/E60778_01/html/E60743/gouag.html#scrolltoc
https://docs.oracle.com/cd/E60778_01/html/E60743/gouag.html#scrolltoc
https://support.oracle.com/epmos/faces/DocumentDisplay?_afrLoop=379120760831411&id=2246606.1
https://docs.oracle.com/cd/E55339_01/homepage.htm
https://docs.oracle.com/cd/E55339_01/homepage.htm
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NOTE: Add a TNS entry before the installation. 

 
Note: 

1.  Login to Atomic  Schema.   

2.  Take  a backup of the following tables: 

a. DQ_RESULT_DETL_MASTER 

b. DQ_RESULT_SUMM_MASTER 

3.  Truncate the above tables. 

4. Perform the Installation activity. 

5. Post installations, restore the tables by using the backup tables. 
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3 Preparing for Installation 

This chapter provides necessary information to review before installing the OFS DM Pack v8.0.6.0.0.  

This chapter includes the following topics: 

• Installer and Installation Prerequisites 

• Obtaining the Software 

• Common Installation Activities 

NOTE:  If you are installing an application pack on an environment, where another application pack is already 

installed, you may get a warning message such as "Object Already Exists". This message can be ignored. 

Do not perform released model upload after installation. Released model upload cannot be performed after 

installation as it may lead to installation issues. 

3.1 Obtaining the Software 

This release of OFS DM Application Pack v8.0.6.0.0 is available for download in MOS as Patch 28525419. You must 

have a valid Oracle account in order to download the software. 

3.2 Common Installation Tasks 

The following are the common pre-installation activities that you need to carry out before installing the OFS DM 

Application Pack. 

This section includes the following topics: 

• Configuration for GUI Mode Installation 

• Identifying the Installation, Download and Metadata Repository Directories 

• Downloading and Copying the OFS DM Application Pack Installer 

• Copying and Extracting the Software 

• Setting up the Web Server/ Web Application Server 

3.2.1 Configuration for GUI Mode Installation 

To install OFS DM Application Pack in GUI mode, you need to ensure the below software and configurations are 

available: 

• Install and configure any PC X Server software such as Open Text Exceed (formerly Hummingbird Exceed) on 

the user desktop system from which the installation is triggered. 

• Configure DISPLAY variable in the user .profile. 
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• Ensure to set the DISPLAY variable on the system on which the OFSAA is installed, to point to the user 

desktop system where the PC X Server software has been installed. 

Syntax: 

export DISPLAY=hostname:n.n1  

where hostname is the IP Address/ Host Name of the user desktop system and n is the sequence number (usually 0). 

For example, 10.11.12.13:0.0 or myhostname:0.0 

3.2.2 Identifying the Installation, Download and Metadata Repository Directories 

For installation of any OFSAA Application Pack, the following directory/ directories required to be created. 

• OFSAA Download Directory (Optional) - Create a download directory and copy the OFSAA Application Pack 

Installer File (Archive).  This is the directory where the downloaded installer/ patches can be copied. 

• OFSAA Installation Directory (Mandatory) – Create an installation directory. This is the directory where the 

installer would install/ copy the product files. FIC_HOME variable to be set in the .profile pointing to this 

OFSAA Installation Directory. 

• OFSAA Staging/ Metadata Repository Directory (Mandatory) – Create a Staging/ Metadata Repository 

Directory. This is the directory where you would be required to copy data loading files, save data extracts etc. 

Additionally, this directory also maintains the OFSAA metadata artifacts. This is commonly referred as 

“FTPSHARE”. 

NOTE:  Ensure the user permission is set to 755 on the Installation and Download Directory. 

Ensure the user permission is set to 777 on the Staging Directory. 

3.2.3 Downloading and Copying the OFS DM Application Pack Installer 

To download the OFS DM Applications Pack Installer, follow these steps: 

• This release of OFS DM Application pack v8.0.6.0.0 can be downloaded from My Oracle Support using patch 

28525419. 

• Copy the downloaded installer archive to the Download Directory (in Binary mode) on the setup identified for 

OFSAA installation. 

• Download the mandatory installer one-off patch 28398331 from My Oracle Support. 

3.2.4 Copying and Extracting the Software 

Once you obtain the installer, copy the installer in Binary mode to the Download Directory. 

NOTE:  You must be logged in to the UNIX operating system as a non-root user. 

 

http://support.oracle.com/
https://support.oracle.com/
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6. Download the unzip utility (OS specific) unzip_<os>.Z from the location 

https://updates.oracle.com/unzips/unzips.html, and copy it in Binary mode to the directory that is included in 

your PATH variable. If you already have the unzip utility to extract the contents of the downloaded archive, skip to 

the next step. 

7. Uncompress the unzip installer file using the command: 

uncompress unzip_<os>.Z 

NOTE:  In case you notice an error message "uncompress: not found [No such file or directory]" when the package is not 

installed, contact your UNIX administrator. 

 

8. Give EXECUTE permission to the file using the command: 

chmod 751 unzip_<os> 

For example, chmod 751 unzip_sparc 

9. Extract the contents of the Oracle Financial Services Data Management Application Pack 8.0.6.0.0 to Download 

Directory using the following command: 

unzip OFS_DM_8.0.6.0.0.zip 

NOTE:  Extract and apply the patch 28398331. Refer to the Readme.txt file packaged with the patch for details on how to 

apply the patch.  DO NOT rename the Application Pack installer directory name on extraction from the 

archive. 

10. Give following permission to the installer directory. Navigate to the Download Directory and execute the command:  

chmod –R 755 OFS_DM_PACK 

3.2.5 Setting up the Web Server/ Web Application Server 

For setting up the environment based on your selected Web Server/ Web Application Server, refer to Appendix A for 

more information. 

3.2.6 Installing Cloudera CDH 

This is an optional step and required only if you intend to install Oracle Financial Services Advanced Analytical 
Infrastructure Big Data Option. Follow these steps: 

1. Install CDH v5.3.3, 5.4.4 or v5.8.4. For more information, refer Cloudera 5.3.x Documentation, Cloudera 5.4.x 
Documentation or Cloudera 5.8.x Documentation. 

2. Copy ofsaa-hive-udf.jar from installer kit (OFS_DM_PACK/OFS_AAAI_PACK/fichome/utility/DMT/UDF/lib) to 
HiveAuxDir of the cluster. For more information, refer Managing User-Defined Functions (UDFs) with 
HiveServer2. 

https://updates.oracle.com/unzips/unzips.html
http://www.cloudera.com/content/www/en-us/documentation/enterprise/5-3-x/topics/installation_installation.html
http://www.cloudera.com/content/www/en-us/documentation/enterprise/5-3-x/topics/installation_installation.html
http://www.cloudera.com/content/www/en-us/documentation/enterprise/5-4-x/topics/installation_installation.html
http://www.cloudera.com/content/www/en-us/documentation/enterprise/5-4-x/topics/installation_installation.html
https://www.cloudera.com/documentation/enterprise/5-8-x/topics/installation.html
https://www.cloudera.com/documentation/enterprise/5-8-x/topics/cm_mc_hive_udf.html
https://www.cloudera.com/documentation/enterprise/5-8-x/topics/cm_mc_hive_udf.html
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4 Installing OFS Data Management Application Pack 

This chapter describes the steps to be followed to install the OFS DM pack.  

NOTE: Release 8.0.6.0.0 of OFS DM is not fully backward compatible with earlier versions of OFSAA applications. 

You can either upgrade all of your applications from existing 8.0.x versions to 8.0.6.0.0 version or choose to upgrade 

only selective application packs to v8.0.6.0.0. In the case of the latter, you must also apply the forthcoming 

compatibility patches for the required application packs, so that the remaining application-packs can continue to be at 

their pre-8.0.6.0.0 versions. 

The Hybrid mode installation of OFS GL supports only full Hive deployment for those application packs where Hive is 

enabled. (For example – Oracle Financial Services Data Foundation). 

This chapter includes the following sections: 

• Schema Creator Utility 

• Configuring and Executing the Schema Creator Utility 

• Installing the OFS DM Application Pack Installer 

4.1 Schema Creator Utility 

Creating database users/ schemas is one of the primary steps in the complete OFSAA installation. This release of 

OFSAA provides a utility to quickly get started with the OFSAA 8.0.6 installation by allowing easier and faster creation 

of database User(s)/ Schema(s), assign the necessary GRANT(s) and so on. Additionally, it also creates the required 

database objects in these schemas.  

This section includes the following topics: 

• About Schema Creator Utility 

• Execution Modes in Schema Creator Utility 

• Execution Options in Schema Creator Utility 

4.1.1 About Schema Creator Utility 

The schema creator utility should be configured and executed mandatorily every time prior to installation of any 

OFSAA Application Pack. 

The following are the types of schemas that can be configured in the OFSAA: 

• CONFIG: Denotes the unique OFSAA setup configuration schema. It contains entities and other objects required 

for OFSAA setup information.  

NOTE:  There can be only one CONFIG schema per OFSAA instance. 
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ATOMIC: Denotes the schema that contains the data model entities. One ATOMIC schema is attached to one Information 

Domain.  

NOTE:  There can be multiple ATOMIC schemas per OFSAA Instance.  

SANDBOX: Denotes the schema that contains the data for all Sandbox executions. One SANDBOX schema is attached to one 

Sandbox Information Domain.  

NOTE:  There can be multiple SANDBOX schemas per OFSAA Instance. 

ADDON: Denotes any additional schema used by the OFSAA Applications.  

4.1.2 Execution Modes in Schema Creator Utility 

The Schema Configuration Utility supports the following modes of execution: 

• Online Mode: In the mode, the utility connects to the database and executes the DDLs for Users, Objects and 

Grants. If you have the SYSDBA privileges you can execute the Schema Creator Utility in Online mode and 

thereby create the Users, Objects and Grants during the execution process. 

NOTE:   To execute the utility in Online mode, you need to connect as ‘<User> AS SYSDBA’. 

• Offline Mode:  In the mode, the utility generates SQL script with all the required DDLs for Users, Objects and 

Grants. This script needs to be executed by the DBA on the appropriate database identified for OFSAA usage. If 

you do not have the SYSDBA privileges, you can execute the Schema Creator Utility in Offline mode and generate 

the script file that contains the Schemas, Objects and Grants, information. Subsequently, a SYSDBA user can 

execute the script file manually.  

NOTE:  1. To execute the utility in Offline mode, you need to connect as any user with below grants (alternatively, you can 

also connect as a user with SYSDBA privileges): 

SELECT ON DBA_ROLES 

SELECT ON DBA_USERS 

SELECT ON DBA_DIRECTORIES 

SELECT ON DBA_TABLESPACES 

CREATE SESSION 

For more details refer, Executing the Schema Creator Utility in Offline Mode 

2. If there are any errors during the script execution, reconfigure the OFS_DM_SCHEMA_IN.XML file and 

execute the utility. This regenerates the scripts with corrected information. For more information, refer 

Configuring and Executing the Schema Creator Utility. 

 

NOTE:  Do not modify the OFS_DM_SCHEMA_OUT.XML file generated after the execution of this utility. 
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4.1.3 Execution Options in Schema Creator Utility 

Depending on the option you choose to run the OFSAA Application Pack Installer, you need to choose the schema 

creator utility execution option. To run the OFSAA Application Pack installer in SILENT mode, it is mandatory to 

execute the schema creator utility with –s option.  

NOTE:  If the schema creator utility is executed without the option –s, it is mandatory to run the OFSAA Application Pack 

Installer in GUI mode. 

4.2 Configuring and Executing the Schema Creator Utility 

This section includes the following topics: 

• Prerequisites 

• Configuring the Schema Creator Utility 

• Executing the Schema Creator Utility 

4.2.1 Prerequisites 

The following prerequisites must be ensured before configuring the Schema Creator Utility: 

• You must have the Oracle User ID/Password with SYSDBA privileges (not applicable for offline mode). 

• You must have the JDBC Connection URL for RAC/Non RAC database. 

• The HOSTNAME/IP of the server on which OFSAA is getting installed. 

• It is recommended to set the PGA_AGGREGATE_LIMIT database-parameter value sufficiently, when Oracle 12c 

is installed. 

• While installing the application on Solaris 5.10 with Java 6, ensure to mandatorily modify setup.sh line number 503 

as “Line: modelsize=$(ls -l $dataModelFile | tr -s '\t' ' ' | cut -d ' ' -f5)”. 

• You must add a TNS entry before the installation. 

• For enabling Transparent Data Encryption (TDE) in your OFSAA instance during installation, perform the steps 

explained in the Appendix R: Enabling Transparent Data Encryption (TDE) in OFSAA.  

Optionally, for HIVE installation, the prerequisites you must have before configuring the Schema Creator Utility are: 

• HIVE connection credentials (For example: Kerberos connection properties). 

• Hostname/IP of the HIVE Server installation. 

NOTE: The TNS Entry for an atomic schema should be without any special character, i.e '_'. If the atomic schema name is 

like 'DEV_ATOM', the TNS entry should be like 'DEVATOM'. 
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4.2.2 Configuring Schema Creator Utility for RDBMS Installation 

Application specific schema details need to be filled in the OFS_DM_SCHEMA_IN.xml file before executing the 

Schema Creator Utility. For more information on the xml file, configure the following elements as described in the 

section Configuring OFS_DM_SCHEMA_IN.XML file. Refer Configuring OFS_DM_PACK.XML file. 

The types of schemas that can be configured are: 

• CONFIG: - This schema holds the entities and other objects required for OFSAA setup configuration 

information. 

NOTE: There can be only one CONFIG schema per OFSAA instance. 

4.2.3 Configuring Schema Creator Utility for HDFS Schema 

NOTE: For configuring Schema Creator Utility for HDFS Schema, rename the following files: 

• OFS_DM_SCHEMA_IN.xml to OFS_DM_SCHEMA_IN.xml.bkp 

• OFS_DM_CFG.dat to OFS_DM_CFG.dat.bkp 

• OFS_DM_SCHEMA_BIGDATA_IN.xml.HYBRID.template to OFS_DM_SCHEMA_BIGDATA_IN.xml 

• OFS_DM_CFG.dat.HYBRID.template to OFS_DM_CFG.dat 

The pack specific schema details need to be filled in the OFS_DM_SCHEMA_BIGDATA_IN.xml file, before executing 

the utility. For more information on the xml file, see Configuring OFS_DM_SCHEMA_BIGDATA_IN.xml file. 

The following are the types of schemas that can be configured: 

• CONFIG: This schema holds the entities and other objects required for OFSAA setup configuration information. 

 

Note: There can be only one CONFIG schema per OFSAA instance. This schema is created only in RDBMS. 

 

• METADOM: This schema holds the DM metadata information. One METADOM schema is attached to one 

Information Domain. 

 

Note: There can be multiple METADOM schemas per OFSAA Instance. This schema is created only in RDBMS. It has only 

platform entities that hold the metadata details. However, it does not hold the data model entities. 

 

• DATADOM: This schema holds data model entities. One DATADOM schema is attached to one Information 

Domain. 

 

Note: There can be multiple DATADOM schemas per OFSAA Instance. 
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4.2.4 Configuring the Schema Creator Utility 

To configure the Schema Creator Utility, perform the following steps: 

1. Log in to the system as non-root user. 

2. Navigate to the following path: OFS_DM_PACK/schema_creator/conf. 

3. Edit the OFS_DM_SCHEMA_IN.xml file in a text editor for RDBMS and for Hybrid edit 

OFS_DM_SCHEMA_BIGDATA_IN.xml file. Refer Configuring OFS DM_SCHEMA_BIGDATA_IN.xml file. 

4. Configure the elements as described in the OFS_DM_SCHEMA_IN.xml . 

5. On successful execution of the utility, the entered passwords in the OFS_DM_SCHEMA_IN.xml file are nullified. 

6. Save the OFS_DM_SCHEMA_IN.xml file. 

7. Navigate to /bin directory and run the schema creator utility. 

NOTE:  On successful execution of the utility, the entered passwords in the OFS_DM_SCHEMA_IN.xml.xml file are nullified.  

NOTE:  For Java 8: Edit the VerInfo.txt file in the path /OFS_DM_PACK/OFS_AAI/bin/ to modify the value for property 

JAVA_VERSION to 1.8, and save the changes. 

4.2.5 Executing the Schema Creator Utility 

This section includes the following topics: 

• Executing the Schema Creator Utility in Online Mode 

• Executing the Schema Creator Utility in Offline Mode 

• Executing the Schema Creator Utility with –s option  

• Executing the Schema Creator Utility while Installing Subsequent Application Pack Schema Creation 

4.2.5.1 Executing the Schema Creator Utility in Online Mode 

In Online Mode, the Schema Creator Utility creates all the Schemas, Schema Objects, Tablespaces, Grants, and 

Roles in the database during the execution process.  

To execute the schema creator utility while creating the schemas for the application pack, perform the following steps: 

1. Log in to the system as non-root user. 

2. Navigate to the following directory path: OFS_DM_PACK/schema_creator/bin/ 

3. Execute the following command. 

./osc.sh  
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NOTE:  For silent mode installation, execute the osc.sh file using the following command: 

./osc.sh -s 

The following message is displayed: You have chosen ONLINE mode. Triggering the utility in ONLINE mode 

executes the DDLs directly on the Database. Do you wish to proceed? (Y/y or N/n). 

4. Enter Y/y to proceed with the script generation 

or 

Enter N/n to quit script creation. 

5. Enter the DB Username with SYSDBA Privileges.  

For example: SYS as SYSDBA. 

6. Enter the User Password.  

 

7. The console runs the initial validation checks and then displays the following message: You have chosen to install 

this Application Pack on <Name of the Atomic Schema>ATOMIC schema. Do you want to proceed? (Y/N). 

8. Enter Y/y to proceed with the schema creation. 

or 

Enter N/n to quit schema creation 

The following message is displayed. 

You have chosen to install this Application Pack on <Name of the Infodom>. Do you want to proceed? (Y/N). 

 

9. Enter Y/y to start the schema creation. 
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Or 

Enter N/n if you want to quit executing the schema creation.  

 

NOTE:  On successful execution of schema creator utility, the console displays the following status message: 

Schema Creator executed successfully. Please proceed with the installation.  

 

Refer log file in OFS_DM_PACK/schema_creator/logs directory for execution status. In case of any 

errors, contact Oracle Support. 

10. Make TNS entries for the created users in TNSNAMES.ORA. For details, refer Add TNS Entries in 

TNSNAMES.ORA file. 

11. Navigate to the directory OFS_AAAI_PACK/schema_creator. 
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12. Log in to SQLPLUS with a user having SYSDBA Privileges. 

 

13. Connect to the Oracle DB Server on which the OFSAA Application Pack installation is to be performed and 

execute the sysdba_output_scripts.sql file using the following command: 

SQL>@sysdba_output_scripts.sql 

Alternatively, you can copy the sysdba_output_scripts.sql file and 

SQLScripts directory to a remote server and execute the 

sysdba_output_scripts.sql file. 

14. (This step is optional and applicable only for HDFS installation.) Connect to the HDFS repository using a 

HUE Browser. Log in to the Hue Browser with System Administrator privileges. Execute the script mentioned 

under hive_output_scripts.hql (omitting the slash (’/’)) in the HIVE Query Editor. For example, the query can 

be as follows: 

CREATE SCHEMA IF NOT EXIST <<HIVE SCHEMA NAME>> 

Note: See log sysdba_output_scripts.log file for execution status. If there are any errors, contact 

Oracle Support Services. If there are no errors in the execution, the log file is empty. 

4.2.5.2 Executing the Schema Creator Utility in Offline Mode 

In Offline Mode, the Schema Creator Utility creates an output in SQL file format. This script has to be executed 

manually by logging as database user with SYSDBA privileges. The SQL file contains the scripts for creation of 

Schemas, Schema Objects, Tablespaces, Grants, and Roles. 

Prerequisites: 

To execute the utility in Offline mode, you need to connect as any user with below grants (alternatively, you can also 

connect as a user with SYSDBA privileges): 

• SELECT ON DBA_ROLES 
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• SELECT ON DBA_USERS 

• SELECT ON DBA_DIRECTORIES 

• SELECT ON DBA_TABLESPACES 

• CREATE SESSION 

NOTE:  Explicit Grants to the user are required. Grants assigned through Roles are not supported. 

To execute the schema creator utility in the offline mode, perform the following steps: 

1. Log in to the system as non-root user. 

2. Navigate to the following path: OFS_DM_PACK/schema_creator/bin 

3. Execute the osc.sh file using the following command: 

./osc.sh –o 

NOTE:  For silent mode installation, execute the osc.sh file using the following command: 

./osc.sh -s  

4. The following message is displayed:  

You have chosen OFFLINE mode. Triggering the utility in OFFLINE mode generates the script. Do you wish to 

proceed? (Y/y or N/n). 

5. Enter Y /y to generate the script. 

or 

Enter N/n to quit the schema creation. 

6. Enter the DB Username with SELECT privileges. 

7. Enter the User Password. 
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8. The console runs the initial validation checks and displays the following message: 

 You have chosen to install this Application Pack on <Name of the Atomic Schema>ATOMIC schema. Do you 

want to proceed? (Y/N). 

9. Enter Y/y to start the script generation. 

Or 

Enter N/n if you want to quit the script generation. 

The following message is displayed.  

You have chosen to install this Application Pack on <Name of the Infodom>. Do you want to proceed? (Y/N). 

 

10. Enter Y/y to start the script generation.  

Or 

Enter N/n if you want to quit the script generation. 
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NOTE:  On successful execution of schema creator utility, the console displays the following status message:  

Schema Creator executed successfully. Please execute 

scratch/ofsaaapp/OFS_DM_PACK/schema_creator/sysdba_output_scripts.sql before 

proceeding with the installation. 

11. Navigate to the directory: OFS_DM_PACK/schema_creator.  

12. Login to SQLPLUS with a user having SYSDBA Privileges. 

13. Execute the sysdba_output_scripts.sql file using the following command: 

SQL>@sysdba_output_scripts.sql 

Alternatively, you can copy the sysdba_output_scripts.sql file and SQLScripts directory to a remote 

server and execute sysdba_output_scripts.sql file, after providing appropriate execute permissions. 

NOTE:  Refer log sysdba_output_scripts.log file for execution status. In case of any errors, contact Oracle 

Support. This log would be empty if there are no errors in the execution. 

14. Make TNS entries for the created users in TNSNAMES.ORA. For details, see Add TNS Entries in 

TNSNAMES.ORA file. 

4.2.5.3 Executing the Schema Creator Utility with –s option 

If you want to run the OFSAA Application Pack Installer in SILENT mode, it is mandatory to execute the schema 

creator utility with –s option. 

To execute the utility with –s option, perform the following steps: 

1. Edit the file OFS_DM_PACK/schema_creator/conf/OFS_DM_SCHEMA_IN.xml in text editor. 

For Example: ./osc.sh –s. 
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2. Make TNS entries for the created users in TNSNAMES.ORA. For details, see Add TNS Entries in 

TNSNAMES.ORA file. 

NOTE:  If the utility is executed without the –s option, it is mandatory to launch the OFSAA Application Pack Installer in GUI 

mode. 

NOTE:  To execute the utility in OFFLINE mode with SILENT option, type. /osc.sh –o –s. 
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4.2.5.4 Executing the Schema Creator Utility while Installing Subsequent Application Pack Schema Creation 

When executing the schema creator utility for subsequent Application Pack, you can choose to install the pack either 

on the same Information Domain/ Atomic Schema or on a new Information Domain/ Atomic Schema. 

NOTE:  OFS DM Application Pack can be installed on any Information Domain/ Atomic schema where any OFS Application 

Packs are installed other than OFS Behavior Detection Application Pack or OFS Compliance Regulatory 

Reporting Application Pack 

To execute the schema creator utility while installing OFS DM Application Pack over an existing Application pack, 

perform the following steps: 

1. Repeat the steps 1 to 8 from Executing the Schema Creator Utility section.  

NOTE:  Ensure to use the same config schema user name as the previous Application Pack  

2. The utility identifies the Application Packs that are already installed on the current OFSAA setup and displays the 

following on console: 

• Atomic schema of the Existing Application Pack 

• Information Domain Name of the Existing Pack 

• List of Installed Application Packs 

3. Enter Y/y to start the schema creation.  

Or 

Enter N/n if you want to quit executing the schema creation. 

4. You can select the Atomic User, on which you want to install the Application Pack. 

5. Make TNS entries for the created users in TNSNAMES.ORA. For details, see Add TNS Entries in 

TNSNAMES.ORA file. 

NOTE:  On successful execution of schema creator utility, the console displays the following status message: Success. 

Please proceed with the installation.  

NOTE:  Refer log file in OFS_DM_PACK/schema_creator/logs directory for execution status. Refer log 

sysdba_output_scripts.log file for execution status, if executed in offline mode. This log would be 

empty if there are no errors in the execution. In case of any errors, contact Oracle Support. 

Verifying the Log File 

If schema creation is successful, the console would display an appropriate message. If the schema creation runs into 

errors, do refer the log file. 

<<OFSDMAP Installer directory>>/<<OFS_DM_PACK>>/schema_creator/logs/ 

<<OFS_DM>>_osc_<timestamp>.log for further details.  
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You may contact Oracle support anytime for assistance. 

4.3 Installing the OFS DM Application Pack 

Follow the instructions in this section to install the OFS DM Application Pack depending on the mode of installation.  

This section includes the following topics: 

• GUI Mode Installation 

• Silent Mode Installation 

• Verifying the Log File 

4.3.1 GUI Mode Installation 

 

NOTE:  Ensure you have followed the steps as mentioned in the Configuration for GUI Mode Installation section prior to 

proceeding with the next steps. 

NOTE:  GUI mode installation is supported only for RDBMS installation and not for Hybrid. 

1. Log in to the system as non-root user. 

2. Identify a directory for installation and set the same in the user .profile file as below: 

FIC_HOME=<OFSAA Installation Directory> 

export FIC_HOME 

3. Execute the user .profile.  

4. Configure and execute the Schema Creator utility. For details, see Configuring and Executing the Schema Creator 

Utility. 

Note: Ensure to make a TNS entry for the new users created. For details, see Add TNS Entries in 

TNSNAMES.ORA file. 

5. Navigate to the path: OFS_DM_PACK/bin. 

6. Run the installer in GUI Mode: 

./setup.sh GUI 

Refer the console for any errors during Pre-install checks. 
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7. Select I accept the terms of the License Agreement option. 

8. Click Next. The Application Pack details are displayed: 
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9. Select the product to enable for which you have already obtained license. 

10. Click Next. The License Agreement page is displayed.  
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11. Select I accept the terms of the License Agreement option. 

12. Click Next. The Pre Installation Summary page is displayed. 
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13. Click Next. The Manage Information Domain page is displayed. 
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14. The default Information Domain Name for this Application Pack is OFSDMINFO. Double-click to edit the 

Information Domain Name, if it is a new Information domain and you wish to change the name of the information 

domain name. 

15. Click Next. The following page is displayed. 
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16. Click Next. The User Installation Directory window is displayed. Enter the installation directory path. This is the 

directory you have set in the user .profile file in step 2. 

 

17. Click Next. The OFSAA Infrastructure Server Details are displayed in the following figure. Enter the IP address or 

hostname of the OFSAAI server and Database server. 
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18. Click Next to view the Web Application Server details. The options are Tomcat, WebSphere and WebLogic. 

 

19. Select the web application server type and click Next. Based on the selection, corresponding screens are 

displayed. 

For WebSphere: The WebSphere Setup Details window is displayed.  

Enter the profile path (up to the Node Cell Name directory) of WebSphere.  

The format is WebSphere path  

<WebSphere profile directory>/installedApps/ <NodeCellName>. 
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For Tomcat: The Absolute Tomcat Path window is displayed. Enter the Tomcat deployment path (till /webapps) 

where the application is deployed. 
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For WebLogic: The WebLogic Home window is displayed. Enter the WebLogic home directory path, and click 

Next.  

 

20. Enter the OLAP details. Enter 1 if you want to configure OFSAAI OLAP feature, using Oracle Hyperion Essbase. 

By default, 0 is displayed.  
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21. Click Next. The Web Server Details window is displayed. 

 

22. Enter the Web Server details. Select Enable HTTPS checkbox if you want to configure HTTPS for the OFSAA 

application. Also, enter the Web Server (HTTP Server) Port, Web Server IP Address, Context name for 

deployment and Web Local Path to any directory on the Web Application Server (Tomcat/ WebSphere/ 

WebLogic). 

23. Click Next. The Database Details window is displayed. 
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24. Enter Oracle SID/Service Name, JDBC URL, Configuration Schema User ID, Password, and Absolute Driver 

Path. 

The JDBC URL, Configuration Schema User ID, Oracle Configuration Schema Password, and Absolute 

Driver Path are auto-populated. 

NOTE:  Absolute Driver Path can be the path where Oracle DB client is installed or JDBC driver is installed. For example, 

/scratch/oracle/app/oracle/product/11.2.0/client_1/jdbc/lib 

 

25. Click Next. The Ports Configuration window is displayed. 
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26. Enter Java Port, Native Port, Agent Port, ICC Server Port, and ICC Native Port. You can proceed with the 

default port values configured.  

27. Click Next. The Ports Configuration window is displayed. 

 

28. Enter OLAP Port, Message Server Port, Router Port, and AM Port. 
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29. Click Next. The SFTP Details window is displayed. 

 

30. Enter 1 to enable SFTP or 0 to enable FTP. 

NOTE:  Ensure the system on which the OFSAA Infrastructure is being installed, has either FTP/ SFTP enabled. You can 

also modify the SFTP settings. 

31. Enter the port to be used for file transfer. 

32. Click Next.  
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33. Enter the path of the FTPSHARE directory and the User Id and password for OFSAAI Server. This is same as the 

OFSAA Staging/ Metadata Repository Directory.FTP/SFTP User ID and Password for FTPSHARE Directory 

access. 

NOTE:  The transfer of data (files) between the OFSAAI Server and the Web Application Server happens over FTP/ SFTP. 

Ensure the necessary host configurations are made for a successful handshake. 

 

34. Click Next. The Pre Installation Summary window is displayed. 
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35. Click Install. The Installing OFSAA Infrastructure window is displayed. 

 

Anytime during the installation you can click Cancel to stop the installation. Once completed, the Installation 

Summary screen is displayed. 
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The Installation Summary screen displays the number of Fatal Errors, Errors, Debug Statements, Information, and 

Warnings along with the location of log files. 

NOTE:  If the installation is successful with some warnings, you can navigate to the installation log for more details and 

address them. 

 

36. Click Next. You have successfully installed the OFS AAI Application Pack. 

Upon invoking the installer, the Introduction screen is displayed with the prerequisites for installation. Ensure that 

all the prerequisites are met before you proceed with the installation. 

37. The Executing AAI Installation Script screen is displayed.  

NOTE:  This step verifies the OFSAA services startup. In case of errors during services check, an appropriate error 

message is displayed. 
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38. After checking the OFSAA services, installation proceeds with the Application Pack Installation. The Installing 

Financial Services Data Management Pack screen is displayed. 

 

39. Installing Oracle Financial Services Data Management Application Pack.  

Upon invoking the installer, the Introduction screen is displayed with the prerequisites for installation. Ensure that 

all the prerequisites are met before you proceed with the installation. 
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Solution Setup Introduction 

40. Click Next. Choose the log mode for this installer. If Debug is selected, the Passwords will be printed in the log file. 

If General is selected then the general information will get printed in the log file. 
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Log Mode 
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41. Click Next. Segment creation window will be displayed. Enter the log paths. 

 

Pre-Setup Information 

42. Click Next. Pre-Infodom Creation Summary window will be displayed. 
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Pre-Infodom Creation Summary 

43. Click Next. The Infodom creation window will be displayed. 



OFSDM 8.0.6.0.0 Installation Guide 

Oracle Financial Services Software 

 

74 

 

 

Infodom creation 
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44. Click Next. Model Upload Window will be displayed. 

 

Model Upload 

45. Select Yes and click Next. Model Review Window will be displayed. 
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Pre-Model Upload Summary 

46. Click Next again. The Data Model Upload starts.  
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Model Upload 
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After Model Upload completion, ETL Application/ Source Pair is displayed. The following panel seeks input from 

the user on whether to create new ETL application/source pair or use an existing one. 

47. Choose a desired option and click Next to continue. 

 

Pre Setup Information 

48. If the option New application/source pair was chosen then the following panel is displayed seeking the application 

and source name for creation of the same. 

49. Specify all the details required for application and source creation. 

50. Click Next to proceed. This will create application and source within OFSAAI. Source model will also be 

generated. This process will take some time depending on the number of entities / attributes in the atomic schema. 

This step cannot be rolled back. 
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51. Enter the source name and description. After Creation, click Next. This panel displays all the pre-installation 

summary. Verify all details and proceed. 
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Pre-Install Summary 

52. Click Install to proceed. A message appears asking for the confirmation. 
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53. Click Yes, Installation will begin. The Installation Progress is displayed in Installation Progress window. 
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Installation in Progress 

The Installation Complete screen is displayed after the completion of installation of the Oracle Financial Services 

Data Management Pack Setup. 

54. Installation Summary window will be displayed. Click Next. 
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55. Click Done to exit. The panel goes back to Main App Pack Installation window. 
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NOTE: The installation process continues on the console. Do not close the console until the 

installation process is complete. 
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56. The Post Install Health checks are displayed: 

 

57. Perform steps mentioned in the Post Installation Configuration section. 

58. Perform the steps mentioned in Post Installation Configurations section. 

59. For enabling Transparent Data Encryption (TDE), see Transparent Data Encryption (TDE).   

60. For enabling Data Redaction, see Data Redaction section under Data Security and Data 

Privacy chapter in OFS Analytical Applications Infrastructure Administration Guide 8.0.6.0.0. 

4.3.2 Silent Mode Installation 

In the Silent Mode Installation you must configure the product xml files and follow the instructions 

in command prompt. 

Perform the following steps for installing the OFS DM Pack in SILENT mode. 

1. Log in to the system as non-root user. 

2. Identify a directory for installation and set the same in the user .profile file as below: 

FIC_HOME=<OFSAA Installation Directory> 

export FIC_HOME 

3. Execute the user .profile. 

4. Navigate to OFS_DM_PACK directory (installer directory). 

https://docs.oracle.com/cd/E60058_01/PDF/8.0.6.x/8.0.6.0.0/OFSAAI_Administration_Guide_8.0.6.0.0.pdf
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5. Edit the OFS_DM_PACK/schema_creator/conf/OFS_DM_SCHEMA_IN.xml for RDBMS 

file to set the appropriate attribute values. It is optional to include INFODOM = “<Infodom 

Name>” in OFS_DM_SCHEMA_IN.xml file. If not specified a default INFODOM name is 

generated. 

6. See Configuring OFS_DM_SCHEMA_IN.XML for details on for RDBMS and for Hybrid edit 

OFS_DM_SCHEMA_BIGDATA_IN.xml file.  

Refer Configuring OFS DM_SCHEMA_BIGDATA_IN.xml file.  

NOTE:  Ensure to make TNS entries for the created users in TNSNAMES.ORA. For details, see Add 

TNS Entries in TNSNAMES.ORA file. 

7. Execute the schema creator utility with –s option. 

NOTE:  This step is mandatory and should be executed before every additional OFSAA Application 

Pack installation. See Executing the Schema Creator Utility for more details. 

8. Edit the OFS_DM_PACK/conf/OFS_DM_PACK.xml to enable the product licenses. Update 

the attribute ENABLE=YES/NO in OFS_DM_pack.xml for licensing the App in the pack.  

9. In case of Hybrid installation, OFS_DM_PACK.xml to be renamed as backup and 

OFS_DM_PACK.xml.HYBRID.template to be renamed as OFS_DM_PACK.xml. 

NOTE:  See Configuring OFS_DM_PACK.XML for details on configuring this XML file.  

NOTE:  Update OFS_DM_PACK.XML, set the attribute “ENABLE=YES” of <APP_ID> tag for 

applications to be enabled during installation. If any application has mentioned 

OFS_AAAI as PREREQ in the <APP_ID> tag, set the attribute “ENABLE=YES” for 

OFS_AAAI. To install DM, ensure to enter "YES" in ENABLE attribute for OFS_AAI, 

and OFS_DGS. 

10. Edit the OFS_DM_PACK/OFS_AAI/conf/OFSAAI_InstallConfig.xml file to set the 

appropriate infrastructure installation attribute values.  

NOTE:  This step can be ignored if an installation of OFSAA 8.0.6.0.0 already exists. 

See Configuring OFSAAI_InstallConfig.xml for details on configuring this XML file. 

11. Create a copy of the Silent.template file present in the installer 

OFS_DM_PACK/OFS_DM/conf and rename it as Silent.props. 

12. In case of HYBRID, perform the following steps: 

a. Rename Silent.template.HYBRID.template to Silent.props. 

b. Rename default.properties to default.properties.bkp. 

c. Rename default.properties.HYBRID.template to default.properties. 
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Silent installation is achieved via a properties file [Silent.props] that must be updated with 

proper values, before attempting to install using the silent mode. The following table lists all 

the properties that need to be specified: 

NOTE:  During Hybrid mode Installation of DMP 8.0.6 the following parameters in the Silent.props 

(after renaming from Silent.template.HYBRID.template) are to be configured as:  

UPLOAD_MODEL=1  

HIVE_UPLOAD_MODEL=1 

Property 

Name                           
Description of Property 

Permissible 

values  
Comments 

LOG_MODE Mode for logging 
0 = Debug  

1= General 
Default : 0 

SEGMENT_1_CODE Segment Code Not Applicable 
Provide a new segment 

code for DM Pack. 

APFTP P_LOG_PATH= 

Infodom Maintenance log path(to 

be created) for the new RDBMS 

Infodom 

Not Applicable 
 

DBFTP_LOG_PATH 

Infodom Maintenance log path(to 

be created) for the new RDBMS 

Infodom 

Not Applicable  

HIVE_APPFTP_LOG_PATH 

Infodom Maintenance log path(to 

be created) for the new HIVE 

Infodom 

Not Applicable 
Applicable only for Hybrid 

Installation 

HIVE_DBFTP_LOG_PATH 

Infodom Maintenance log path(to 

be created) for the new HIVE 

Infodom 

Not Applicable 
Applicable only for Hybrid 

Installation 

UPLOAD_MODEL 
Specify if you want to perform 

Model Upload for RDBMS 

0 = If you have 

already 

performed Model 

Upload and want 

to skip model 

upload process 

 

1 = If you want to 

perform Model 
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Property 

Name                           
Description of Property 

Permissible 

values  
Comments 

Upload 

MODEL_TYPE 

Specify if you want to use the 

released datamodel or 

customized datamodel for model 

upload process for RDBMS 

0 = If you want to 

upload the 

released 

datamodel 

 

1 = If you want to 

upload the 

customized 

datamodel 

 

DATAMODEL 

Specify the file(DATAMODEL) 

name for the customized 

datamodel for RDBMS 

Not Applicable 

Mandatory only if you want 

to upload the customized 

datamodel 

 

i.e you have specified 

MODEL_TYPE=1 

DM_DIRECTORY 

Specify the path 

(DM_DIRECTORY)  for the 

customized datamodel for 

RDBMS 

Not Applicable 

Mandatory only if you want 

to upload the customized 

datamodel 

 

i.e you have specified 

MODEL_TYPE=1 

HIVE_UPLOAD_MODEL 
Specify if you want to perform 

Model Upload for HIVE 

0 = If you have 

already 

performed Model 

Upload and want 

to skip model 

upload process 

 

1 = If you want to 

perform Model 

Upload 

Applicable only for Hybrid 

Installation. 
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Property 

Name                           
Description of Property 

Permissible 

values  
Comments 

HIVE_MODEL_TYPE 

Specify if you want to use the 

released datamodel or 

customized datamodel for model 

upload process for HIVE 

0 = If you want to 

upload the 

released 

datamodel 

 

1 = If you want to 

upload the 

customized 

datamodel 

 

Applicable only for Hybrid 

Installation. 

DATAMODEL_HIVE 

Specify the file(DATAMODEL) 

name for the customized 

datamodel for HIVE 

Not Applicable 

Applicable only for Hybrid 

Installation. 

 

Mandatory only if you want 

to upload the customized 

datamodel 

 

i.e you have specified 

MODEL_TYPE=1 

 

DM_DIRECTORY 

Specify the path 

(DM_DIRECTORY)  for the 

customized datamodel for HIVE 

Not Applicable 

Applicable only for Hybrid 

Installation. 

 

Mandatory only if you want 

to upload the customized 

datamodel 

 

i.e you have specified 

MODEL_TYPE=1 

 

ETL_APPSRC_TYPE 

Please specify if you want create 

new ETL Src  or use an existing 

one 

0 = If you want to 

create a new ETL 

src  
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Property 

Name                           
Description of Property 

Permissible 

values  
Comments 

1 = If you want to 

use an existing 

pair 

ETL_SRC_1_NAME 
Please specify new ETL Source 

Name for RDBMS 
Not Applicable  

ETL_SRC_2_NAME 
Please specify new ETL Source 

Name for HIVE 
Not Applicable 

Applicable only for Hybrid 

Installation. 

ETL_SRC_1_DESC 
Please specify new ETL Source 

Description for RDBMS 
Not Applicable  

ETL_SRC_2_DESC 
Please specify new ETL Source 

Description for HIVE 
Not Applicable 

Applicable only for Hybrid 

Installation. 

13. On successful execution of the schema creator utility, navigate to OFS_DM_PACK/bin/ and 

execute the application pack installer with SILENT option. 

14. Execute ./setup.sh SILENT in the console. 

15. Enter the Infrastructure FTP/SFTP password value, when prompted at the command prompt. 

Console Prompts User Inputs 

Please enter Infrastructure 
FTP/SFTP password 

Enter the password to access Product Staging/Metadata repository 
directory in the application server. 

Note: During installation stage, you need to enter the config schema 
password again. 

16. Enter Always, when prompted to add host key fingerprint. 

17. The OFSAAI License Agreement is displayed. 

 

18. To accept the License Agreement, enter Y/y. 

19. Enter the passwords for default Infrastructure administrator and authorizer users. 
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Console Prompts User Inputs 

Please enter password for default 
Infrastructure administrator user SYSADMN 

Enter the password for the System Administrator. 

Please re-enter password for default 
Infrastructure administrator user SYSADMN 

Enter the same password again to confirm its validity. 

Please enter password for default 
Infrastructure authorizer user SYSAUTH 

Enter the password for the System Authorizer. 

Please enter password for default 
Infrastructure authorizer user SYSAUTH 

Enter the same password again to confirm its validity. 

NOTE:  SYSADMN and SYSAUTH are the two default OFSAAI administrative users created. 

 



Oracle Financial Services Software 

OFSDM 8.0.6.0.0 Installation Guide 
 

92 

 

NOTE:  The installation process continues on the console. Do not close the console until the 

installation process is complete. 

20. The following message is displayed in the console: 

Installation completed… 

 

21. On completion of installation, refer the installation log files. For more information, see 

Verifying the Log Files. 

22. In case of DGS, install AAI 8.0.6.1.0 one-off patch 28033370 if this patch is not already 

applied. Refer to the Readme available with the patch for further instructions on installing the 

patch. 

23. Perform steps mentioned in the Post Installation Configuration section. 

24. Perform the steps mentioned in Post Installation Configurations section. 
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25. For enabling Transparent Data Encryption (TDE), see Transparent Data Encryption (TDE).   

26. For enabling Data Redaction, see Data Redaction section under Data Security and Data 

Privacy chapter in OFS Analytical Applications Infrastructure Administration Guide 8.0.6.0.0. 

 

NOTE:  Download and install patch for Bug 21160684 if installing this release of the OFS AAAI 

Application Pack version 8.0.0.0.0 on Java 8. For more information, see Configurations 

for Java 8. This patch is not required if an OFSAA instance already exists and is 

configured for Java 8. 

 

4.3.3 Verifying the Log File 

Refer the following logs files for more information:  

• Refer the Pack_Install.log located at OFS_DM_PACK/logs/ directory for OFS DM 

Application Pack installation log file. 

• Refer the log file(s) located at OFS_DM_PACK/OFS_AAI/logs/ directory for Infrastructure 

installation log. 

• Refer the log file(s) located at OFS_DM_PACK/OFS_DM/logs/ directory for application 

installation log. 

NOTE:  For Pack on Pack installation, the following errors might be logged in the installation log and 

these can be ignored as this has no implication on the product: 

 'create sequence SEQ_DIM_GL_ACCOUNT 

  minvalue 1 

maxvalue 999999999999999999999999999 

start with 1 

increment by 1 

cache 20' 

Warning:Object already exists 

 

4.3.4 Verifying the Installation 

This section explains the steps to verify your application installation. 

To verify that you have successfully installed the Data Management pack, perform the following 

steps: 

1. Login in to the atomic schema. 

2. Verify all the database objects such as view, procedure, and functions must have been 

complied without any compilation error. 

https://docs.oracle.com/cd/E60058_01/PDF/8.0.6.x/8.0.6.0.0/OFSAAI_Administration_Guide_8.0.6.0.0.pdf
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3. Deploy the war file and check the application screen is coming or not. 
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6 Upgrading OFS DM Application Pack 

Refer to the following instructions to download, extract, install, and configure this release.  

1. Execute the scripts detailed in Patch Execution Performance Scripts in atomic schema. 

2. As a prerequisite, the following entry must be done for the table: 

OFSAA_SETUP_APPLN_DTLS in config schema: 

APPNAME APPVERSION DSNID SEG_MAP_ID SEGMENT

_CODE 

INSTALLED_ 

FLAG 

INSTALLED_DAT

E 

GL <last_version_insta

lled> 

<infodom> COMMON <segment_

code> 

Y <ANY_DATE> 

DGS <last_version_insta

lled> 

<infodom> COMMON <segment_

code> 

Y <ANY_DATE> 

Ensure to provide the last version installed and the same infodom and segment code 

when GL or DGS is installed. 

3. As a prerequisite for DGS 8.0.6.0.0, ensure that OFSDF 8.0.6.0.0 is installed in the 

setup.  

NOTE:  This step is applicable only for DGS 8.0.6.0.0.  

4. As a prerequisite for Reconciliation Framework 8.0.6.0.0,  

• Ensure to have the base version as 8.0.5 or 8.0.5.1. 

• If AAI 8.0.6.0.0 is installed on the environment, ensure to apply the patch 28595665. 

5. In case AAI 8.0.6.1.0 is installed, drop below index prior to installation of DM Pack: 

DROP INDEX DIM_DATES_CALENDAR_DATE; 

DROP INDEX DIM_KI_GROUP_LRI; 

6. Download the OFS DM Application Pack v8.0.6.0.0 archive file and copy it to your 

OFSAA server in the Binary mode. For more information on downloading and copying 

the OFS DM Application Pack v8.0.6.0.0 installer, see Downloading and Copying the 

OFS DM Applications Pack Installer section.  

NOTE:  The archive files are different for every operating system like AIX, Solaris, and 

RHEL/Oracle Linux.  

7. Log in to the OFSAA Server. 

8. Shut down all the OFSAAI Services. For more information, see the Start/Stop 

Infrastructure Services section in Starting/Stopping Infrastructure Services.  

9. Execute the command:  

chmod -R 750 $FIC_HOME 

10. If you have Unzip utility, skip to the next step. Download the Unzip utility (OS specific) 

and copy it in Binary mode to the directory that is included in your PATH variable, 

typically $HOME path or directory in which you have copied the 8.0.6.0.0 installer.  

https://support.oracle.com/epmos/faces/DocumentDisplay?_afrLoop=358488681017709&id=2531696.1&_afrWindowMode=0&_adf.ctrl-state=1dnl6uxpbx_45
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• Uncompress the unzip installer file using the command:  

uncompress unzip_<os>.Z  

NOTE:  In case you notice an error message “uncompress: not found [No such 

file or directory]” when the package is not installed, contact your UNIX 

administrator.  

• Give EXECUTE permission to the file using the command:  

chmod 751 OFS_DM_80600_<OperatingSystem>.zip 

11. Extract the contents of the Oracle Financial Services Data Management Application Pack 

8.0.6.0.0 installer archive file, using the command: 

unzip_<os> <name of the file to be unzipped> 

12. Give the EXECUTE permission for the OFS_DM_PACK folder using the command: 

chmod –R 775 OFS_DM_PACK 

13. Before triggering the installation, you must update the configuration file Silent.props. 

Create a copy of the Silent.template file present in the installer  

OFS_DM_PACK/OFS_DM/conf and rename it as Silent.props.  
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Property 

Name                           
Description of Property 

Permissible 

values  
Comments 

LOG_MODE Mode for logging 
0 = Debug  

1= General 

Optional; 

Default : 0 

SEGMENT_1_CODE Segment Code Not Applicable MANDATORY 

APPFTP_LOG_PATH 

Infodom Maintenance log path(to 

be created) for the new Infodom 

for app layer 

Not Applicable 

# Mandatory if this an App Layer 

Installation and if you want to create a 

new infodom. 

DBFTP_LOG_PATH 

Infodom Maintenance log path(to 

be created) for the new Infodom 

for DBLayer 

Not Applicable 

# Mandatory if this an DB Layer 

Installation and if you want to create a 

new infodom. 

UPLOAD_MODEL 
Whether you want to perform 

Model Upload 

0 = No  

1 = yes 
# Mandatory 

MODEL_TYPE 
Released data model or 

Customized data model 

0 = released  

1 = customized 

# Mandatory only in the case of 

UPLOAD_MODEL=1 

DATAMODEL 
The file name for the customized 

data model 
Not Applicable 

# Mandatory only in the case of 

uploading the customized data model  

# Option selected for 

MODEL_TYPE=1 

DM_DIRECTORY 
The path for the customized data 

model 
Not Applicable 

# Mandatory only in the case of 

uploading the customized data model  

# Option selected for 

MODEL_TYPE=1 

ETL_APPSRC_TYPE The ETL application name 
0=New Pair 

1=Existing 

# Mandatory 

Existing source is to be used i.e. 

ETL_APPSRC_TYPE  = 1 

ETL_SRC_1_NAME ETL Staging Source Name 
Example: 

STAGING 

# Mandatory 

ETL_SRC_1_NAME to be given is to 

be same as the source name given 

for base installation 

ETL_SRC_1_DESC ETL Staging Source Description 
Example: 

STAGING 

# Mandatory if you want to create 

new ETL src 
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NOTE:  When you are entering the values, the names must be same as the ones given 

in the previous full installation process. Refer to the Silent Mode Installation 

section. 

14. Edit the OFS_DM_PACK/conf/OFS_DM_PACK.xml to enable the product licenses. 

Update the attribute ENABLE=YES/NO in OFS_DM_pack.xml for licensing the App in the 

pack. 

NOTE:  Prior to installing the DM Application Pack in SILENT mode, refer to the 

OFS_DM_PACK.xml section in Appendix: DM Pack XML Files.  

15. Execute setup.sh file using the following command:  

./setup.sh SILENT  

Verify if the release is applied successfully by checking the log file generated in the 

installation folder. You can ignore ORA-00001, ORA-00955, ORA-02260, and ORA-

01430 errors in the log file. In case of any other errors, contact Oracle Support.  

16. In case of DGS, install AAI 8.0.6.1.0 one-off patch 28033370 if this patch is not already 

applied. Refer to the Readme available with the patch for further instructions on installing 

the patch. 

17. For more information on securing your OFSAA Infrastructure, refer to the OFSAA 

Security Guide in OHC Documentation Library.  

18. After successful installation, follow these steps:  

Log in to the web application server and clear the application cache. Navigate to the 

following path depending on the configured web application server and delete the files.  

• Tomcat  

<Tomcat installation folder>/work/Catalina/localhost/<Application 

name>/org/apache/jsp  

• WebLogic  

<Weblogic installation location>/domains/<Domain 

name>/servers/<Server name>/tmp/_WL_user/<Application name>/<auto 

generated folder>/jsp_servlet  

In case of WebLogic version 12.2.x.x, delete the folder named 

".WL_internal" present in the path  <WebLogic installation 

location>/user_projects/domains/< Domain name 

>/applications/<context_name>.ear/META-INF/", if it exists. 

• WebSphere 

<Websphere installation folder>/AppServer/profiles/<Profile 

name>/temp/<Node name>/server1/<Application name>/<.war file 

name> 

http://docs.oracle.com/cd/E61555_01/homepage.htm
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19. Add unmask 0027 in the .profile of the UNIX account which manages the WEB server to 

ensure restricted access permissions.  

20. Restart all the OFSAAI services. For more information, refer to the Start/Stop 

Infrastructure Services section in Appendix D.  

21. Before generating the application EAR/WAR file and deploying the application onto 

configured Tomcat, see Deploying WAR Files on Tomcat. 

22. Generate the application EAR/WAR file and redeploy the application onto your configured 

web application server. For more information on generating and deploying EAR / WAR 

file, refer Appendix C section.  

23. For enabling TDE, see Configuring TDE in case of Upgrade. 

24. For enabling Data Redaction, see Enabling Data Redaction in case of Upgrade.  

25. DMT migration is mandatory step to be followed as per AAI guide. For information on 

DMT Metadata Migration refer AAI DMT Migration Guide. 

26. Resave all GL Hierarchies starting from HGL001 to HGL013. 

 

 

https://docs.oracle.com/cd/E60058_01/PDF/8.0.6.x/8.0.6.0.0/OFSAA%20DMT%20Metadata%20Migration%20Guide%208.0.6.0.0.pdf
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7 Post Installation Configuration 

On successful installation of the Oracle Financial Services Data Management Application Pack, 

perform the post installation steps mentioned as follows. 

This chapter includes the following sections: 

• Configuring Resource Reference 

• Starting OFSAA Infrastructure Services 

• Adding TNS entries in TNSNAMES.ORA file 

• Creating and Deploying the Application Pack Web Archive 

• Accessing the OFSAA Application 

• Performing Post Deployment Configurations 

• Changing Batch Ownership 

• Enabling Metadata Browser 

• Performing Post-Installation Configuration for Data Management Application Pack 

• Configuring Process Monitoring Runs and Tasks for Data Management Application 

Pack 

• Passing the RUNSKEY as Parameter 

• Livy Configuration 

• Hive Configuration 

NOTE:   

• In case of Hybrid, for post install script execution, refer the file post_install_table_list.sql. 

• While upgrading GL from 8.0.5 or 8.0.5.1 to 8.0.6, update the parameters of 

SETUP_MASTER from existing setup into GL_SETUP_CONFIGURATION table. 

• Install Data Management Pack 8.0.6.0.1 one-off patch (Bug No. 28861525) after 

installation of Data Management Pack 8.0.6.0.0. 

• Ensure to clear the application cache prior to the deployment of Application Pack Web 

Archive. This is applicable to all Web Servers (WebSphere, WebLogic, Tomcat). For 

more information, see Clearing Application Cache section. 

• It is recommended to save the batch execution rights (for GL Recon Admin and DGS 

Admin) in the Batch Execution Rights screen. The runs can be viewed under "Batch 

Execution" screens. 

• For information on Servlet Entries, refer the MOS link. 

https://docs.oracle.com/cd/E93133_01/PDF/common/post_install_table_list.sql
https://support.oracle.com/epmos/faces/DocumentDisplay?_afrLoop=533212199360050&id=2505567.1&_afrWindowMode=0&_adf.ctrl-state=t8d84cvsb_4
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• You must install the consolidated patch for bug 27938294 from 

https://support.oracle.com. Refer to the read me available with the patch for further 

instructions on installing the patch. 

• The following five AAI patches are mandatory for OFS GL. These patches must be the 

last one to be applied for pack on pack scenarios. Follow this sequence to install them 

27938294, 28079607, 28033582, 28146898 and 28399816. 

• DMT migration utility is available as part of the OFSAAI 8.0.6.0.0 upgrade to migrate the 

DMT metadata (PLC/Data Source/Data Mapping/Data File Mapping) to be persisted in 

tables instead of XML. To identify when to migrate, what/how to migrate, and how to 

handle migration issues, see OFSAA DMT Metadata Migration Guide. 

o Execute the DMT Migration Utility to manually migrate the DMT metadata of the 

Applications which are not upgraded to 8.0.6.0.0. 

7.1 Configuring Resource Reference 

Configure the resource reference in the Web Application Server configured for OFSAA 

Applications. See Appendix B for details on configuring the resource reference in WebSphere, 

WebLogic, and Tomcat Application Servers.  

7.2 Starting OFSAA Infrastructure Services 

Start the OFSAA Infrastructure Services prior to deployment or accessing the OFSAA 

Applications. See the Appendix D for details on Start/ Stop OFSAA Services. 

7.3 Adding TNS entries in TNSNAMES.ORA file 

Add TNS entries in the tnsnames.ora file, for every schema created for the Application Pack. 

To find the tnsname for the entries, perform the following steps: 

1. Login to the application using System Administrator privileges. 

2. Navigate to System Configuration & Identity Management tab. 

3. Click Administration and Configuration → System Configuration → Database Details. 

4. Expand the dropdown list for Name to get the list of TNS entry names. 

Alternatively, you can connect to the CONFIG schema and execute the following query: 

select dbname from db_master where dbname !='CONFIG' 

https://support.oracle.com/
https://docs.oracle.com/cd/E60058_01/PDF/8.0.6.x/8.0.6.0.0/OFSAA%20DMT%20Metadata%20Migration%20Guide%208.0.6.0.0.pdf
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7.4 Creating and Deploying the Application Pack Web Archive  

On successful installation of the OFSAA Application Pack, the web archive file is automatically 

generated. However, you need to deploy the generated web archive file on the Web Application 

Server.  

To deploy the application pack web archive, perform the following steps: 

1. Navigate to FICWEBHOME 

2. Run ant.sh 

For identifying the location of the generated web archive file and for generating and deploying the 

web archive file at any time later, see Appendix C 

NOTE:  See the Oracle Financial Services Forms Manager User Guide for instructions on Creating 

and Deploying the Forms Manager Web Archive 

7.5 Accessing the OFSAA Application 

Prior to accessing the OFSAA application ensure the Internet Explorer Settings are configured. 

Refer Appendix E for details on accessing the OFSAA Application on successful deployment of 

the application web archive. 

7.6 Performing Post Deployment Configurations 

Prior to using the OFSAA Application perform the Post Deployment Configuration steps detailed 

in Appendix F. 

7.7 Changing Batch Ownership   

All the seeded batches are created with SYSADMN as the owner by default. This needs to be 

updated with username of the user who is responsible for maintenance of the batches. This can 

be done by executing the below procedure in the config schema: 

begin  

AAI_OBJECT_ADMIN.TRANSFER_BATCH_OWNERSHIP('fromUser','toUser','infodom;  

end;  

OR 

begin  

AAI_OBJECT_ADMIN.TRANSFER_BATCH_OWNERSHIP('fromuser','touser');  

end; 

where “FromUser” indicates the user who currently owns the batch and “toUser” indicates the 

user to which ownership needs to be transferred to. “Infodom” is an optional parameter. 
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7.8 Enabling Metadata Browser 

Execute the following as part of post installation step atomic schema:  

declare  

result number;  

begin  

result:=fn_mdb_t2t_view;  

dbms_output.put_line(result);  

exception  

when others then  

dbms_output.put_line(SQLERRM);  

end; 

7.9 Performing Post-Installation Configuration for Data Management Application 

Pack 

Perform the following steps for post-installation configuration of Data Management Application 

Pack: 

1. Restore the following tables that were truncated as part of the Installation Prerequisites 
section. 

a. DQ_RESULT_DETL_MASTER 

b. DQ_RESULT_SUMM_MASTER 

2. Create application specific users, and map them to the respective user groups available in 
the application. For details see section Mapping Application Users to User Groups. Whenever 
the user to user group mapping is created/ modified, execute the step 2 and 4 below. 

3. After successful installation, execute the batch <INFODOM>_USER_ROLES. 

4. Then perform these steps: 

a. Generate source model for the application-source pair used during installation. 

i. Login to the application and navigate to Common Tasks > Unified Analytical 
Metadata > Data Management Tools. 

ii. In the Data Management Tools pane, click Data Sources. 

 

file:///D:/DGS/DGS_Framework/OFSAA_DM_Pack_801_with_DGS_Installation_Guide.docx%23mapping_app_users_to_user_groups
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iii. The Source Designer window opens. Scroll down to the Map section and select the 
application from drop down box. In the Source Applications pane, in Mapped 
Sources, select the required value. Click the Generate Source Model icon. 

iv. A dialog box opens with the message: Model already exists for the source. Do you 
want to replace existing model? To replace the existing model, click OK.  

v. The Generate Source Model window is displayed. To generate the source model, 
click the Catalog icon and then click Generate. 

vi. An acknowledgement message is displayed: Source model generation successful. To 
complete the process of Source Model Generation, click OK. 

b. Resave the following mentioned derived entities: 

• DEATNAME: DE Attribute Name 

• DE Business Line 

• DEGLSTERM: DE Business Term 

• DE Components 

• DE Document Type 

• DEENNAME: DE Entity Name 

• DE Frequency 

• DE KI Frequency 

• DE Location 

• DE Measure Scale 

• DE Process 

• DE Risk Categories 

• DE User List 

• DE_GROUP 

• PMREPLINK 

c. Resave the following mentioned hierarchies: 

• HDGENNAM: Entity Name Hierarchy 

• HDGATNAM: Attribute Name Hierarchy 

• HDGGLTRM: Business Term Hierarchy 

• Reports Hierarchy 

 

5. Save the hierarchies in Common Tasks > Unified Analytical Metadata > Business 
Metadata Management > Save Metadata 
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6. Compile the backend objects such as functions, procedures and packages which are related 
to DGS.  

7.10 Configuring Process Monitoring Runs and Tasks for Data Management 

Application Pack 

As a pre-requisite, before configuring the runs and tasks, ensure the following: 

Oracle Financial Services Regulatory Reporting for US Federal Reserve 8.0.6 version or Oracle Financial 

Services Regulatory Reporting Solution for US Treasury or Oracle Financial Services Regulatory 

Reporting for European Banking Authority (OFS REG REP USFED 8.0.6 or OFS_REG_REP_USTR 

8.0.5.1.0 or OFS REG REP EBA 8.0.6) is installed and configured. 

MDB Publish is performed for Oracle Financial Services Regulatory Reporting for US Federal Reserve 

8.0.6. 

NOTE:  See Oracle Financial Services Regulatory Reporting for US Federal Reserve 8.0.6 or Oracle 

Financial Services Regulatory Reporting Solution for US Treasury or Oracle Financial 

Services Regulatory Reporting for European Banking Authority Installation and 

Configuration on OHC for more details. 

As part of configurations perform the following steps to load the Process Monitoring related plans, 

runs and tasks associated with OFS REG REP USFED 8.0.6 or OFS_REG_REP_USTR 8.0.5.1.0 

or OFS REG REP EBA 8.0.6 install. 

1. Login to OFSAAI using a user having permissions for running batches. 

2. Navigate to Batch Execution screen and search for the batch ID such as 

Process_Monitoring_Batch. 

http://docs.oracle.com/cd/E60528_01/homepage.htm
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3. Select the MIS Date and execute the batch Process_Monitoring_Batch. 

4. Check and ensure that the batch is executed successfully.  

5. Navigate to Process Monitoring menu under Data Governance application and ensure 

that the Plans, Runs and Tasks are displayed for OFS REG REP USFED 8.0.6 or 

OFS_REG_REP_USTR 8.0.5.1.0 or OFS REG REP EBA 8.0.6. 

 

7.11 Passing the RUNSKEY as Parameter 

The Bulk KI Assessment batch expects RUNSKEY to pass as a parameter. 

In an integrated setup, user can avoid passing RUNSKEY parameter manually by including the 

bulk KI assessment process part of either US FED 8.0.6/ EBA 8.0.6/FSDF 8.0.6 Run. 

For a standalone setup, user needs to pass the RUNSKEY parameter separately from the UI. For 

the same, user needs to navigate to the UI and make the specified changes in the batch to set 

the desired RUNSKEY. 

The process to pass RUNSKEY as a parameter from the UI is to update the 

BULK_KI_ASSESMENT batch: 

1. Navigate to Applications after selecting Financial Services Data Governance for the 

preferred jurisdiction. 
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2. Navigate to Common Tasks -> Operations -> Batch Maintenance. 

 

3. Select the Bulk KI Assessment batch to edit the Task definition. Pass the RUN SKEY 

parameter for which user needs to perform assessment. 
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7.12 Livy Configuration 

Populate the AAI_DMT_DB_CLUSTER_PROPERTY table in the config schema to point to the livy url 

against all the infodoms being used. Duplicate the entries for each infodom. 

   V_DB_CLUSTER_ID  V_PROPERTY_NAME V_PROPERTY_VALUE  

<INFODOMNAME> LIVY_AUTH_TYPE    DEFAULT    

<INFODOMNAME> LIVY_SERVICE_URL   <http://ofss222xxx:8998> 

7.13 Hive Configuration 

In case of Hybrid deployment the following are the Hive configurations: 

1. Copy hive-site.xml from hive conf directory to SPARK2 conf directory. 
For example.  
cp /etc/hive/conf.cloudera.hive/hive-site.xm /etc/spark2/conf.cloudera.spark2_on_yarn 
 

2. Edit the file to have the following entry in SPARK2 conf. 
 

In Hive conf In spark conf 

<property>               

<name>hive.metastore.warehouse.dir</name> 

<value>/user/hive/warehouse</value> 

</property> 

<property>        

<name>spark.sql.warehouse.dir</name> 

<value>/user/hive/warehouse</value> 

</property> 

Note:  For additional information please refer the AAI Installation guide OHC. 

http://ofss222xxx:8998/
https://docs.oracle.com/cd/E60058_01/homepage.htm
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8 Oracle Reconciliation Framework Configuration 

Following steps are to be followed for configuring Reconciliation Framework Analytics v8.0.6.0.0 

Dashboards and Reports after OBIEE installation (Server): 

A. Preliminary Installation of Software  

 

1. Make sure Oracle Business Intelligence (Version 11.1.1.9.0) installation is completed and 

available.  

2. If the OBIEE is installed in other than Windows environment, make sure that a 

standalone OBIEE Client is installed in a Windows environment. 

B. Modify Repository Connection Pool Settings  

For Windows Server 

 

1. Copy the Repository file from the $FIC_HOME/GLBI and place it in the Repository folder 

where OBIEE is installed.  

i.e.<OBIEE Install Folder>/instances/instance1/bifoundation/ 

OracleBIServerComponent/coreapplication_obis1/repository. 

2. Select Start > Programs > Oracle Business Intelligence > Administration. 

3. Select File > Open > Offline. 

4. Locate the OFS GL 8.0.rpd and open.  

5. Provide Repository password. The Repository password is 'weblogic123'  

Set the Connection Pool Properties 
6. In the "Physical" layer, under Database object double-click on the "Connection Pool" to 

update its properties.. 

7. In the ‘General’ tab, edit / check the following entries: 

8. Call Interface: Default (OCI 10g/11g) 

9. Update Data source name as give in the below example: 

For example: 

(DESCRIPTION=(ADDRESS_LIST=(ADDRESS=(PROTOCOL=TCP)(HOST=<Database 

IP Address>)(PORT=<Port no>)))(CONNECT_DATA=(SID=<Database name>)))  

10.  Enter Database Schema user name in the User Name field. 

11. Enter Database Schema password in the Password field. 

12.  Click 'OK' to close the window and click 'Save' to save the RPD file. 

13.  Click 'No' for the Global Consistency Message. 
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14.  Close the RPD file (File / Exit).     

For Other Servers  

 

1. Copy the Repository file from the $FIC_HOME/GLBI and place it anywhere in the local 

Windows system. 

2. Open the BI Administration tool in the windows environment. 

3. Select Start > Programs > Oracle Business Intelligence Enterprise Edition Plus Client> 

Administration. 

4. Select File > Open > Offline. 

5. Locate the file OFS GL 8.0.rpd and open. 

6. Provide Repository password. The Repository password is 'weblogic123' 

Set the Connection Pool Properties as described above 6-14.  

 
C. Starting Node manager and WebLogic Servers 

 

1. Check if the Node Manager is running or not. If not then follow the below steps. 

For Windows Server 

 

1.1 Navigate to the services. 

1.2 Start the Service Oracle Weblogic NodeManager. 

 
 

Alternatively you can start Node Manager and all the managed services from the All 

Programs -> Oracle Business Intelligence-> Start BI Services option in the start menu. 
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For Other Servers  

 

1.1 Navigate to < OBIEE Install Folder >/ wlserver_10.3/server/bin folder. 

1.2 Run the following command: ‘nohup ./startNodeManager.sh &’. 

2. Check if the Weblogic AdminServer if running or not. If not then follow the below steps. 

For Windows Server 

 

2.1 Navigate to < OBIEE Install Folder >/user_projects/domains/bifoundation_domain/bin 

2.2 Run the following command: startWebLogic.cmd 

Note: The Weblogic Admin Server would have been already started if you had started 

through the, All Programs -> Oracle Business Intelligence-> Start BI Services option as 

stated above. 

 

For Other Servers  

 

2.1 Navigate to < OBIEE Install Folder >/user_projects/domains/bifoundation_domain/bin 

2.2 Run the following command: ‘./startWebLogic.sh’ 

2.3 Enter the weblogic credential defined during the installation. 

2.4 Bringing up this service may take a few minutes depending on your environment, wait 

until the command line stops scrolling and indicates server in RUNNING mode. 

 
 

3. Start Weblogic Managed Server (bi_server1) 

a. Log in to Fusion Middleware Control ‘ http://<hostserver name or IP>:<Port No Default is 

7001>/em’ using the weblogic credentials defined during installation. 

b. Under the WebLogic Domain expand the bifoundation_domain node in the navigation tree, 

and select bi_cluster. Select bi_cluster, and click the WebLogic Cluster menu to the right 

of it. Select the Control option from the menu, and select Start Up to start the Managed 

Servers. 
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c. Verify the status of the applications. 

 
 

D. Deployment 

 

1. Deploy RPD file.  

1.1 Log in to Fusion Middleware Control ’http://<hostserver name or IP>:<Port No Default is 

7001>/em’ using the weblogic credentials defined during installation. 

1.2 Go to Business Intelligence folder > coreapplication> Deployment and click on Lock and Edit 

Configuration.  
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1.3 In the Upload BI Server Repository click on Browse and locate the folder where the new OFS 

GL 8.0.RPD which has to be deployed is present.  

1.4 Now put the existing RPD Password. Then Apply > Activate Changes.  

1.5 You can see the new Default RPD as the OFSGL3_BI0008.0 

 
 

1.6 Restart the BI Server as mentioned in section E. 

1.7 Modify the NQSConfig.INI file to incorporate User Roles and Group Id changes in case any 

GUID related error occurs. The location is  

< OBIEE Install Folder> 

/instances/instance1/config/OracleBIServerComponent/coreapplication_obis1  

Change the FMW_UPDATE_ROLE_AND_USER_REF_GUIDS to YES. 

Example: FMW_UPDATE_ROLE_AND_USER_REF_GUIDS = YES; 

 

1.8 After modifying the file, restart the BI services again to remove the above error.  
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2. Deploy Web Catalog. 

2.1 Copy the GL_Recon_8.0.catolog file from $FIC_HOME/GLBI folder. 

2.2 Navigate to Business Intelligence folder > coreapplication> Deployment and check for the 

Catalog name. Change to GL then apply and activate changes. This will create a new empty 

catalog with the name given. 

Example: 

$ORACLE_INSTANCE/bifoundation/OracleBIPresentationServicesComponent/$COMPONE

NT_NAME/catalog/GL 

 

 
 

2.3 Navigate to Catalog Manager. Open the newly created catalog. File -> Open Catalog. 

2.4 Open the catalog offline -> Browse to the catalog path. Click OK.   

 
 

2.5 Now navigate to the /shared folder in the catalog manager and unarchive by selecting the 

path where the GL_Recon_8.0.catolog was present. Then press ok. 
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2.6 Verify that the GL folder appears under /shared folder. 
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2.7 Once the Unarchive is done.  Restart the BI Presentation Services (see section E) to apply 

the change.  

2.8 Modify the instanceconfig.xml file in case of any GUID error related to the BI Presentation 

Server to instruct Presentation Services to refresh GUIDs on restart.  

The location of instanceconfig.xml file is < OBIEE Install Folder> 

/instances/instance1/config/OracleBIPresentationServicesComponent/coreapplication_obips1 

Edit the file to add the line <UpdateAccountGUIDs>UpdateAndExit</UpdateAccountGUIDs> 

and restart the BI presentation services once again. 

2.9 Note that the steps mentioned above will force the BI Presentation Services to shut down 

after updating the Account GUIDS.  

In that case, go to instanceconfig.xml file and revert back the changes made i.e. remove the 

line <UpdateAccountGUIDs>UpdateAndExit</UpdateAccountGUIDs> from the 

instanceconfig.xml file and restart the services again.  

E. Starting the Analytics services  

 

The Oracle Business Intelligence system components can start in any of the following manner.  

 

1. Through OPMN controller 

For Windows Server 

 

1.1 Open a command prompt, navigate to <OBIEE Install 

Folder>/instances/instance1/bin 

1.2 Run the ‘opmnctl startall’ command. 

For Other Servers  
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a. Navigate to < OBIEE Install Folder > /instances/instance1/bin  

b. Run the command ‘. /opmnctl startall’ 

c. Check the status by running the command ‘. /opmnctl status’ 

 
  

2. Through Enterprise Manager 

a. Login to the EM administration screen using the url ’http://<hostserver name or 

IP>:<Port No Default is 7001>/em’ 

b. Expand 'Business Intelligence' node on the left and choose Core application. 

c. Navigate to Capacity management > Availability. 

d. Click on the necessary buttons to start and stop the services. 
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3. In case of any problems check for the log files present in the respective diagnostic folders 

of analytics server that is, <OBIEE Install Folder>/instances/instance1/diagnostics/logs. 

F. Testing the Analytics reports  

 

1. Log in to ‘http:// <host server name or IP>:<Port No default is 

7001>/analytics/saw.dll?Dashboard’ using your Administrator credentials created during 

platform install. 

2. Check for the reports availability.  

In case of any problems, check for the log files present in the respective diagnostic 

folders of analytics server, that is, <OBIEE Install 

Folder>/instances/instance1/diagnostics/logs. 
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9 Deploying Data Management Application Pack Analytics 

This chapter includes the following sections: 

• Managing OBIEE Activities 

• Deploying Data Management Application Pack Analytics 

9.1 Managing OBIEE Activities 

This section covers following topics: 

• Installing OBIEE Server 

• Installing OBIEE Windows Administration Client 

• Disabling the Cache Feature in OBIEE Server 

9.1.1 Installing OBIEE Server 

To install Oracle Business Intelligence Enterprise Edition (OBIEE) server, refer to Oracle Fusion 

Middleware Installation Guide for Oracle Business Intelligence11g Release 1 (11.1.1.9.0). After 

installing Oracle Business Intelligence Enterprise Edition (OBIEE) server, get the Enterprise 

Manager URL, username, password, and OBIEE installed directory from the System 

Administrator. 

9.1.2 Installing OBIEE Windows Administration Client 

To install OBIEE repository administration client for Windows machine, refer to Oracle® Fusion 

Middleware Installation Guide for Oracle Business Intelligence11g Release 1 (11.1.1.9.0). 
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9.1.3 Disabling the Cache Feature in OBIEE Server 

Login to Enterprise Manager, and perform the following steps: 

1. Click Business Intelligence directory from left hand side menu and select coreapplication. 

 

2. Select Capacity Management tab. 

3. Select Performance sub tab. 

4. Click Lock and Edit Configuration tab. 

5. Uncheck the Cache Enabled option to disable the cache. 

6. Click Apply → Activate Changes. 

7. Select Yes when prompted. 

8. Click Restart to apply recent changes. 

9.2 Deploying Data Management Application Pack Analytics 

Perform the following steps to deploy Analytic Reports:  

1. Stop Oracle Process Manager and Notification Server (OPMN) services by executing the 

following command: 

<OBIEE Installed Directory>/instances/instance1/bin 

./opmnctl stopall 

2. Copy DGS.rpd from $FIC_HOME/DGSBI of Web layer to windows machine where the 

OBIEE windows administration client is installed. 

3. Perform the following steps to change the default password for the repository: 

a. Open the repository using OBIEE Windows administration client. 

b. Select DGS.rpd file. Click Open. 



Oracle Financial Services Software 

OFSDM 8.0.6.0.0 Installation Guide  

 

122 

 

c. The OBIEE Windows Administration Client to enter Repository Default Password is 

displayed. 

 

d. Enter default repository password as password123. 

e. Click File menu, select Change Password. 

 

4. Enter the new password. Click OK. 

5. Perform the following steps to configure connection pool of repository: 

a. Select Manage → Variables from the menu. 
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b. Select static variables under the Repository section. 

 

c. Select the variable SCHEMA and enter the schema name within single quotes under the 

Default Initializer section. Save the changes. 

d. Select the variable TNS and enter the TNS details within single quotes under the Default 

Initializer section. Save the changes. 

e. In the Physical section, expand DGS directory. 
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f. Double-click Connection Pool to open the Connection Pool Properties window. 

g. Enter atomic schema user password in Password text box. 

h. Click OK. 
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i. Double-click Initialization Blocks to open the Connection Pool window. 

j. Enter atomic schema password in Password text box. 

k. Click OK. 

 

6. Click File menu and then click Save. 
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7. Click Yes on the pop-up message, Do you want to check global consistency? 

 

8. Click OK, on the pop-up message Consistency check didn’t find any errors, warning or best 

practices violations. 

NOTE:  Warnings on consistency check can be ignored. 

 

9. Copy DGS.catalog file from <FIC_HOME>/DGSBI of Web layer to your local machine. 

10. Login to Enterprise Manager. Click Business Intelligence directory at LHS. Select 

coreapplication and then click Deployment tab. 
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11. Click Repository tab. 

 

12. Click Lock and Edit Configuration. The Lock and Edit Configuration Confirmation window is 

displayed. 

 

13. Click Close. 

14. In Upload BI Server Repository section, browse the DGS.rpd file from Windows machine. 
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15. Enter the new repository password in Repository Password and Confirm Password. 

16. In BI Presentation Catalog section, provide the Catalog Location as  

<OBIEE Installed Directory>/instances/instance1/bifoundation/ 

OracleBIPresentationServicesComponent/coreapplication_obips1/ 

catalog/DGS 

17. Click Apply. 

18. Click Activate Changes. An Activate Changes Confirmation window is displayed. 

 

19. Click Close. 

20. Click Restart to apply recent changes. 

You will notice a new catalog folder with the name DGS is created at the location <OBIEE 

Installed Directory>/instances/instance1/bifoundation/Oracle 

BIPresentationServicesComponent/coreapplication_obips1/catalog/ 

21. Select Catalog Manager to connect to the new catalog. 
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22. Once connected, expand Catalog Root and select Shared Folders. 
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23. Select File and then Unarchive from the drop down. 
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24. When prompted, click Browse and select the saved DGS.catalog file on your local machine. 

25. The RPD and catalog are deployed and the application is ready to view the reports. 

9.3 Updating Server Specific Parameters 

This feature is used in the dashboards where in the user navigates from OBIEE dashboard links 

to OFSAA application. For Example: Create a new issue 

1. Insert/update the columns of the table obiee_parameters in atomic schema with the 

appropriate values. 

INFODOM <INFODOM> 

SEGMENT <SEGMENT> 

LOCALE <LOCALE> 

9.4 Alias Configuration 

This configuration is required to successfully navigate from a report to a dashboard page while 

filtering the data in the all the reports on that page. This functionality is used in various reports 

across the DGR dashboards. 
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1. Navigate to 

<MIDDLEWARE_HOME>/user_projects/domains/bifoundation_domain/ 

config/fmwconfig/biinstances/coreapplication directory. 

2. Locate the ActionFrameworkConfig.xml file. Take a backup so that any unwanted 

changes to the file can be reverted to the original state. 

3. Open the file for editing. Locate the </aliases> tag and replace it with the following XML 

code: 

<aliases> 

<location-alias> 

<alias>actionsrv</alias> 

<actual>http://<hostname>:<port_number> </actual> 

</location-alias> 

<location-alias> 

<alias>biserver</alias> 

<actual>http:// 

<hostname>:<port_number>/analytics/saw.dll?WSDL</actual> 

<alias>app_url</alias> 

<actual><OFSAA_APP_URL></actual> 

</location-alias>                                                                                                                                                                                               

</aliases>    

For Example: 

<actual>http://10.184.155.80:15520/DGSGL</actual>                                                                                                                                                                                     

NOTE:  The <hostname>, <port_number> and <OFSAA_APP_URL> must be replaced with server 

specific values. 

4. Save the file. 

5. Restart the OPMN and Managed Servers. 

9.5 Starting Node Manager and WebLogic Servers 

Check if the Node Manager is running or not. If not then perform the following steps. 

For Windows Server 

2. Navigate to Services. 

3. Start Service Oracle WebLogic NodeManager. 
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4. Alternatively you can start Node Manager and all the managed services from the All 

Programs → Oracle Business Intelligence → Start BI Services option in the start 

menu. 

 

For Other Servers 

1. Navigate to <OBIEE Install Directory>/ wlserver_10.3/server/bin directory. 

2. Run the following command:  

nohup ./startNodeManager.sh & 

tail –f nohup.out 

3. Bringing up this service may take a few minutes depending on your environment, wait 

until the command line stops scrolling and indicates INFO: Secure socket listener 

started on port <port_no>. 

4. Check if the WebLogic Admin Server is running. If not, then follow the below steps. 

For Windows Server 

1. Navigate to <OBIEE Install Directory>/user_projects/domains/bifoundation_domain 

/bin directory. 

2. Run the following command:  

startWebLogic.cmd 

NOTE:  The WebLogic Admin Server would have been already started if you had started through the, 

All Programs → Oracle Business Intelligence → Start BI Services as stated above. 
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For Other Servers  

1. Navigate to <OBIEE Install Directory>/user_projects/domains/bifoundation_domain 

/bin directory. 

2. Run the following command:  

nohup ./startWebLogic.sh & 

3. Enter the WebLogic credential defined during the installation. 

4. Execute the following command: 

tail –f nohup.out 

5. Bringing up this service may take a few minutes depending on your environment, wait 

until the command line stops scrolling and indicates Server started in RUNNING mode. 

 
4. Start WebLogic Managed Server (bi_server1) 

a. Log in to Fusion Middleware Control ‘ http://<hostserver name or IP>:<Port No Default 

is 7001>/em’ using the WebLogic credentials defined during installation. 

b. Under the WebLogic domain expand the bifoundation_domain node in the navigation 

tree, and select bi_cluster. Click the WebLogic Cluster menu to the right of it. Select 

Control from the menu, and select Start Up to start the Managed Servers. 
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c. Verify the status of the applications. 

 
5. Through Enterprise Manager: 

a. Login to the EM Administration screen using the URL  

’http://<hostserver name or IP>:<Port No Default is 7001>/em’ 

b. Expand Business Intelligence node on the left pane and select 

coreapplication. 

c. Navigate to Capacity Management → Availability. 

d. Click on the necessary buttons to start and stop the services. 
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e. If any problems, check for the log files present in the respective diagnostic 

directories of the analytics server, that is, <OBIEE Install 

Directory>/instances/instance1/diagnostics/logs. 

6. Testing the Analytics Reports: 

a. Log in to ‘http:// <host server name or IP>:<Port No default is 

7001>/analytics/ saw.dll?Dashboard’ using your Administrator credentials 

created during platform install. 

b. Check for the reports availability.  

If any problems, check for the log files present in the respective diagnostic directories of 

the analytics server, that is, <OBIEE Install 

Directory>/instances/instance1/diagnostics/logs 

 

For details, see Oracle Business Intelligence Configuration Guide. 

 

https://docs.oracle.com/cd/E57638_01/doc.80/e50113/toc.htm
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10 Appendix A: Configuring Web Server 

This appendix includes the following sections: 

• Configuring Web Server 

• Configuring Web Application Server 

10.1 Configuring Web Server 

This step assumes an installation of a Web Server exists as per the prerequisites. 

Refer the product specific Installation Guide/ Configuration Guide to install/ configure the Web Server. If 

an installation already exists, skip and proceed to the next step. 

NOTE:  Make a note of the IP Address/ Hostname and Port of the web server. This information is required 

during the installation process. 

10.2 Configuring Web Application Server 

This step assumes an installation of a web application server exists as per the prerequisites. To configure 

the Web Application Server for OFSAA Deployment refer the following sections:  

This section includes the following topics: 

• Configuring WebSphere for Application Deployment 

• Configuring WebLogic for Application Deployment 

• Configuring Apache Tomcat Server for Application Deployment 

NOTE:  Make a note of the IP Address/ Hostname and Port of the web application server. This information is 

required during the installation process (required if Web Server is not configured). 

Refer OFSAA Secure Configuration Guide/ Security Guide mentioned in the Related 

Documents section for additional information on securely configuring your Web Server. 

10.2.1 Configuring WebSphere Application Server for Application Deployment 

You can deploy multiple OFSAA applications on different profiles of a WebSphere application server. To 

create multiple WebSphere "Profiles", in a stand-alone server use the command line option as explained 

below. A profile is the set of files that define the runtime environment. At least one profile must exist to run 

WebSphere Application Server. 

This section includes the following topics: 

• Creation of New Profile in WebSphere 

• Managing IBM WebSphere SDK Java Technology Edition Versions 

• Manage Applications in WebSphere 



Oracle Financial Services Software 

OFSDM 8.0.6.0.0 Installation Guide 

 

 

138 

 

• Delete WebSphere Profiles 

• Configuring WebSphere Shared Library to Support Jersey 2x and Jackson 2.9x Libraries 

• Error! Reference source not found. 

• WebSphere Memory Settings 

• Configuring WebSphere for REST Services Authorization 

• Configuring Application Security in WebSphere 

10.2.1.1 Creation of New Profile in WebSphere 

A new profile is created in WebSphere through the command line interface using the manageprofiles.sh 

command which resides in <WebSphere Install directory>/AppServer/bin directory. 

The command to create a profile without admin security through command line is as follows: 

"manageprofiles.sh -create -profileName <profile> -profilePath <profile_path> 

-templatePath <template_path> -nodeName <node_name> -cellName <cell_name> -

hostName <host_name>" 

Example: 

$usr/home>./manageprofiles.sh -create -profileName mockaix -

profilePath/websphere/webs64/Appserver/profiles/mockaix -

templatePath/websphere/webs64/Appserver/profileTemplates/default -nodeName 

ipa020dorNode04 - cellName ipa020dorNode04Cell -hostName ipa020dor 

The command to create a profile with admin security through command line is as follows: 

"manageprofiles.sh -create -profileName <profile> -profilePath <profile_path> 

-templatePath <template_path> -nodeName <node_name> -cellName <cell_name> -

hostName <host_name> -enableAdminSecurity true -adminUserName <Admin User 

Name> -adminPassword < Admin User Password> -samplespassword <sample User 

Password>" 

Example: 

$usr/home>./manageprofiles.sh -create -profileName mockaix -

profilePath/websphere/webs64/Appserver/profiles/mockaix -

templatePath/websphere/webs64/Appserver/profileTemplates/default -nodeName 

ipa020dorNode04 -cellName ipa020dorNode04Cell -hostName ipa020dor -

enableAdminSecurity true -adminUserName ofsaai -adminPassword ofsaai -

samplespassword ofsaai" 

NOTE:  While using the manageprofiles.sh command to create a new profile in WebSphere, you can also use 

"-validatePorts" to validate if the specified ports are not reserved or in use. Additionally, you can 

specify new ports with "-startingPort <base port>" which specifies the starting port number to 

generate and assign all ports for the profile. For more information on using these ports, refer 

WebSphere manageprofiles command. 
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10.2.1.2 Managing IBM WebSphere SDK Java Technology Edition Versions 

By default, WebSphere Application Server V8.5.5.X uses the Java 6.0 SDK. You must upgrade to Java 7.X SDK 

or JAVA 8.X SDK. 

Prerequisites: Install the IBM WebSphere SDK Java Technology Edition Versions 1.7.X_64 or 1.8.X_64. 

Perform the following steps to upgrade to Java 7.X SDK or JAVA 8.X SDK: 

1. Enter the WebSphere URL in the format http://HOST_NAME:PORT_ NUMBER/ibm/console (use 

https if SSL is enabled.). For example, http://192.168.1.0:9000/ibm/console. 

2. Login with your administrator user ID and password. 

3. From the LHS menu, click Servers to expand and view the menu. 

4. Click Server Types to expand the menu further and then click WebSphere Enterprise Application Servers 

to view the Application servers window. 

5. On Application servers window, click the required Application Server link. For example, server1 in the 

following illustration: 

 

6. Click Java SDKs link from Server Infrastructure to view the list of Java SDKs. 
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7. Select either 1.7_64 or 1.8_64 based on the JVM version with which you plan to install OFSAA or have 

installed with. 

8. Click Make Default button and save to master repository. 

9. Restart the WebSphere Application Server to apply the changes to the IBM application profile. 

 

10.2.1.3 Manage Applications in WebSphere 

To manage the installed applications in WebSphere, do the following: 

1. Open the administrator console using the following URL: 

http://<ipaddress>:<Administrative Console Port>/ibm/console 

Example: http://10.111.222.333:9003/ibm/console (https if SSL is enabled) 

NOTE:  Administrative Console Port value is available in serverindex.xml file within <WebSphere Profile 

Directory>/config/cells/<Node Cell>/nodes/<Node Name> directory. 

 

The Integrated Solutions Console Login window is displayed. 
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2. Log on with the User ID provided with the admin rights. 

3. From the LHS menu, expand the Applications → Application Type → WebSphere Enterprise 

Applications. 

4. The Enterprise Applications screen is displayed. 

 

5. This Enterprise Applications screen helps you to: 

• Install new application 

• Uninstall existing applications 
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• Start or Stop the installed applications 

10.2.1.4 Configuring WebSphere Shared Library to Support Jersey 2x and Jackson 2.9x Libraries 

Perform the following configuration to set WebSphere shared library to support jersey 2x and Jackson 

2.9x libraries.  

1. Click Environment from the menu on the left to expand and view the list. Click Shared Libraries to 

open the Shared Libraries window. 

 

2. Enter details as shown in the following:  

1. Name: Enter a unique identifiable name. 

2. Description: Enter a valid description. 

3. Classpath: Enter the absolute path where the JARs related to Jersey 2.x and Jackson 2.9x are 

copied. These jars are available in the <OFSAA_HOME>/utility/externallib/WEB-INF/lib directory 

after creation of the EAR file. 

3. Select Use an isolated class loader for this library. 

4. Click OK to save to master configuration.  

5. Select the application or module and map the shared libraries. Click OK. In the following illustration, 

ofsa is selected.  
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6. From the Shared Library Mapping window, move the required shared libraries from Available to 

Selected. In the following illustration, JERSEY2x is selected. 

 

7. Click OK.  

8. Similarly, select the next application or module and repeat the procedure from steps 5 to 7. 
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9. Disable the built-in JAX-RS via JVM property.  

1. Go to WebSphere admin console in Servers > WebSphere Application Servers > 

yourServerName.  

2. In Server Infrastructure section, go to Java and Process Management > Process definition > 

Java Virtual Machine > Custom properties. 

3. Add the following property: 

com.ibm.websphere.jaxrs.server.DisableIBMJAXRSEngine=true 

10. Restart the application. 

10.2.1.5 Delete WebSphere Profiles 

To delete a WebSphere profile, do the following: 

1. Select the checkbox adjacent to the required application and click Stop. 

2. Stop the WebSphere profile to be deleted. 

3. Navigate to WebSphere directory: 

<WebSphere_Installation_Directory>/AppServer/bin/ 

4. Execute the command: 

manageprofiles.sh -delete -profileName <profile_name> 

5. Delete profile directory. 

Example: 

<WebSphere_Installation_Directory>/AppServer/profiles/<profile_name> 

6. Execute the command: 

manageprofiles.sh –validateAndUpdateRegistry 
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10.2.1.6 WebSphere HTTPS Configuration 

Following are the steps for configuring an HTTPS Transport on WebSphere: 

1. Create a profile using the Profile Creation Wizard in WebSphere. 

2. Note down the https port specified during this process and use the same as servlet port or web server 

port during OFSAAI installation. 

To enable https configuration on Infrastructure, assign value 1 to "HTTPS_ENABLE" in 

OFSAAI_InstallConfig.xml file for Silent Mode OFSAAI installation.  

10.2.1.7 WebSphere Memory Settings 

To configure the WebSphere Memory Settings: 

1. Navigate to WebSphere Applications Server → Application Servers → Server1 → Process 

Definition → Java Virtual Machine. 

2. Change the memory setting for Java Heap: 

Initial heap size = 512 

Maximum heap size =3072 

10.2.1.8 Configuring WebSphere for REST Services Authorization 

Configure the following in WebSphere to enable REST API authorization by OFSAA: 

3. Log on to WebSphere console with the User ID provided with the admin rights. 

4. Expand Security menu in the LHS and click Global security > Web and SIP security > General 

settings.  

 

5.  De-select the Use available authentication data when an unprotected URI is accessed 

checkbox. 

6. Click OK. 
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7.  Click Save to save the changes to master configuration. 

10.2.1.9 Configuring Application Security in WebSphere 

This is a mandatory security procedure for WebSphere to restrict the unauthorized access of configuration 

files in directories. For detailed information, see the Oracle Financial Services Analytical Applications 

Infrastructure Security Guide. 

10.2.2 Configuring WebLogic for Application Deployment 

You can deploy multiple OFSAA applications on different domains of a stand-alone Weblogic application 

Server. To create a WebLogic "Domain" you can use the Domain Creation wizard. A domain is the set of 

files that define the runtime environment. At least one domain must exist to run WebLogic Application 

Server. 

Note: For deployment on Oracle WebLogic Server 12.1.3+ (64 bit) with Java 8, download and install 

patch 18729264 from My Oracle Support.Following configuration is required only if OFS Big Data 

Processing is licensed and enabled in your OFSAA instance and OFSAA is deployed on Oracle 

WebLogic Server version 12.2.x: 

The jersey-server-1.9.jar file should be copied to <HIVE_LIB_ PATH> path. 

This section includes the following topics: 

• Creating Domain in WebLogic Server 

• Delete Domain in WebLogic 

• Configuring WebLogic Memory Settings 

• Configuring WebLogic for REST Services Authorization 

10.2.2.1 Creating Domain in WebLogic Server 

1. Navigate to the directory <WLS_HOME>/wlserver/common/bin and execute the command: 

http://docs.oracle.com/cd/E61555_01/books/OFSAAI_Security_Guide.pdf
http://docs.oracle.com/cd/E61555_01/books/OFSAAI_Security_Guide.pdf
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./config.sh 

The Configuration Type window of the Configuration Wizard is displayed. 

 

2. Select Create a new domain option and click Next. The Templates window is displayed. 
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3. Select the Create Domain Using Product Templates option and click Next. The Administrator 

Account window is displayed. 

 

 

4. Enter the user name to be assigned to the administrator, the password and confirm the 

password. Click Next. The Domain Mode and JDK window is displayed. 
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5. Select from the following options: 

In the Domain Mode section, select the required mode (Development 

or Production). 

In the JDK section, select the required option. If you select Other JDK Location, 

click Browse, navigate to the JDK location, and select. Click Next. 

The Advanced Configuration window is displayed. 
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6. Select Administration Server. A WebLogic Server domain must have an Administration 

Server. You can also select Manages Servers, Clusters and Machines and RDBMS 

Security Store, if required. Click Next. 

The Administration Server window is displayed. 
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7. Enter Administration Server details such as the Server Name, Listen 

address, Listen Port, Enable SSL(for secure login using https, 

select this check box), and SSL listen port. Click Next. The 

Configuration Summary window is displayed.  

Note: Make a note of the Listen Port or SSL Listen Port value (for 

example: 7007), since the same has to be re-entered in the Servlet 

port field during Infrastructure installation. 
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8. Verify the configuration details of the WebLogic domain and click 

Create. The Configuration Progress  window is displayed with the 

status indication of the domain creation process. 
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9. Click Next when 100% of the activity is complete.  

The End of Configuration  window is displayed 
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10. Click Finish. The domain server is created enabling the 

deployment of multiple Infrastructure applications on a single 

WebLogic. 

NOTE:  

Note down the HTTPS port specified during this process and use the same as servlet port or web 

server port during OFSAAI Installation. 

To enable https configuration on Infrastructure, assign value 1 to "HTTPS_ENABLE" in 

OFSAAI_InstallConfig.xml for silent mode OFSAAI installation 

11. Add a java option entry -DUseSunHttpHandler=true in WLS_HOME/bin/ 

"setDomainEnv.sh" file (Required only if self signed certificate is used). 

10.2.2.2 Delete Domain in WebLogic 

1. Navigate to the following directory: 

<WebLogic Installation directory>/user_projects/domains/<domain 

name>/bin 

2. Execute stopWebLogic.sh command to stop the WebLogic domain. 

3. Delete the WebLogic domain. 
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10.2.2.3 Configuring WebLogic Memory Settings 

To configure the WebLogic Memory Settings: 

1. Change the memory setting for Java Heap to -Xms512m –Xmx3072m in 

setDomainEnv.sh file, which resides in the directory <DOMAIN_HOME>/bin and in 

CommEnv.sh file which resides in the common/bin directory. 

2. Edit this file for customizing memory settings and garbage collector settings depending on the 

available hardware configuration. 

Example 1: 

if [ "${JAVA_VENDOR}" = "Sun" ]; then 

WLS_MEM_ARGS_64BIT="-Xms512m -Xmx1024m" 

export WLS_MEM_ARGS_64BIT 

WLS_MEM_ARGS_32BIT="-Xms512m -Xmx1024m" 

export WLS_MEM_ARGS_32BIT 

else 

WLS_MEM_ARGS_64BIT="-Xms512m -Xmx1024m" 

export WLS_MEM_ARGS_64BIT 

WLS_MEM_ARGS_32BIT="-Xms512m -Xmx1024m" 

export WLS_MEM_ARGS_32BIT 

Example 2: 

JAVA_VM= 

MEM_ARGS="-Xms256m -Xmx1024m" 

10.2.3 Configuring WebLogic for REST Services Authorization 

To enable REST API authorization by OFSAA in WebLogic, perform the following steps: 

1. Open the config.xml file located in the domain where OFSAA is deployed, that is 

<domain_home>/config/config.xml. 

2. Add the following in the security-configuration tag: 

<enforce-valid-basic-auth-credentials>false</enforce-valid-basic-

auth-credentials>. 

 

10.2.4 Configuring Apache Tomcat Server for Application Deployment 

This section is applicable only when the Web Application Server type is Tomcat. 

This section includes the following topics: 
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• Tomcat User Administration 

• Configure Tomcat to use JAVA 64 bit Executables 

• Configure Servlet Port 

• SSL Port Configuration 

• Apache Tomcat Memory Settings 

• Uninstalling WAR Files in Tomcat 

• Configuration for Axis API 

• Configure Tomcat for User Group Authorization, Data Mapping, and Disable WADL for the 

Web Service 

10.2.4.1 Tomcat User Administration 

The Tomcat administration and manager application does not provide a default login. You are 

required to edit "$CATALINA_HOME/conf/tomcat-users.xml" file as instructed below. 

This file contains an XML tag <user> for each individual user, which displays the username and 

password used by admin to log on to Tomcat, and the role names to which the admin user is 

associated with. For example, <user name="admin" password="admin" 

roles="standard,manager"/> 

1. Add the manager role to any one of the existing username/password combination as shown 
in the example above. 

2. Use the same username/password to which the manager-gui role has been assigned to 
access the Tomcat Application Manager. 

3. If the Tomcat server is already running, it requires a re-start after the above configuration is 
done. 

10.2.4.2 Configure Tomcat to use JAVA 64 bit Executables 

1. Navigate to the $CATALINA_HOME/bin directory. 

2. Edit the setclasspath.sh file as explained below. 

Replace the following block of text: 

# Set standard commands for invoking Java. 

RUNJAVA="$JRE_HOME"/bin/java 

if [ "$os400" != "true" ]; then 

RUNJDB="$JAVA_HOME"/bin/jdb 

With: 

# Set standard commands for invoking Java. 



Oracle Financial Services Software 

OFSDM 8.0.6.0.0 Installation Guide  

 

 

157 

 

RUNJAVA="$JAVA_BIN"/java 

if [ "$os400" != "true" ]; then 

RUNJDB="$JAVA_BIN"/jdb 

3. If the Tomcat server is already running, it requires a re-start after the above configuration is 
done. 

NOTE:  If Tomcat server is installed under different Unix profile, set JAVA_BIN environment variable 

in profile to include the Java Runtime Environment absolute path. For example: 

export JAVA_BIN /usr/java6_64/jre/bin  

export JAVA_BIN = /usr/java6_64/jre/bin//sparcv9 for Solaris Sparc 

10.2.4.3 Configure Servlet Port 

The default servlet port configured for the Tomcat installation is 8080. Ignore this section if you 

need to use the default port. 

If you need to use a different port number, you must first configure the port in the "server.xml" in 

the "conf" directory of Tomcat Installation directory. The following steps guide you through the 

configuration process: 

1. Navigate to $CATALINA_HOME/conf. Open server.xml and locate the tag: 

"Define a non-SSL HTTP/1.1 Connector on port 8080 "  

2. Against this tag, a parameter is specified 'Connector port = "8080"'. Edit this value to 

the new port number that is used during the installation process. 

3. Save your changes in "server.xml". 

NOTE:  Make a note of the servlet port configured. This information is required during the installation 

of OFSAA Application Pack. 

10.2.4.4 SSL Port Configuration 

If you need to configure and access your OFSAA setup for HTTPS access, ensure that the 

following connect tag under "Define a SSL HTTP/1/1 Connector on port 8443" in 

"<Tomcat_installation_directory>/conf/server.xml" file is uncommented for SSL 

Configuration. (By default, it is commented). 

<Connector port="8443" protocol="HTTP/1.1" SSLEnabled="true" 

maxThreads="150" scheme="https" secure="true" 

clientAuth="false" sslProtocol="TLS" 
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NOTE:  Make a note of the servlet port configured. This information would be required during the 

installation of OFSAA Application Pack. To enable https configuration on Infrastructure, 

assign value 1 to "HTTPS_ENABLE" in OFSAAI_InstallConfig.xml file for SILENT 

mode OFSAAI installation. 

For more information related to SSL Configuration on Tomcat, refer to http://tomcat.apache.org/. 

10.2.4.5 Apache Tomcat Memory Settings 

To configure the Apache Tomcat Memory Settings: 

1. Locate the file catalina.sh which resides in the directory <CATALINA_HOME>/bin 

directory. 

2. Edit this file for customizing the memory settings and garbage collector settings depending on 

the available hardware configuration. 

3. Add the memory setting for Java Heap to -Xms512m -Xmx1024m. 

Example: 

if [ -z "$LOGGING_MANAGER" ]; then 

JAVA_OPTS="$JAVA_OPTS -Xms512m -Xmx1024m 

-Djava.util.logging.manager=org.apache.juli.ClassLoaderLogManager" 

else 

JAVA_OPTS="$JAVA_OPTS -Xms512m -Xmx1024m $LOGGING_MANAGER" 

fi 

10.2.4.6 Uninstalling WAR Files in Tomcat 

To uninstall WAR files in Tomcat, see Uninstalling WAR Files in Tomcat. 

10.2.4.7 Configuration for Axis API 

This step is optional and required only if the web application server used in Apache Tomcat. If 

you use any other web application server, skip and proceed to next step. 

Copy the jaxrpc.jar file from the <OFSAA Installation Directory>/axis-

1_4/webapps/axis/WEB-INF/lib and place it in under <Tomcat Installation 

Directory>/lib and restart the Tomcat Server. 

http://tomcat.apache.org/
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10.2.4.8 Configure Tomcat for User Group Authorization, Data Mapping, and Disable WADL for 

the Web Service 

This section applies only if the Web Application Server Type is Tomcat. 

Users with System Authorization Roles can access User Group Authorization. However, to make 

it available on the Tomcat Web Server, you have to perform the following configuration steps: 

1. Navigate to the $FIC_WEB_HOME/webroot/WEB-INF/ Dierctory and open the 

web.xml File. 

2. Enter the following in the web.xml File. 

<init-param> 

<param-name>mappedfile</param-name> 

<param-value>false</param-value> 

</init-param> 

3. To disable the WADL for the Web Service, navigate to the following snippet in the 

web.xml file. 

<servlet> 

<servlet-name>CommonRESTServlet</servlet-name> 

<servlet-class>org.glassfish.jersey.servlet.ServletContainer</servlet-class> 

<init-param> 

<param-name>javax.ws.rs.Application</param-name> 

<param-value>com.ofs.fsapps.commonapps.util.ApplicationResourceConfig</param-value> 

</init-param> 

<load-on-startup>1</load-on-startup> 

</servlet> 

4. Add the following snippet before the <load-on-startup>1</load-on-startup> 

Attribute: 

<init-param> 

<param-name>jersey.config.server.wadl.disableWadl</param-name> 

<param-value>true</param-value> 

</init-param> 

5. Save and close the file. 

6. If the Tomcat Server is already running, it requires a re-start after the preceding 

configuration is done. 
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11 Appendix B: Configuring Resource Reference in Web 

Application Servers 

This appendix includes the following topics: 

• Configure Resource Reference in WebSphere Application Server 

• Configure Resource Reference in WebLogic Application Server 

• Configure Resource Reference in Tomcat Application Server 

11.1 Configure Resource Reference in WebSphere Application Server 

This section is applicable only when the Web Application Server is WebSphere. 

This section includes the following topics: 

• Create JDBC Provider 

• Create Data Source 

• J2C Authentication Details 

• JDBC Connection Pooling 

11.1.1 Create JDBC Provider 

1. Open the WebSphere admin console in the browser window: 

http://<ipaddress>:<administrative console port>/ibm/console (https, if 

SSL is enabled). The Login window is displayed.  

2. Login with the user ID that has admin rights. 

3. Expand the Resources option in the LHS menu and click JDBC → JDBC Providers. The 

JDBC Providers window is displayed. 
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4. Select the Scope from the drop-down list. Scope specifies the level at which the resource 

definition is visible. 

5. Click New to add new JDBC Provider under the Preferences section. The Create a new 

JDBC Provider window is displayed. 
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6. Enter the following details: 

• Database Type - Oracle 

• Provider Type - Oracle JDBC Driver 

• Implementation Type - Connection pool data source 

• Name - The required display name for the resource 

• Description - The optional description for the resource 

7. Click Next.  
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8. Specify the directory location for ojdbc<version>.jar file. Ensure that you do not use the 

trailing slash file separators. 

The Oracle JDBC driver can be downloaded from the following Oracle Download site: 

• Oracle Database 11g Release 2 (11.2.0.4) JDBC Drivers 

• Oracle Database 12c Release 1 (12.1.0.1) JDBC Drivers 

Once downloaded, you need to copy the file in the required directory on the server. 

NOTE:  See Appendix P for identifying the correct ojdbc<version>.jar version to be copied. 

Once downloaded, you need to place the file in the required directory in your system. While 

creating the JDBC Provider, ensure that the path to the jar file in the directory is specified in 

the Classpath field in the previous window. 

9. Click Next. The Summary window is displayed. 
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10. Verify the details and click Finish to create the JDBC Provider. 

11. The options to Save and Review are displayed. Click Save. 

11.1.2 Create Data Source 

The following steps are applicable for both CONFIG and ATOMIC data source creation: 

1. Open this URL in the browser window: http://<ipaddress>:<administrative console 

port>/ibm/console (https, if SSL is enabled). The Login window is displayed. 

2. Login with the user ID that has admin rights. 

3. Expand the Resources option in the LHS menu and click JDBC → Data Sources. The Data 

Sources page is displayed. 
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4. Select the Scope from the drop down list. Scope specifies the level at which the resource 

definition is visible. 

5. Click New. The Create a Data Source window is displayed. 

 

6. Specify the Data Source name and JNDI name for the new Data Source. 
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The JNDI name and Data Source name are case sensitive. Ensure that JNDI name is same 

as the Information Domain name.  

7. Click Next. The Select JDBC provider window is displayed. 

 

8. Select the option Select an Existing JDBC Provider and select the required JDBC provider 

from the drop-down list. Click Next. 

 

9. Specify the database connection URL. 

For Example: jdbc:oracle:thin:@<DB_SEREVER_IP>:<DB_SERVER_PORT>:<SID> 

10. Select Data Store Helper Class Name from the drop-down list and ensure that the checkbox 

Use this data source in container managed persistence (CMP) is selected.  

NOTE:  For RAC configuration, provide the RAC URL specified during installation 

 

For Example: 

jdbc:oracle:thin:@(DESCRIPTION=(ADDRESS_LIST=(ADDRESS=(PROTOCOL=TCP)

(HOST=10.11.12.13)(port=1521))(ADDRESS=(PROTOCOL=TCP)(HOST=10.11.12.

14)(PORT=1521))(LOAD_BALANCE=no)(FAILOVER=yes))(CONNECT_DATA=(SERVIC

E_NAME=pqadb))) 
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11. Click Next. 

 

12. Map the J2C authentication alias, if already created. If not, you can create a new J2C 

authentication alias by accessing the link given (Global J2C authentication alias) or you 

can continue with the data source creation by clicking Next and then Finish. 

 

You can also create and map J2C authentication alias after creating the Data Source. 

13. You must create another Data Source by following the above procedure with 

jdbc/FICMASTER as JNDI name pointing to the ‘configuration schema’ of Infrastructure. 
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11.1.3 J2C Authentication Details 

The following steps are applicable for creating both config and atomic J2C Authentication. 

To create J2C Authentication details: 

1. Select the newly created Data Source and click JAAS - J2C authentication data link under 

Related Items.  

 

2. Click New under the Preferences section. 

 

3. Enter the Alias, User ID, Password, and Description. Ensure the following: 
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• User ID is the Oracle user ID created for the respective CONFIG and ATOMIC Schema 

for the Information Domain. 

• Specify the CONFIG database user ID and password information for the 

jdbc/FICMASTER data source, and specify the ATOMIC database user ID and password 

information for the ATOMIC schema data source that you created earlier. 

4. Click Apply and save the details. 

11.1.4 JDBC Connection Pooling 

To define the JDBC connection pooling ensure that you have created JDBC Provider and Data 

source to access the data from the database. 

1. Expand the Resources option in the LHS menu and click JDBC → Data sources option. 

The Data sources page is displayed. 

2. Click the newly created Data Source $DATA_SOURCE$ and navigate to the path Data 

sources>$DATA_SOURCE$>Connection pools. 

 

3. Set the values for Connection timeout to 0 seconds, Maximum connections to 100 

connections, and Minimum connections to 10 connections as shown in the above figure. 

You can also define Reap Time, Unused Timeout, and Aged Timeout as required. 
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11.2 Configure Resource Reference in WebLogic Application Server 

This section is applicable only when the Web Application Server is WebLogic. 

This section includes the following topics: 

• Create Data Source 

• Create GridLink Data Source 

• Configure Multi Data Sources 

• Advanced Settings for Data Source 

• JDBC Connection Pooling 

In WebLogic, you can create Data Source in the following ways: 

• For a Non RAC Database instance, Generic Data Source has to be created. See Create Data 

Source. 

• For a RAC Database instance, GridLink Data Source has to be created. See Create GridLink 

Data Source. 

• When Load Balancing/Fail Over is required, Multi Data Source has to be created. See 

Configure Multi Data Sources. 

11.2.1 Create Data Source 

The following steps are applicable for both config and atomic data source creation. 

1. Open WebLogic Admin Console in the browser window:  

http://<ipaddress>:<administrative console port>/console (https, if SSL is enabled). The 

Welcome window is displayed.  

2. Login with the Administrator Username and Password.  
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3. From the LHS menu (Domain Structure), click Services → Data Sources. The Summary of 

JDBC Data Sources window is displayed. 

 

4. Click New and select Generic Data Source option. The Create a New JDBC Data Source 

window is displayed. 

You can also select GridLink Data Source or Multi Data Source while creating a Data 

Source. 
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5. Enter JDBC data source Name, JNDI Name, and select the Database Type from the drop-

down list. Click Next. 

Ensure the following: 

• The JNDI Name field should be in the format "jdbc/informationdomain". 

• Same steps needs to be followed to create a mandatory data source pointing to the 

configuration schema of infrastructure with jdbc/FICMASTER as JNDI name.  

• JNDI Name is the same as mentioned in web.xml file of OFSAAI Application. 

• Required Database Type and Database Driver should be selected. 

 

6. Select Database Driver from the drop-down list. You need to select the Database Driver 

depending on database setup, that is, with or without RAC. Click Next. 
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7. Select Supports Global Transactions checkbox and then One-Phase Commit. 

8. Click Next. The Connection Properties window is displayed. 

 

9. Enter the required details such as the Database Name, Host Name, Port, Oracle User 

Name, and Password.  

10. Click Next. The Test Database Connection window is displayed. 
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11. Verify the details and click Test Configuration and test the configuration settings. 

A confirmation message is displayed stating "Connection test succeeded". 

12. Click Finish. The created Data Source is displayed in the list of Data Sources. 

NOTE:  User ID is the Oracle user ID that is created for the respective CONFIG and ATOMIC schema 

of the respective "Information Domain". 

User ID to be specified for data source with FICMASTER as JNDI name should be the 

Oracle user ID created for the CONFIG schema. 

13. Select the new Data Source and click Select Targets tab. 
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14. Select AdminServer and click Finish. 

11.2.2 Create GridLink Data Source 

If you have selected the option, New → GridLink Data Source while creating the Data Source, 

you can directly specify the JDBC URL as indicated. 

 

1. Enter Data Source Name and JNDI Name. 

Ensure that the JNDI Name is specified in the format "jdbc/infodomname" and the XA 

Driver checkbox is not selected. Click Next. 
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2. Specify Complete JDBC URL, Database User Name, and Password. Click Finish. The 

created Data Source is displayed in the list of Data Sources. 

11.2.3 Configure Multi Data Sources 

A JDBC multi data source is an abstraction around a group of data sources that provides load 

balancing and failover between data sources. As with data sources, multi data sources are also 

bound to the JNDI tree. Applications can look up a multi data source on the JNDI tree and then 

reserve a database connection from a data source. The multi data source determines from which 

data source to provide the connection. 

When the database used is Oracle RAC (Real Application Clusters) which allows Oracle 

Database to run across a set of clustered servers, then group of data sources can be created for 

instances running on a set of clustered servers and a JDBC multi data source can be created so 

that applications can look up a multi data source on the JNDI tree to reserve database 

connection. If a clustered server fails, Oracle continues running on the remaining servers. 

1. Open WebLogic Admin Console in the browser window: 

http://<ipaddress>:<administrative console port>/console (https if SSL is 

enabled). The Login window is displayed.  

2. Login with the User ID that has admin rights. 

3. In the LHS menu (Domain Structure), select Services → JDBC → Multi Data Sources. The 

Summary of JDBC Multi Data Sources window is displayed.  
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4. Click New. The Create a New JDBC Multi Data Source screen is displayed. 

NOTE:  Ensure that the Data Sources which must be added to new JDBC Multi Data Source are 

created. 

 

5. Enter the JDBC Source Name, JNDI name, and select the Algorithm Type from the drop-

down list. Click Next. 

NOTE:  The JNDI Name must be specified in the format jdbc/infodomname. 

JNDI Name of the Data Sources that are added to new JDBC Multi data source should 

be different from the JNDI name specified during Multi Data Source. 

Same steps must be followed to create a mandatory data source pointing to the 

configuration schema of infrastructure with jdbc/FICMASTER as JNDI name for Data 

Source. 

JNDI Name provided in multi data source should be the same name that is mentioned 

in the web.xml file of OFSAAI Application. 

You can select the Algorithm Type as Load-Balancing. 
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6. Select AdminServer and click Next. 

 

7. Select the type of data source which is added to new JDBC Multi Data Source. Click Next. 

 

8. Map the required Data Source from the Available Data Sources. Click Finish. 

The New JDBC Multi Data Source is created with added data sources. 

11.2.4 Advanced Settings for Data Source 

1. Click the new Data Source from the Summary of JDBC Data Sources window. The Settings 

for <Data Source Name> window is displayed. 

2. Select the Connection Pooling tab given under Configuration. 

3. Navigate to Advanced option at the bottom of the page, and check the Test Connection of 

Reserve checkbox (enables WebLogic Server to test a connection before giving it to a client). 

4. To verify if the data source is valid, select Data Source name. For example, FICMASTER. 
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5. Select the server and click Test Data Source. 

6. A message is displayed indicating that the test was successful. 

7.  Once the Data Source is created successfully, the following messages are displayed: 

• All changes have been activated. No restart is necessary. 

• Settings updated successfully.  

If not, follow the steps given above to recreate the data source.  

11.2.5 JDBC Connection Pooling 

To define the JDBC connection pooling, ensure that you have created JDBC Provider and Data 

Source to access the data from the database. 

1. Click the newly created Data Source $DATA_SOURCE$ and navigate to the path  

Home → Summary of Services: JDBC → Summary of JDBC Data Sources → JDBC 

Data Source-<INFODDOM_NAME> 

2. Set the values for Initial Capacity to 10, Maximum Capacity to 100, Capacity Increment to 

1, Statement Cache Type to LRU, and Statement Cache Size to 10. 

3.  Click Save. 

11.3 Configure Resource Reference in Tomcat Application Server 

This section is applicable only when the Web Application Server is Tomcat. 

This section includes the following topics: 

• Create Data Source 

• JDBC Connection Pooling 
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Copy the Oracle JDBC driver file, "ojdbc<version>.jar" from <Oracle Home>/jdbc/lib 

directory and place it in <Tomcat Home>/lib directory. 

NOTE:  See Appendix P for identifying the correct ojdbc<version>.jar version to be copied. 

11.3.1 Create Data Source 

To create Data Source for OFSAA application, navigate to <Tomcat Home>/conf directory and 

edit the following block of text by replacing the actual values in the server.xml file. 

NOTE:  The User-IDs for configuration/ atomic schemas have the prefix of SETUPINFO NAME 

depending on the value set for PREFIX_SCHEMA_NAME in <APP 

Pack>_SCHEMA_IN.xml file of Schema Creator Utility. For example, if the value set 

for SETUPINFO NAME is DEV and PREFIX_SCHEMA_NAME is Y, and the schema 

name was mentioned as ofsaaconf, then the actual schema created in the database 

would be DEV_ofsaaconf. 

<Context path ="/<context name>" docBase="<Tomcat Installation 

Directory>/webapps/<context name>" debug="0" reloadable="true" 

crossContext="true"> 

<Resource auth="Container"  

name="jdbc/FICMASTER" 

type="javax.sql.DataSource" 

driverClassName="oracle.jdbc.driver.OracleDriver" 

username="<user id for the configuration schema>"  

password="<password for the above user id>"  

url="jdbc:oracle:thin:@<DB engine IP address>:<DB 

Port>:<SID>" 

maxActive="100"  

maxIdle="30" 

maxWait="10000"/> 

<Resource auth="Container" 

name="jdbc/<INFORMATION DOMAIN NAME>" 

type="javax.sql.DataSource" 

driverClassName="oracle.jdbc.driver.OracleDriver" 

username="<user id for the atomic schema>" 

password="<password for the above user id>" 

url="jdbc:oracle:thin:@<DB engine IP address>:<DB 

Port>:<SID>" 
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maxActive="100" 

maxIdle="30" 

maxWait="10000"/> 

</Context> 

NOTE:  The <Resource> tag must be repeated for each Information Domain created. 

After the above configuration, the WAR file must be created and deployed in Tomcat 

Server. 

11.3.2 JDBC Connection Pooling 

To define the JDBC connection pooling, do the following: 

1. Copy $ORACLE_HOME/jdbc/lib/ojdbc<version>.jar file to the 

$TOMCAT_DIRECTORY/lib/directory. 

NOTE:  See Appendix P for identifying the correct “ojdbc<version>.jar” file version to be copied. 

2. Edit the server.xml file present under the $TOMCAT_DIRECTORY/conf/ directory with 

the below changes, which is required for connection pooling. 

<Context path="/ $CONTEXTNAME$" docBase=" $APP_DEPLOYED_PATH$ " 

debug="0" reloadable="true" crossContext="true"> 

<Resource auth="Container" 

name="jdbc/ $INFODOM_NAME$" 

type="javax.sql.DataSource" 

driverClassName="oracle.jdbc.driver.OracleDriver" 

username=" $ATOMICSCHEMA_USERNAME$" 

password="$ATOMICSCHEMA_PASSWORD$" 

url="$JDBC_CONNECTION_URL" 

maxActive="100" 

maxIdle="30" 

maxWait="10000" 

removeAbandoned="true" removeAbandonedTimeout="60" 

logAbandoned="true"/> 

</Context> 

Note the following: 

• $APP_DEPLOYED_PATH$ should be replaced by OFSAAI application deployed 

path.$INFODOM_NAME$ should be replaced by Infodom Name. 
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• $ATOMICSCHEMA_USERNAME$ should be replaced by Atomic schema database user 

name. 

• $ATOMICSCHEMA_PASSWORD$ should be replaced by Atomic schema database 

password. 

• $JDBC_CONNECTION_URL should be replaced by JDBC connection string 

jdbc:Oracle:thin:<IP>:<PORT>:<SID>. For example, jdbc:oracle:thin 

10.80.50.53:1521:soluint 

• The User IDs for configuration/ atomic schemas have the prefix of setupinfo depending 

on the value set for PREFIX_SCHEMA_NAME in <<APP Pack>>_SCHEMA_IN.XML file 

of Schema Creator Utility. 

For example: if the value set for PREFIX_SCHEMA_NAME is DEV and the schema 

name was mentioned as ofsaaconf, then the actual schema created in the database 

would be DEV_ofsaaconf. 

11.3.3 Class loader configuration for Apache Tomcat 

1. Edit the server.xml file available in $TOMCAT_HOME/conf/ directory. 

2. Add tag <Loader delegate="true" /> within the <Context> tag, above the 

<Resource> tag. This is applicable only when the web application server is Apache Tomcat 

8. 

NOTE:  This configuration is required if Apache Tomcat version is 8. 
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12 Appendix C: Creating and Deploying EAR/WAR File 

This appendix includes the following topics: 

• Creating EAR/WAR File 

• Deploying EAR/WAR File 

12.1 Creating EAR/WAR File 

To create EAR/WAR File, perform the following steps: 

1. Navigate to the $FIC_WEB_HOME directory on the OFSAA Installed server. 

2. Execute  ./ant.sh to trigger the creation of EAR/ WAR file.  

3. On completion of the EAR files creation, the BUILD SUCCESSFUL and Total Time taken 

message is displayed and you are returned to the prompt. 

 

4. The EAR/ WAR file - <contextname>.ear/ .war - is created.  

NOTE:  The <contextname> is the name given during installation.  

This process overwrites any existing version of EAR file that exists in the path. 

For OFSAA configured onTomcat installation, <contextname>.war file is created. 
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12.2 Deploying EAR/WAR File 

This section includes the following topics: 

Deploying WebSphere EAR/WAR Files 

Deploying WebLogic EAR/WAR Files  

Deploying Tomcat WAR Files 

NOTE:  Ensure to clear the application cache prior to the deployment of Application Pack Web 

Archive. This is applicable to all Web Servers (WebSphere, WebLogic, and Tomcat). 

For more information, see Clearing Application Cache section. 

12.2.1 Deploying EAR/WAR Files on WebSphere 

To deploy WebSphere EAR/WAR File, perform the following steps: 

1. Start WebSphere Profile by navigating to the path 

"/<Websphere_Installation_Directory>/IBM/WebSphere/AppServer/profile

s/<Profile_Name>/bin/" and execute the command: 

./startServer.sh server1 

2. Open the following URL in the browser: http://<ipaddress>:<Administrative 

Console Port>/ibm/console (https if SSL is enabled). The login screen is displayed.  

 

3. Enter the user credentials with admin privileges and click Log In. 
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4. From the LHS menu, select Applications and click New Application. The New Application 

window is displayed. 

 

5. Click New Enterprise Application. The Preparing for the application installation window is 

displayed.  

 

6. Select Remote File System and click Browse. Select the EAR file generated for OFSAA to 

upload and install. Click Next.  

 

7. Select the Fast Path option and click Next. The Install New Application window is displayed. 
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8. Enter the required information and click Next. The Map Modules to Servers window is 

displayed. 

 

9. Select the Web Application and click Next. The Map Resource References to Resources 

window is displayed. 
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10. Map each resource defined in the application to a resource JNDI name defined earlier. 

11. Click Modify Resource Authentication Method and specify the authentication method 

created earlier. 

12. You can specify ‘config’ for FICMASTER resource or ‘atomic’ for atomic resource as the 

authentication method. 

13. Select OFSAAI Web Application and click Next. The Map Virtual hosts for Web Modules 

window is displayed. 

 

14. Select Web Application and click Next. The Summary page is displayed. 
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15. Click Finish and deploy the Infrastructure Application on WebSphere. 

16. On successful installation, a message is displayed. Click Save and save the master file 

configuration. The details are displayed in the Master File Configuration window. 

Start Application 

To start the application, perform the following steps: 

1. Expand Applications → Application Type → WebSphere Enterprise Applications. The 

Enterprise Applications window is displayed. 
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2. Select the installed application and click Start. 

NOTE:  <profile name> is the profile name given while creating the WebSphere profile. 

<cell name> is the cell name given during profile creation  

<context name> is the context name given during installation. 

12.2.2 Deploying WAR File on WebLogic 

Following are the steps for deploying Infrastructure application that is created during installation: 

1. Navigate to the <WebLogic Installation 

directory>/user_projects/domains/<domain name>/bin directory in the 

machine in which WebLogic is installed. 

2. Start WebLogic by executing the command: 

./startWebLogic.sh -d64 

3. Open the URL in the browser window: http://<ipaddress>:<admin server 

port>/console (https, if SSL is enabled). The Sign in window of the WebLogic Server 

Administration Console is displayed. 

NOTE:  Ensure that you have started Infrastructure Server by executing “./reveleusstartup.sh" 

command as mentioned in Start Infrastructure. 

 

4. Log on to the WebLogic Server by entering the user credentials having privileges to 

deploy the EAR file. 

5. From the Domain Structure LHS menu, click Deployments. The Summary of 

Deployments window is displayed. 
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6. Click Install. The Install Application Assistant window is displayed. 

7. Select the Exploded EAR directory after browsing to the directory where it is saved and click 

Next. 

Explode EAR 

To explode EAR, perform the following steps: 

1. Create the applications directory under domain name. For example, 

/Bea/user_projects/domains/ <Domain _name>/applications. 

2. Create <context_name>.ear directory under applications directory.  

3. Copy the <$FIC_WEB_HOME/<context_name>.ear file to 

<WEBLOGIC_INSTALL_DIR>/Bea/user_projects/domains/<DOMAIN_NAME>/appli

cations/<context_ name>.ear directory. 

4. Explode the <context_name>.ear file by executing the command: 

jar -xvf <context_name>.ear 

5. Delete the <context>.ear and <context>.war files (recently created) in 

<WEBLOGIC_INSTALL_DIR>/Bea/user_projects/domains/<DOMAIN_NAME>/appli

cations/<context_name>.ear directory. 

6. Create <context_name>.war directory under 

<WEBLOGIC_INSTALL_DIR>/Bea/user_projects/domains/<DOMAIN_NAME>/appli

cations/<context_ name>.ear directory. 
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7. Copy <$FIC_WEB_HOME/<context_name>.war file to <WEBLOGIC_INSTALL_ 

DIR>/Bea/user_projects/domains/<DOMAIN_NAME>/applications/<context_ 

name>.ear/<context_name>.war directory. 

8. Explode the <context_name>.war file by executing the following command to get the 

directory structure: 

jar -xvf <context_name>.war 

Install Application 

To install the application, perform the following steps:  

1. Open Install Application Assistant.  

 

2. Click Next.  

 

3. Select the Install this deployment as an application option from Choose targeting style 

section and click Next. The Optional Settings window is displayed. 
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4. Enter a Name for the deployment if required. 

5. Under the Security section, select the DD only option to specify that only roles and policies 

that are defined in the deployment descriptors should be used. 

6. Select I will make the deployment available from the following location option under the 

Source accessibility section.  

7. Click Next to continue. The Deployment Summary window is displayed. 
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8. Select the Yes, take me to the deployment's configuration screen option and click Finish. 

The Settings for <Deployment Name> window is displayed. 
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9. Review the general configuration details of the deployment. You can also update the 

configuration of the deployment in this window. In the Overview tab you can view the 

complete deployment configuration. 

10. Click Save to update the changes, if any. 

11. From the LHS menu, click Deployments. The Summary of Deployments window is 

displayed. 
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12. Select the newly deployed Infrastructure application and click Start → Servicing all 

requests. Ensure that the infrastructure server is up and running. 

 

13. The State of the deployed application is displayed as Active if started successfully. 

12.2.3 Deploying WAR Files on Tomcat 

Before deploying the WAR files, ensure that the previously deployed applications of Infrastructure 

are uninstalled. See Uninstalling Previously Deployed WAR Files in Tomcat for the procedure to 

uninstall the previously deployed Infrastructure war files. 

On the machine that hosts Tomcat, follow the below steps outlined to deploy Infrastructure 

application: 
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For more information on upgrade, see Upgrading the OFS DM Application Pack. 

1. Copy the <context-name>.war file from $FIC_WEB_HOME/<context-name.war> to 

<Tomcat Installation Directory>/webapps/ directory.  

2. Click Manager App. The Connect to dialog box is displayed.  

3. Enter the User ID and Password that has admin rights and click OK. (For user 

creation in Tomcat, see Tomcat User Administration. The Tomcat Web Application 

Manager window is displayed with the list of all the applications deployed. 
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4. In the Deploy section, enter the Context Path provided during the installation as 

"/<context-name>".  

5. Enter the path where the <context-name>.war file resides (by default "$FIC_WEB_ 

HOME/<context-name>.war") in the WAR or Directory URL field and click Deploy.  

6. On successful application deployment, a confirmation message is displayed. Start the 

Tomcat server. See Starting Web Application Servers for more details. 
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13 Appendix D: Starting / Stopping Infrastructure Services 

13.1 Starting/Stopping OFSAA Infrastructure Services 

This chapter details on how to start and stop OFSAA Infrastructure services. This chapter 

includes the following sections: 

• Starting Infrastructure Services 

• Starting Web Application Servers 

• Stopping Infrastructure Services 

• Stopping Web Application Servers 

13.1.1 Starting Infrastructure Services 

Once the installation of Infrastructure has been completed successfully and the post-installation 

steps are completed, the servers must be started. Log on to each machine and run the 

.profile file. All servers mentioned must be started from the same shell encoding. The servers 

mentioned below are dependent on each other. It is mandatory to maintain the order in which the 

servers are started. Allow each of the servers to initialize completely before starting the next 

server. 

1. On the machine in which Infrastructure Application components have been installed, navigate 

to $FIC_APP_HOME/common/FICServer/bin directory and execute the following 

command to start the Infrastructure Server. 

./startofsaai.sh 

NOTE:  You can also start the Infrastructure Server by executing the command "nohup ./ 

startofsaai.sh &". Starting the process using "nohup" and "&" returns the 

command prompt without having to wait till the process completes. However, this 

command cannot be used when you are starting the server for the first time or starting 

after changing user password in the configuration database schema. 

2. Select the required Webserver start up option from the table. 

Start up Option Description 

Starting WebSphere Profile On the machine in which Web sphere is installed, navigate to 
[Webshpere_Install_Directory] 

/AppServer/<profiles>/<profile name>/bin and 

execute the command: ./startServer.sh server1 

Starting WebLogic Domain On the machine in which WebLogic is installed navigate to 
<WebLogic Installation 

directory>/user_projects/domains/<domain 

name>/bin and execute the command: startWebLogic.sh 
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Start up Option Description 

-d64 

Note: If WebLogic is already running, access the WebLogic Admin 
Console. Stop and start the application <context name>.ear. 

Starting Tomcat Application On the machine in which Tomcat is installed, navigate to 
<Tomcat_Install_ Directory>/bin and execute the 

command: ./catalina.sh run 

3. Start ICC server: 

• On the machine in which Infrastructure default Application components have been 

installed, navigate to $FIC_HOME/ficapp/icc/bin directory and execute the 

command. 

o ./iccserver.sh 

NOTE:  Only Infrastructure Default Application Server holds ICC component. 

 

4. To start Back-end Services: 

• On the machine on which Infrastructure Database components have been installed, 

navigate to $FIC_DB_HOME/bin directory and execute the command to start "Agent 

server": 

o ./agentstartup.sh  

o Or 

o Start Back-end services using the command: 

o nohup ./agentstartup.sh & 

NOTE:  This agent internally starts the Router, Message Server, OLAP data server and AM services. 

13.1.2 Starting Web Application Servers 

Start the Web Application Server depending on the type from the following table. 

Start up Option Description 

Starting WebSphere Profile On the machine in which Web sphere is installed, navigate to 
[Webshpere_Install_Directory] 

/AppServer/<profiles>/<profile name>/bin and 

execute the command: ./startServer.sh server1 

Starting WebLogic Domain On the machine in which WebLogic is installed navigate to 
<WebLogic Installation 

directory>/user_projects/domains/<domain 

name>/bin and execute the command: startWebLogic.sh -
d64 

Note: If WebLogic is already running, access the WebLogic Admin 
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Start up Option Description 

Console. Stop and start the application <context name>.ear 

Starting Tomcat Application On the machine in which Tomcat is installed, navigate to 
<Tomcat_Install_ Directory>/bin and execute the 

command: ./catalina.sh run 

13.1.3 Stopping Infrastructure Services 

To stop Infrastructure Services: 

1. On the machine in which Infrastructure Application components are installed, navigate to 

$FIC_APP_HOME/common/FICServer/bin and execute the command: 

./stopofsaai.sh 

2. To stop ICC server, on the machine in which Infrastructure default Application components 

are installed, navigate to $FIC_HOME/ficapp/icc/bin and execute the command: 

./iccservershutdown.sh 

NOTE:  Only Infrastructure Default Application Server holds ICC component. 

 

3. To stop Back-end server, on the machine in which Infrastructure database components are 

installed, navigate to $FIC_DB_HOME/bin and execute the command: 

./agentshutdown.sh 
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14 Appendix E: Accessing OFSAA Application 

This appendix gives details the steps to be performed to access OFSAA Application. 

14.1 Accessing the OFSAA Application 

1. From a your desktop, open the browser and enter the URL in below format:  

<scheme>://<IP address/ hostname>:<port>/<context-name>/login.jsp 

For example, https://111.222.333.444:5555/ofsaa/login.jsp 

The OFSAA Login window is displayed. 

 

2. With installation of every OFSAA Application Pack, there are two seeded user profiles 

configured in the system: 

o SYSADMN – System Administrator 

o SYSAUTH – System Authorizer 

3. Login to the application using the "SYSADMN" User ID. (Note that, there is no "I" in the 

SYSADMN login USER ID). Enter the password that was provided during installation. On the 

first login, you are prompted to change the password. 

Once you have logged into the Infrastructure system, you need to perform the following 

additional configurations to setup the OFSAAI environment: 

• Define Server Details for Database, Application and Web Servers.  

• Add Database Details.  

• Create an Information Domain.  

• Create a Segment.  
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• Create / Add User with access to all permissions. 

NOTE:  Each new file that is created in the ftpshare directory of any installation layer should be 

granted specific / explicit permission. If you encounter any problems during setup, 

please contact Infrastructure Support. 

14.2 OFSAAI Login 

While accessing Oracle Financial Services Analytical Applications Infrastructure, the Splash 

screen is as displayed: 

 

You can select the required language from the Language drop-down list. The language options 

displayed in the drop down are based on the license. Based on the selection of Language, the 

appropriate language login screen is displayed. 

Enter the User ID and Password provided by the System Administrator and click Login. You are 

prompted to change your password on your first login. Alternatively, you can also choose to 

change your password any time. 

In the Change Password screen, enter a new password, confirm it and click OK to view the 

Splash screen. Refer to the following guidelines for password creation: 

• Passwords are displayed as asterisks (stars) while you enter. This is to ensure that the 

password is not revealed to other users. 

• Ensure that the entered password is at least six characters long. 

• The password must be alphanumeric with a combination of numbers and characters. 

• The password should not contain spaces. 

• Passwords are case sensitive and ensure that the Caps Lock is not turned ON. 

• By default the currently used password is checked for validity if password history is not set. 



Oracle Financial Services Software 

OFSDM 8.0.6.0.0 Installation Guide  

203 

 

• New password should be different from previously used passwords based on the password 

history which can be configured. 

• If you encounter any of the following problems, contact the System Administrator: 

o Your user ID and password are not recognized. 

o Your user ID is locked after three consecutive unsuccessful attempts. 

o Your user ID has been disabled. 

o Guest user cannot change the password. 
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15 Appendix F: Post Deployment Configurations 

15.1 Post Deployment Configuration 

This chapter covers the following topics: 

• Deploying the Application 

• Logging as System Administrator 

• Creating Application Users 

• Mapping Application User(s) to User Group 

15.2 Deploying the Application 

This section explains steps to deploy the application. Web Layer deployment is required, For 

more information, see Appendix A. 

15.3 Logging as System Administrator 

Post installation, the first login into Infrastructure is possible only for a System Administrator 

through user ID, sysadmn. This ID is created at the time of installation with the password 

provided during installation. Enter login ID, sysadmn and password that was provided during 

installation. Click Login. 

15.4 Creating Application Users 

User Maintenance facilitates you to create user definitions, view, manage, modify, and delete 

user information. You can access User Maintenance by expanding User Administrator section 

within the tree structure of LHS menu. 

The User Maintenance screen displays user details such as User ID, Name, Profile Name, Start 

and End dates. You can also identify the user status if enabled to access the Infrastructure 

system. 

To add a user in the User Maintenance screen: 

1. Select  button from the User Maintenance tool bar. Add button is disabled if you have 

selected any User ID in the grid. The New User screen is displayed. 
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2. Enter the user details as tabulated. 

Field Description 

Fields marked in red asterisk (*) are mandatory.  

User ID* Enter a unique user ID. Ensure that there are no special characters and extra 
spaces in the id entered. 

User Name* Enter the user name. The user name specified here is displayed on the 
Infrastructure Splash screen. Ensure that the user name does not contain any 
special characters or spaces except ”–“, “’”. and “.”.  

Contact Address* Enter the contact address of the user. It can be the physical location from where 
the user is accessing the system. Ensure that Contact Address does not contain 
any special characters except ".", "#", "-", ",".  

Date Of Birth* Specify the date of birth. You can use the popup calendar to enter the date.  

Designation* Enter the user designation. Ensure that designation does not contain any special 
characters except “_, “:” and "-".  

Profile Name* Select the profile name by clicking on the drop down list.  

User Start Date* Specify the user start date based on the day slot the user is enabled to access 
the system. Ensure that User Start Date is greater than today’s date. You can 
use the popup calendar to enter the date.  

User End Date* Specify the user end date based on month and year when the user Id expires. 
Ensure that user End Date is greater than User Start Date. You can use the 
popup calendar to enter the date.  

Password* Enter the default password for the user for the initial login. User needs to change 
the default password during the first login.  

A user is denied access in case the user has forgotten the password or enters 
the wrong password for the specified number of attempts (as defined in the 
Configuration screen). To enable access, enter a new password here.  

Notification Time (Optional) Specify the notification start and end time within which the user can 
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be notified with alerts.  

E-mail ID* Enter the e-mail address of the user.  

Mobile No (Optional) Enter the mobile number of the user.  

Pager No (Optional) Enter the pager number of the user.  

Enable User* Select the checkbox to allow user to access the system. 

A deselected checkbox denies access to the user. 

3. Click Save to upload the user details. 

The new User details are populated in the User Authorization screen which has to be 

authorized by System Authorizers. Once authorized, the User details are displayed in User 

Maintenance screen and can then be mapped to the required user group in the User 

UserGroup Map screen. 

NOTE:  This step may not be required if you have already setup users in the OFSAA setup. 

For more information refer user creation section from the Oracle Financial Services 

Analytical Applications Infrastructure User Guide. 

15.5 Mapping Application User(s) to User Group 

The User UserGroup Map facilitates you to map user(s) to specific user group which in turn is 

mapped to a specific Information Domain and role. Every UserGroup mapped to the infodom 

needs to be authorized. Else, it cannot be mapped to users. 

The User UserGroup Map screen displays details such as User ID, Name, and the corresponding 

Mapped Groups. You can view and modify the existing mappings within the User UserGroup 

Maintenance screen. 

Starting the OFSAA 8.0 release, with installation of DM Application Pack, preconfigured 

Application user groups are seeded. These user groups are unique to every OFSAA Application 

Pack and have application roles pre-configured. 

You can access User UserGroup Map by expanding User Administrator section within the tree 

structure of LHS menu. 

After the user is created for Reconciliation Framework, it should to be mapped to the following 

mentioned user groups: 

1. Recon Administrator 

2. Recon Framework Analyst 

3. Recon Framework Authorizer 

After the user is created for Data Governance for different jurisdictions, it should to be mapped to 

the required user groups as per their roles: 
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• Data Governance for US Regulatory Reporting Application: DGS Authorizer Group, DGS 

Administrator Group, DGS Analyst Group, BUO and CWS 

• Data Governance for European Central Reporting Application: DGS EBA Authorizer 

Group, DGS EBA Administrator Group, DGS EBA Analyst Group, BUO and CWS 

• Glossary Module: Glossary Approver Group, Glossary Creator Group, Glossary Owner 

Group, Glossary Viewer Group 

• Business Terms Module: Glossary Term Approver Group, Glossary Term Creator Group, 

Glossary Term Owner Group, Glossary Term Viewer Group 

• Critical Data Element Module: CDE Approver Group, CDE Creator Group, CDE Owner 

Group, CDE Viewer Group 

• Control Module: DGCOGRP, DGCOVIEWGRP 

• Key Indicator Module: DGSKRCODGRP, KIVCAP, DGKIVIEWGRP, DGKIVCAP 

• Issues Module: DGISAPRGRP, DGISASRGRP 

• Actions Module: DGAAGRP 

• Process Monitoring Module: DGSPLANSCOPE, DGSPSI, DGPMVIEWGRP 

• Metadata Report Module: MDR Owner Group, MDR View Group 
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16 Appendix G: Cloning OFSAA Instance 

There is a consistent need for a faster and effective approach of replicating an existing OFSAA 

instance for further project developments, that is, setting up OFSAA instances that are exact 

copies of the current OFSAA instance. For more information on cloning, see OFSAA Cloning 

Reference Guide. 

http://docs.oracle.com/cd/E61555_01/books/OFSAA_Cloning_Reference_Guide_8.0.pdf
http://docs.oracle.com/cd/E61555_01/books/OFSAA_Cloning_Reference_Guide_8.0.pdf
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17 Appendix H: OFSAA Landing Page 

This appendix includes the following topics: 

Installation Checklist 

OFSAA Landing Page 

Enabling a Product within an Application 

Uninstalling the OSFAA Installation 

17.1 Installation Checklist 

Before starting on the OFSAAI Installation Kit, ensure that the following pre-installation activities 

checklist is completed successfully. It is recommended to take a print out of the checklist and 

follow the checklist step by step. 

Table with (General, Pre-Install, Install, and Post Install) Checklist 

Step No. Task  Done 

General 

1 Check the OFS Data Management Release Notes and Read Me document for 
any additional steps to be performed on OFS Data Management Pack or 
OFSAAI. 

Note: For more details, contact Oracle support. 



 

Data Management Pack Pre Installation + During Installation 

1 Prior to installation, ensure that sufficient free temp space (minimum 1 GB free) 
is available in /tmp directory of unix server hosting OFSAAI. 



Data Management Pack Post Installation 

1 Perform post-installation steps 
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17.2 OFSAA Landing Page for DM Administrator 

On successful authentication, the OFSAA 8.0.6.0.0 Landing Page is displayed. This is a common 

landing page for all users until a preferred application landing page is set by the user in his 

preferences.  

 

The landing page includes multiple tabs and each tab has specific links to OFSAA Infrastructure 

and/or Application modules. The tabs and links are displayed based on the OFSAA Application 

accessed and the access roles mapped to the logged in user. 

Each tab contains LHS Menu and RHS Menu. The LHS Menu holds link(s) to modules in a tree 

structure. The RHS Menu holds link(s) to modules in a navigational panel format. 

NOTE:  Refer the User Manual for more details on how to operate on each tab. 

17.2.1 Accessing OFSAA Infrastructure 

Infrastructure can be accessed through your web-browser as soon as the System Administrator 

(SA) installs and configures Oracle Financial Services Analytical Applications Infrastructure. 

The SA provides you with a link through which you can access Oracle Financial Services 

Analytical Applications Infrastructure. You can access the Infrastructure application login screen 

through your web-browser using the URL: http://<IP Address of the Web Server>:<servlet 

port>/<context name>/login.jsp. 

You can also login to the Infrastructure application with the host name instead of the IP address. 

To do this, it is necessary to have the host name mapped to the IP address in the hosts file the 

client Windows machine. The hosts file is in %systemroot%\system32\ drivers\etc\ directory. 

17.3 Enabling a Product within an Application 

Each product is marketed by a separate team and which is headed by a Sales Manager who 

reports to the Sales Head. Each Sales Manager in turn has two Sales Officers who are 

responsible for sales and profitability of the product.  
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The Sales Head has decided that the Sales Officer of each product not have access to the 

information of other products. However, each Sales Manager have access to Sales figures of the 

other products.  

Using the Oracle Infrastructure Security Hierarchy feature Administrator can provide information 

security at hierarchy level by defining security options for each hierarchy node. Thus, the Bank 

can control access of information at a node level and not increase the overheads.  

In the Oracle Infrastructure:  

• The users are created in Oracle Infrastructure and then, a business hierarchy (as defined 

above) is created.  

• The bank can restrict access of certain information to certain people in the Hierarchy Security 

configuration. In this window,  

• The administrator can control security by mapping the users to various nodes in hierarchy.  

For example, the administrator maps Sales Officer 1 and Sales Officer 2 to only the Personal 

Loans Node in the Product hierarchy. This restricts Sales Officer 1 and 2 to only viewing and 

maintaining their particular node in the hierarchy.  

By default, all the users mapped to a domain can access all the hierarchy levels to which they are 

mapped. This function allows the administrator to restrict or exclude a user/s from accessing 

restricted nodes. 

17.4 Enabling a Product within an Application Pack 

You can also enable a product/ application within an application pack post installation at any point 

of time.  

To enable a product through the application UI, Perform the following steps: 

1. Login to the application as SYSADMN user or any user with System Administrator privileges. 

2. Click  Administration. 
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3. Click Manage OFSAA Product License(s). The Manage OFSAA Product License(s) page is 

displayed. 
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This page includes the following sections: 

• INSTALLED APPLICATION PACKS 

• PRODUCTS IN THE APPLICATION PACK 

The following fields are displayed in the INSTALLED APPLICATION PACKS section: 

Field Description 

Application Pack ID 

Displays a unique Application Pack ID related to the Application Pack. 

Select the appropriate Pack ID. The products in the application pack 
are displayed in the PRODUCTS IN THE APPLICATION PACKS 
section. 

Application Pack Name Displays the name of the Application Pack. 

Description Displays the description of the Application Pack. 

Install Date Displays the date when the Application Pack was installed. 

The following fields are displayed in the PRODUCTS IN THE APPLICATION PACK 

section: 

Field Description 

Enable Select the checkbox to enable a product within an Application Pack. 

Product ID Displays a unique product ID for the product. 

Product Name Displays the name of the Product 

Description Displays the description of the product. 

Enable Date Displays the date when the product was enabled. 

4. Select an Application Pack from the Application Pack ID field. 

Selecting an Application Pack displays the products within the Application Pack. 
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Products enabled during installation have the checkbox “ENABLE” disabled. You can enable 

any product within the selected Application Pack by clicking the “ENABLE” checkbox against 

the respective Product ID. 

5. Click RESET to cancel the operation and refresh the screen. 

6. Click VIEW LICENSE AGREEMENT. The License Agreement window is displayed. 

7. Select I ACCEPT THE LICENSE AGREEMENT. 

8. Click ENABLE. 

An appropriate pop-up message confirmation is displayed showing that the product is 

enabled for the pack. 

NOTE:  To use the newly enabled product, you need to map your application users to the appropriate 

product specific User_Group(s) and subsequently, authorize the actions by logging in 

as System Authorizer. 

 

NOTE:  For more information refer to Mapping/Unmapping Users section in the Oracle Financial 

Services Analytical Applications Infrastructure User Guide 8.0.  

To identify the newly enabled product specific UserGroups/ Application Pack specific 

User_Groups, refer to the respective Application Pack specific Installation and 

Configuration Guide/ User Manual. 

17.5 Uninstalling OFSAA Installation 

This section provides the necessary steps to uninstall the OFSAA 8.0 installation. 

Before you start the uninstall process, ensure that no open connections exist to the OFSAA 

Configuration Schema and Atomic Schemas, and Infrastructure Services are brought down. 

To uninstall OFSAA: 

1. Log in to the system as non-root user. 

2. Navigate to the $FIC_HOME directory and execute the command: 

./Uninstall.sh 

3. Enter the password for OFSAA Configuration Schema when prompted as shown in the 

following figure: 
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Uninstall process does not uninstall the OFSAA application from the Web Application Server. This 

has to be done manually. The files/ directories under the file system staging area (ftpshare) have 

to be deleted manually. 

All the Database objects from Atomic Schemas have to be dropped manually. 
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18 Appendix I: Additional Configurations 

The following sections provide detailed module specific post installation configurations. 

This section includes the following topics: 

• Configuring FTP/SFTP 

• Configuring Infrastructure Server Memory 

• Setting Up Internet Explorer 

• Retrieving Patch Information 

• Configuring OLAP Data Server 

• Changing IP/ Hostname, Ports, Deployed Paths of the OFSAA Instance 

• Configuring Infrastructure Ports 

• Fetching Tool for OFSAAI Setup Information 

• Encryption Changer 

• Configuring Infrastructure LDAP 

• Configuring OFSAAI Web Services 

• Deploying OFSAAI Web Services 

• Configuring Message Details in Forms Designer 

• Clearing Application Cache 

• Configuring Password Changes 

• Configuring Java Virtual Machine 

• Configuring Internal Service (Document Upload/ Download) 

18.1 Configuring FTP/SFTP 

This section details about the configurations required for FTP/SFTP. 

18.1.1 Adding FTP/ SFTP Configuration for File Transfer 

In OFSAA, certain modules require transfer of files from the web application server to the OFSAA 

server over SSH.  

Follow these steps to ensure the OFSAA server recognizes the web application server during file 

transfers.  

1. Login to the web application server. 

2. Type sftp <user>@<OFSAA Server> 
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3. Specify Yes when prompted for permission.  

Are you sure you want to continue connecting (yes/no)?  

4. This will add an entry into the "known_hosts" file. 

5. A confirmation message is displayed  

Permanently added <OFSAA Server> (RSA) to the list of known hosts. 

18.1.2 Setting Up SFTP Private Key 

Log in to OFSAA Unix user using Putty tool, where you plan for installation and generate a pair of 

authentication keys using the ssh-keygen command. If required, set passphrase. Otherwise 

OFSAAI_SFTP_PASSPHRASE tag in the OFSAAI_ InstallConfig.xml file should be set to 

NA. 

To generate private key, enter the commands as shown: 

ofsaapp@OFSASERVER:~> ssh-keygen -t rsa Generating public/private rsa 

key pair. 

Enter file in which to save the key (/home/ofsaapp/.ssh/id_rsa): 

Created directory '/home/ofsaapp/.ssh'. 

Enter passphrase (empty for no passphrase): Enter same passphrase 

again:  

Your identification has been saved in /home/ofsaapp/.ssh/id_rsa. Your 

public key has been saved in /home/ofsaapp/.ssh/id_rsa.pub. The key 

fingerprint is: 3e:4f:05:79:3a:9f:96:7c:3b:ad:e9:58:37:bc:37:e4  

ofsaapp@OFSASERVER:~> cat /home/ofsaapp/.ssh/id_rsa.pub >> 

/home/ofsaapp/.ssh/authorized_keys 

 

In case, you are generating SFTP Private key for Hive server, append the content of  

/home/ofsaapp/.ssh/id_rsa.pub to Hiveserver authorized_keys file located at  

$HOME_DIR_HIVE/.ssh folder. 

Ensure the following permissions exist for the given folders: 

• Permission of .ssh should be 700 

• Permission of .ssh/authorized_keys should be 640 

• Permission of .ssh/id_rsa should be 400 

• Permission of Unix user created should be 755 
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18.2 Configuring Infrastructure Server Memory 

The memory settings for Infrastructure Application Server, Tomcat, WebSphere, and WebLogic 

can be edited for customizing memory settings and garbage collector settings depending on the 

available hardware configuration as explained below. These settings are base minimum and has 

to be incremented considering the deployment metrics into account. The increments are usually 

handled in multiples of 128mb for heap and 64mb for stack. 

18.2.1 Setting Up Infrastructure Server Memory 

You can configure the Infrastructure Application Memory settings as follows: 

1. Locate .profile file. 

2. Edit X_ARGS field in this file for customizing memory settings and garbage collector settings 

depends on the hardware configuration. 

This has a default value X_ARGS_APP ="-Xms200m" 

X_ARGS_APP =" "$X_ARGS" $DELIM -Xmx2048m" 

NOTE:  You need to modify X_ARGS_APP variable in the .profile file to customize Java Memory 

Settings for Model Upload based on the Data Model size. 

For Run and Rule executions, the following value is recommended:   

 

X_ARGS_RNEXE="-Xms1g -Xmx1g -XX:+UseAdaptiveSizePolicy -

XX:MaxPermSize=512M -XX:+UseParallelOldGC -XX:+DisableExplicitGC"   

 

X_ARGS_RLEXE="-Xms1g -Xmx1g -XX:+UseAdaptiveSizePolicy -

XX:MaxPermSize=512M -XX:+UseParallelOldGC -XX:+DisableExplicitGC" 

  



Oracle Financial Services Software 

OFSDM 8.0.6.0.0 Installation Guide  

219 

 

18.3 Setting Up Internet Explorer 

NOTE:  OFSAAI supports only default zoom setting in Internet Explorer, that is, 100%. 

Cookies should be enabled. 

 

The following browser settings have to be specified at every client machine prior to accessing the 

Infrastructure application. 

1. Open Internet Explorer. Select Tools → Internet Options. The Internet Options window is 

displayed. 

2. Click the Settings button. The Settings window is displayed. 

3. Select the option Everytime I Visit the webpage and click OK. 

 

4. In the Internet Options window, select the Security tab and select the Internet option under 

Select a zone to view or change the security settings. 

5. Click Default Level under Security level for this zone. 
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6. Click OK to save. 

7. Click Internet Explorer → Tools → Compatibility View Settings. 

8. Enter the OFSAA setup URL in the Add this website field. 

9. Click Add. 

10. Ensure the URL is listed under Websites you've added to Compatibility View. 

11. In the Internet Options window, select the Privacy tab and select the Turn on Pop-up 

Blocker option under Pop-up Blocker settings. 
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12. Click Settings. The Pop-up Blocker Settings window is displayed. 

13. Enter the URL of the OFSAA Application in the Address of Website to Allow: field. 

14. Click Add. The OFSAA URL is displayed in the Allowed Sites section. 

15. Click Close. 

16. Click OK in the Internet Options window. 

18.4 Retrieving Patch Information 

To identify the list of patches installed on your OFSAA setup, perform the following steps: 

1. Login to the OFSAA application as a user with Object AdminAdvanced Role. 

2. Navigate to Object Administration tab. 

3. Click System Utilities. 

4. Click Patch Information. 

5. The page displays the list of patches installed on the OFSAA setup across Applications/ 

Platform. 
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18.5 Configuring OLAP Data Server 

This section is applicable if you are using the OLAP feature of OFSAAI. 

The following parameters must be set to ensure that the system limitations are not exceeded at 

any stage. The values for these OS parameters should be specified based on the expected load 

at each implementation site. 

Example: 

Process Memory Limit 

Max Thread Stack Size 

Max Number of Threads per Process 

Sort Buffer settings: This must be set at the Essbase application level appropriate to the 

anticipated load. 

Shutdown and Restart: During shutdown of OFSAAI Server that has an instance of Data 

Services that is communicating with an OLAP Data Server, it is imperative to ensure that the 

cleanup of the old instance is completed on the OLAP Data Server before restarting the OFSAAI 

Server. Pause for a period of time based on the load the system was subjected to, before 

restarting the Data Services subsystem. 

18.6 Changing IP/ Hostname, Ports, Deployed Paths of the OFSAA Instance 

For information on this section, see OFS Analytical Applications Infrastructure Administration 

User Guide in OTN. 

18.7 Configuring Infrastructure Ports 

This step is applicable only in the event you wish to change any of the ports used by 

Infrastructure services after the installation process. The ports that are used by the Infrastructure 

application are distributed across the machines on which Infrastructure Web; Application, and 

Database components have been installed. Therefore you must perform the port changes on all 

the machines on which Infrastructure components have been installed. 

The PortC.jar file can be executed in two modes. 

GUI 

CMD 

To execute PortC.jar file in GUI mode, ensure that Hummingbird Exceed is running and do 

the following: 

1. Navigate to the path $FIC_HOME in each machine. 

2. Enter the command: 

http://docs.oracle.com/cd/E60058_01/homepage.htm
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java -jar PortC.jar GUI 

3. The OFSAA Infrastructure Port Changer window is displayed. 

 

The OFSAA Infrastructure Port Changer window displays the following: 

The path in which Infrastructure components have been installed. 

The check-boxes corresponding to enable Application Layer, Database Layer, or Web 

Layer: 

o In the event you have performed a single-tier installation on the current machine, the 

check-boxes for all three components be enabled.  

If you have installed more than one category of components on the current machine, the 

corresponding checkboxes for the respective components you have installed are 

enabled. 

To edit the port value, enter the new port value. User has the option to change the required 

ports and leave the other ports unchanged. Only the ports for which values are modified 

change and the ports that are unchanged retain its default value. 

NOTE:  All ports on a machine must be unique. The range of port numbers that are given should 

preferably be between 1025 and 65535. The Servlet port can have 80 or 443 as port 

numbers if Default HTTP/HTTPS ports are being used. 
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o Select the Database Type as Oracle from the drop-down list. 

The IP / Host Address of the machine on which the corresponding database is installed  

be populated. 

The Port Number on which the database is listening is displayed. 

The SID details are displayed. 

The Configuration Schema username is displayed. 

Enter the Configuration schema password. 

Click Change to initiate the port changes. 

To execute PortC.jar in CMD mode: 

4. Navigate to the path $FIC_HOME. 

5. Enter the command: 

java -jar PortC.jar CMD 

Then enter the requested information to change the ports. Once the port numbers are 

changed in the Infrastructure configuration, a message  be displayed confirming the changes. 

The log, Portchanger.log, in the Infrastructure installation path provides the status of port 

changes performed. 

For above port changes to take effect, a restart of all Infrastructure servers is required. 

NOTE:  Do not execute the PortC.jar file with CMD option in the nohup mode. The port changes 

are done only on Infrastructure web components where EAR/WAR files are deployed. 

After the port changes are done, you need to re-create the EAR/WAR files and re-

deploy these files. 

18.8 Fetching Tool for OFSAAI Setup Information 

Executing the SetupInfo.jar file available in the $FIC_HOME path helps you retrieve the 

related information about the OFSAAI Set up such as Operating System Name and version, 

Database Type and Version, OFSAAI architecture, Log file locations and so on. 

To execute "SetupInfo.jar" in console: 

1. Navigate to the path $FIC_HOME. 

2. Enter the command: 

java -jar SetupInfo.jar 

After execution, the output file location is displayed in the console. 
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18.9 Encryption Changer 

For more information on Encryption Changer, see Key Management section in OFSAAI 

Administration Guide. 

18.10 Configuring Infrastructure LDAP 

For more information on LDAP configuration, see OFSAAI Administration Guide. 

18.11 Configuring Enable Parallel Execution of DML statements 

A configuration file, OracleDB.conf has been introduced to accommodate any configurable 

parameter related to operations on oracle database. If you do not want to set a parameter to a 

specific value, then the respective parameter entry can be removed/commented off form the 

OracleDB.conf file which resides in the path $FIC_DB_HOME/conf. 

As of now, the OracleDB.conf file has only one parameter namely 

CNF_DEGREE_OF_PARALLELISM. This parameter indicates the degree of parallelism to be used 

for a DML operation if parallel DML is explicitly enabled in the session with the ENABLE 

PARALLEL DML clause of the ALTER SESSION statement. The default mode of a session is 

DISABLE PARALLEL DML. If CNF_DEGREE_OF_PARALLELISM is not set, then the default 

degree, as decided by Oracle is used. 

18.12 Configuring Message Details in Forms Designer 

You can configure the Message Details in Forms Designer under Data Entry Forms and Queries 

module by updating the details of mail server in the "NotificationConfig.cfg" file which resides in 

the path $FIC_APP_HOME/common/FICServer/conf. 

Ensure that the "authorized User details" for whom you need to configure the Message details are 

included in Administration → Security Management → User Administrator → User 

Maintenance window. 

Update the following parameters in the "NotificationConfig.cfg" file: 

Parameter Description 

SMTP_SERVER_IP Specify the hostname or IP address of SMTP Server. 

SMTP_DEBUG_MODE To run SMTP service in Debug mode, set value to 'true', otherwise set value 
to 'false'. 

SMTP_AUTHORIZATION Set to 'true' if SMTP server requires the client to be authenticated, otherwise 
set to 'false'. 

SMTP_USERNAME Username required for logging into SMTP server, if authentication is not 
required use a dummy value. 

https://docs.oracle.com/cd/E60058_01/homepage.htm
https://docs.oracle.com/cd/E60058_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/PDF/8.0.0.x/8.0.0.0.0/OFSAAI_Administration_Guide_8.0.pdf
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Parameter Description 

SMTP_PASSWORD Password required for logging into SMTP server, if authentication is not 
required use a dummy value. 

SMTP_MAILID If the Messages has to go from a Particular ID that ID must be added. 
Exchange server forces you set a valid ID that is there in the exchange 
server. (Based on Security settings) 

 

Ensure that the authorized User details are included in Administration → Security 

Management → User Administrator → User Maintenance window. 

18.13 Clearing Application Cache 

This is applicable to all Web Servers (that is, WebSphere, WebLogic, and Tomcat).  

Prior to the deployment of Infrastructure or Application Service Packs / One-off patches, navigate 

to the following path depending on the WebServer configured and clear the cache: 

• Tomcat: <Tomcat installation 

directory>/work/Catalina/localhost/<Application name>/org/apache/jsp 

• WebLogic: <Weblogic installation location>/domains/<Domain 

name>/servers/<Server name>/tmp/_WL_user/<Application 

name>/qaelce/jsp_servlet 

• WebSphere: <Websphere installation 

directory>/AppServer/profiles/<Profile name>/temp/<Node 

name>/server1/<Application name>/<.war file name> 

18.14 Configuring Password Changes 

This section explains about how to modify the OFSAA Infrastructure Config Schema and Atomic 

Schema passwords. 

18.14.1 Modifying OFSAA Infrastructure Configuration Schema Password 

To change the Config Schema password, perform the following steps: 

1. Change the Config Schema User Password in the database. 

2. Delete the $FIC_HOME/conf/Reveleus.SEC file. 

3. Shutdown the OFSAAI App service: 

cd $FIC_APP_HOME/common/FICServer/bin 

./ reveleusshutdown.sh 
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4. Start the Infrastructure Server in foreground directly on the server or through X-Windows 

software using the command: 

./ reveleusstartup.sh 

At the prompt, enter System Password. Enter the "new Config schema" password. The 

service starts and initializes itself if it is able to successfully connect to the DB. 

5. Post successful startup of the service, if required, the Infrastructure server can be shut down 

and restarted in the background using nohup mode. 

18.14.2 Modifying OFSAA Infrastructure Atomic Schema Password 

To change the Atomic Schema password, perform the following steps: 

1. Change the Atomic Schema User Password in the database. 

2. Login to the application from the browser using SYSADMN account or any user ID, which has 

System Administrator role mapped. 

3. Navigate to System Configuration → Database Details window. Select the appropriate 

connection and edit the password. 

4. Navigate to Unified Metadata Manager → Technical Metadata → Data Integrator → 

Define Sources window. Update the appropriate Source details. 

5. If you are using Apache Tomcat as Web server, update the <Context> -> Resource tag 

details in Server.xml file from the $CATALINA_HOME/conf directory. (In case of Tomcat 

only Atomic <Resource>  exist). 

6. If you are using WebSphere as Web server: 

a. Login to the WebSphere Administration Console, from the left side menu. 

b. Navigate to Resources → JDBC → Data Sources. A list of data sources are populated 

on the right side.  

c. Select the appropriate Data Source and edit the connection details. (In this case, both 

Config and Atomic data sources must be modified). 

7. If you are using WebLogic as Web server: 

a. Login to the WebLogic Administration Console, from the left side menu 

b. Under Domain Structure list box, expand the appropriate Domain and navigate to 

Services → JDBC → Data Sources. A list of data sources are populated on the right 

side.  

c. Select the appropriate Data Source and edit the connection details. (In this case, both 

Config and Atomic data sources must be modified). 

8. Restart the OFSAAI services. 
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18.15 Configuring Java Virtual Machine 

While running several database intensive tasks in parallel, fetching the database connection from 

connection pool may face an error. To ensure no such error is encountered, add the line 

securerandom.source=file:/dev/./urandom in the java.security configuration file 

available in $JAVA_HOME/jre/lib/security/ path. 

This must be configured on all the machines or virtual machines where the OFSAAI database 

components (ficdb layer) are installed. 

18.16 Configuring Internal Service (Document Upload/ Download) 

This step can be ignored if it has already been configured as part of any previous IR /ML 

installation. 

The Document Upload /Download feature has undergone a change and can now be configured to 

use Internal service for document upload / download instead of the earlier ExeWebService. 

To facilitate Internal service for document upload/ download, perform the following configurations: 

1. Create the directories download, upload, TempDocument and Temp in the local path of 

Web application server and provide Read/Write permission. 

• To find the exact location, execute the following query in CONFIG schema: 

select localpath from web_server_info 

• To create directories with Read/Write permission, execute the command: 

mkdir -m 777 download upload TempDocument Temp 

2. Create DocStorage directory in the FTPSHARE location of APP tier and provide Read/Write 

permission. 

• To find the exact location, execute the query in CONFIG schema: 

select ftpdrive from app_server_info 

• To create directory with Read/Write permission, execute the command: 

mkdir -m 777 DocStorage 

 



OFSDM 8.0.6.0.0 Installation Guide 

Oracle Financial Services Software 

 

 

229 

 

19 Appendix J: Patching DM Pack Installation 

Oracle strongly recommends installing the latest available patch set to be up-to-date with the 

various releases of the OFSAA Infrastructure product. 

See http://support.oracle.com for more information on latest releases. 

 

http://support.oracle.com/


OFSDM 8.0.6.0.0 Installation Guide 

Oracle Financial Services Software 

 

 

230 

 

20 Appendix K: Grants for Atomic/ Config Schema 

This appendix includes the following sections: 

• Grants for Atomic Schema 

• Grants for Config Schema 

• Grants for Config Schema Entities for Atomic Users 

20.1 Grants for Atomic Schema 

Atomic Schema creation requires certain grants for object creation. This can be located in 

$FIC_HOME/privileges_atomic_user.sql file  

grant create SESSION to &database_username 

/ 

grant create PROCEDURE to &database_username 

/ 

grant create SEQUENCE to &database_username 

/ 

grant create TABLE to &database_username 

/ 

grant create TRIGGER to &database_username 

/  

grant create VIEW to &database_username 

/ 

grant create MATERIALIZED VIEW to &database_username 

/ 

grant olap_user to &database_username 

/ 

grant select on SYS.V_$PARAMETER to &database_username 

/ 

grant create SYNONYM to &database_username 

/ 

NOTE:  If you intend to use Oracle OLAP feature, execute the below grant on all  ATOMIC schema(s)  

grant olap_user to &database_username 

20.2 Grants for Config Schema 

Config Schema creation requires certain grants for object creation. This can be located in 

$FIC_HOME/privileges_config_user.sql file  

The following are the Grants for Config Schema: 

grant create SESSION to &database_username 

/ 

grant create PROCEDURE to &database_username 

/  

grant create SEQUENCE to &database_username 

/  
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grant create TABLE to &database_username 

/  

grant create TRIGGER to &database_username 

/  

grant create VIEW to &database_username 

/  

grant create MATERIALIZED VIEW to &database_username 

/  

grant olap_user to &database_username 

/ 

grant select on SYS.V_$PARAMETER to &database_username 

/ 

grant create SYNONYM to &database_username 

/ 

20.3 Grants on Config Schema Entities for Atomic Users 

Atomic Schema creation requires certain grants for config schema object access. This can be 

located in $FIC_HOME/config_table_privileges_for_atomic_user.sql file.  
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21 Appendix L: DM Pack XML Files 

21.1  OFS_DM_PACK.xml 

NOTE: In case of HIVE, rename the following files and then proceed. 

• OFS_DM_PACK.xml to OFS_DM_PACK.xml.bkp 

• OFS_DM_PACK.xml.HYBRID.template to OFS_DM_PACK.xml 

The OFS_DM_PACK.xml file holds details on the various products that are packaged together in 

DM Application Pack.  

This section details the various tags/ parameters available in the file and the values that must be 

updated. Prior to installing the DM Application Pack in SILENT mode, it is mandatory to update 

this file.  

 

21.1.1 Configuring OFS_DM_PACK.XML file 

The OFS_DM_PACK.xml file holds details on the various OFSAA products that are packaged in a 

particular Application Pack.  

The following table gives details about the various tags/ parameters available in the file and the 

values that must be updated. Prior to installing the OFSAA Application Pack in SILENT mode, it is 

mandatory to update this file.  

NOTE:  If you are installing in the GUI mode, then this file is not updated. 
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Tag Name/ Attribute Name Description Mandatory  
(Y/ N) 

Default Value/ 
Permissible Value 

Comments 

APP_PACK_ID Unique 

Application Pack 

Identifier 

Y Unique Seeded 

Value  

DO NOT modify this 

value. 

APP_PACK_NAME Unique 

Application Pack 

Name 

Y Unique Seeded 

Value 

DO NOT modify this 

value. 

APP_PACK_DESCRIPTION Unique 

Application Pack 

Description 

Y Unique Seeded 

Value 

DO NOT modify this 

value. 

VERSION Unique release 

version 

Y Unique Seeded 

Value 

DO NOT modify this 

value. 

APP Unique 

Application 

Entries 

Y Unique Seeded 

Value 

DO NOT remove 

these tags. 

APP_ID Unique 

Application 

Identifier 

Y Unique Seeded 

Value 

DO NOT modify this 

value. 

APP_ID/ PREREQ Prerequisite 

Application/ 

Product 

Y Unique Seeded 

Value 

For most 

applications 

Infrastructure is the 

prerequisite set. For 

certain other 

applications, an 

appropriate 

Application ID 

would be set. 

DO NOT modify this 

value. 

APP_ID/ DEF_SEL_FLAG Default Selected 

Flag 

Y Default - YES In all Application 

Packs, 

Infrastructure would 

have this value set 

to “YES”. DO NOT 

modify this value. 
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Tag Name/ Attribute Name Description Mandatory  
(Y/ N) 

Default Value/ 
Permissible Value 

Comments 

APP_ID/ ENABLE Enable 

Application/ 

Product 

YES if 

installing in 

SILENT 

mode. 

Default:  

YES for Infrastructure 

NO for Others 

Permissible: YES or 

NO 

Set this attribute-

value to YES 

against every 

APP_ID which is 

licensed and should 

be enabled for use. 

Note: Application/ 

Product once 

enabled cannot be 

disabled. However, 

Application/ Product 

not enabled during 

installation can be 

enabled later 

through the 

Administration UI. 

APP_NAME Unique 

Application/ 

Product Name 

Y Unique Seeded 

Value 

DO NOT modify this 

value. 

APP_DESCRIPTION Unique 

Application/ 

Product Name 

Y Unique Seeded 

Value 

DO NOT modify this 

value. 

VERSION Unique release 

version 

Y Unique Seeded 

Value 

DO NOT modify this 

value. 
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21.2 OFS_DM_SCHEMA_IN.xml 

The OFS_DM_SCHEMA_IN.XML file contains details on the various application schemas that 

should be created prior to the DM Application Pack installation.  

This section details the various tags/ parameters available in the file and the values that must be 

updated. Prior to executing the schema creator utility, it is mandatory to update this file. 

 

21.2.1 Configuring OFS_DM_SCHEMA_IN.XML File 

Creating database schemas, object with schemas and assigning appropriate grants are the 

primary steps in the installation process of OFSAA Applications. The OFS_DM_SCHEMA_IN.xml 

file contains details on the various application schemas that should be created prior to the 

Application Pack installation.  

The following table gives details about the various tags/ parameters available in the file and the 

values that must be updated. Prior to executing the schema creator utility, it is mandatory to 

update this file. 
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Tag Name/  
Attribute Name 

Description Mandatory 
(Y/N) 

Default Value/  
Permissible Value 

Comments 

<APP_PACK_ID> Unique Application 
Pack Identifier 

Y 
Unique Seeded Value  DO NOT modify this 

value. 

<JDBC_URL> Enter the JDBC URL. 

Note: You can enter 
RAC and NON-RAC 
enabled database 
connectivity URL. 

Y 
Example,  

jdbc:oracle:thin:@< 
DBSERVER IP/HOST/ 
IP>:<PORT>:<SID> 

oror 

jdbc:oracle:thin:@//[HOST][:P
ORT]/SERVICE 

or 

jdbc:oracle:thin:@(DESCRIP
TION=(ADDRESS_LIST=(AD
DRESS=(PROTOCOL=TCP)(
HOST=[HOST])(port=[PORT])
)(ADDRESS=(PROTOCOL=T
CP)(HOST=[HOST])(PORT=[
PORT]))(LOAD_BALANCE=y
es)(FAILOVER=yes))(CONNE
CT_DATA=(SERVICE_NAME
=[SERVICE])))  

For example, 
jdbc:oracle:thin:@//dbhost.ser
ver.com:1521/service1  

or 

jdbc:oracle:thin:@//dbshost.s
erver.com:1521/scan-1 

or 

jdbc:oracle:thin:@(DESCRIP
TION=(ADDRESS_LIST=(AD
DRESS=(PROTOCOL=TCP)(
HOST=dbhost1.server.com)(p
ort=1521))(ADDRESS=(PRO
TOCOL=TCP)(HOST=dbhost
2.server.com)(PORT=1521))(
LOAD_BALANCE=yes)(FAIL
OVER=yes))(CONNECT_DA
TA=(SERVICE_NAME=servic
e1))) 

Ensure to add an 
entry (with SID/ 
SERVICE NAME) in 
the tnsnames.ora file 
on the OFSAA 
server. The entry 
should match with 
the SID/ SERVICE 
NAME used in the 
JDBC URL. 

<JDBC_DRIVER> 
By default this driver 

name is seeded.  

Note: Do not edit this 
attribute value. 

Y 
Example,  

oracle.jdbc.driver.OracleDrive
r 

Only JDBC Thin 
Driver is supported. 
DO NOT modify this 
value. 

<HOST> Enter the Hostname/ 
IP Address of the 
system on which you 
are installing the 

Y 
 

Host Name/ IP Address 
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Tag Name/  
Attribute Name 

Description Mandatory 
(Y/N) 

Default Value/  
Permissible Value 

Comments 

OFSAA components. 
 

 

<IS_HYBRID>/ 

VALUE = TRUE 

Flag to identify the 
mode of installation 

Y 
TRUE 

This flag value 
should be TRUE in 
case of Hybrid mode 
of installation only. 

<SETUPINFO>/ 
NAME 

Enter the acronym 

for the type of 

implementation. This 

information will be 

displayed in the 

OFSAA Home Page. 

Note: On executing 
the schema creator 
utility, this value will 
be prefixed with each 
schema name. For 
example: 
dev_ofsaaconf, 
uat_ofsaaatm. 

Y 
Accepts strings with a 

minimum length of two and 

maximum of four. 

Example,  

DEV, SIT, PROD 

This name would 
appear in the OFSAA 
Landing Page as 
“Connected To: xxxx” 

The schemas being 
created would get 
this prefix. For E.g. 
dev_ofsaaconf, 
uat_ofsaaconf etc. 

<SETUPINFO>/ 
PREFIX_SCHEMA_N
AME 

Identifies if the value 

specified in 

<SETUPINFO>/ 

NAME attribute 

should be prefixed to 

the schema name. 

N  
YES or NO 

Default value is YES. 

<PASSWORD>/ 
APPLYSAMEFORALL 

Enter as Y if you want 
to apply the password 
specified in DEFAULT 
attribute for all the 
schemas.  

If you enter as N, you 
need to provide 
individual passwords 
for all schemas. 

Note: In case you 
have entered Y in 
APPLYSAMEFORALL 
attribute and also 
have specified 
individual passwords 
for all the schemas, 
then the specified 
individual passwords 
will take precedence. 

Y Default – N 
Permissible – Y or N 

Note: Setting this 
attribute value is 
mandatory, If 
DEFAULT attribute is 
set. 

<PASSWORD>/ Enter the password N The maximum length 
 



OFSDM 8.0.6.0.0 Installation Guide 

Oracle Financial Services Software 

 

 

238 

 

Tag Name/  
Attribute Name 

Description Mandatory 
(Y/N) 

Default Value/  
Permissible Value 

Comments 

DEFAULT* if you want to set a 

default password for 

all schemas. 

Note: You also need 

to set 

APPLYSAMEFORA

LL attribute as Y to 

apply the default 

password for all the 

schemas. 

allowed is 30 characters. 

Special characters are not 

allowed. 

<SCHEMA>/ TYPE The different types of 
schemas that are 
supported in this 
release are  ATOMIC, 
CONFIG, SANDBOX, 
and ADDON. 

By default, the 
schemas types are 
seeded based on the 
Application Pack.  

Note: Do not edit this 
attribute value. 

 

Y ATOMIC/CONFIG/SANDBOX
/ADDON 

 

Note:  

SANDBOX AND ADDON 
schemas are not applicable 
for OFS AAAI Application 
Pack. 

Only One CONFIG 
schema can exist in 
the file. 
This schema 
identifies as the 
CONFIGURATION 
schema that holds 
the OFSAA setup 
details and other 
metadata 
information. 

Multiple ATOMIC/ 
SANDBOX/ ADDON 
schemas can exist in 
the file. 

ATOMIC schema 
refers to the 
Information Domain 
schema. SANDBOX 
schema refers to the 
SANDBOX schema. 
ADDON schema 
refers to other 
miscellaneous 
schema (not 
applicable for this 
Application Pack).  

<SCHEMA.>/ NAME 
By default, the 

schemas names are 

seeded based on 

the Application 

Pack. 

You can edit the 

schema names if 

required.  

Note: 

Y The permissible length is 15 
characters and only 
alphanumeric characters 
allowed. No special 
characters allowed except 
underscore ‘_’. 

SETUPINFO/ NAME 
attribute value would 
be prefixed to the 
schema name being 
created. 
For E.g. if name is 
set as ‘ofsaaatm’ and 
setupinfo as ‘uat’ 
then schema being 
created would be 
‘uat_ofsaaatm’.  

NAME should be 
same where 
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Tag Name/  
Attribute Name 

Description Mandatory 
(Y/N) 

Default Value/  
Permissible Value 

Comments 

The Schema Name 

will have a prefix of 

the SETUPINFO/ 

NAME attribute. 

SCHEMA NAME 

must be same for all 

the ATOMIC 

Schemas of 

applications within 

an Application Pack. 

APP_GRP=1 for all 
SCHEMA tags (Not 
applicable for this 
Application Pack). 

<SCHEMA>/ 
PASSWORD* 

Enter the password of 
the schema to be 
created.  

Note:  

If this attribute is left 
blank, then the 
password specified in 
the 
<PASSWORD>/DEFA
ULT attribute is 
applied as the 
Schema Password. 

 

N 

 

The maximum length allowed 
is 30 characters. Special 
characters are not allowed. 

Note: You need to 
mandatorily enter the 
password if you have 
set the 
<PASSWORD>/ 
APPLYSAMEFORAL
L attribute as N. 

<SCHEMA>/ APP_ID 
By default, the 

Application ID is 

seeded based on 

the Application 

Pack.  

Note: Do not edit this 
attribute value. 

Y Unique Seeded Value Identifies the 
Application/ Product 
for which the schema 
is being created. 

DO NOT modify this 
value. 

<SCHEMA>/ 
DEFAULTTABLESPA
CE 

Enter the available 

default tablespace 

for DB User. 

Note:  

If this attribute is left 
blank, then USERS is 
set as the default 
tablespace. 

N Default – USERS 
Permissible – Any existing 
valid tablespace name. 
 

Modify this value to 
associate any valid 
tablespace with the 
schema. 

<SCHEMA>/ 
TEMPTABLESPACE 

Enter the available 

temporary 

tablespace for the 

DB User.  

N Default – TEMP 
Permissible – Any existing 
valid temporary tablespace 
name. 

Modify this value to 
associate any valid 
tablespace with the 
schema. 
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Tag Name/  
Attribute Name 

Description Mandatory 
(Y/N) 

Default Value/  
Permissible Value 

Comments 

Note:  

If this attribute is left 
blank, then TEMP is 
set as the default 
tablespace. 

<SCHEMA>/ QUOTA Enter the quota to be 
set on 
DEFAULTTABLESPA
CE attribute for the 
schema/ user. By 
default, the quota size 
is set to 500M. 
Minimum: 500M or 
Unlimited on default 
Tablespace 

N 
Example,  

600M/m 

20G/g 

UNLIMITED/unlimited 

 

Modify this value to 
grant the specified 
quota on the 
mentioned 
tablespace to the 
user.  

<SCHEMA>/ 

INFODOM 

Enter the name of 

the Information 

Domain to associate 

this schema. 

The schema creator 

utility automatically 

derives an 

Information Domain 

Name based on the 

Application Pack if 

no value is specified 

for this attribute. 

N 

(Optional for 

Atomic and 

mandatory for 

sandbox ) 

Permissible length is 16 

characters and only 

alphanumeric characters 

allowed. No special 

characters allowed. 

Enter this field in 
UPPERCASE. 

If DM media pack is 
first media pack 
installation in the 
setup, then 
INFODOM has to be 
specified mandatorily 
otherwise it is 
optional 

<ADV_SEC_OPTIO

NS> 

Parent tag to hold 
Advance Security 
Options.  

  

N  
Uncomment the tag 
and edit if you want 
to add security 
options. For 
example, TDE and 
Data Redact. 
 

For details, see the 
example following 
the table. 

<ADV_SEC_OPTIO

NS>/TDE 

Tag to 

enable/disable TDE. 

N Default is FALSE. To enable 

TDE, set this to TRUE. 

Ensure this tag is not 
commented if you 
have uncommented 
<ADV_SEC_OPTIO
NS>/ 

<ADV_SEC_OPTIO

NS>/ 

DATA_REDACT 

Tag to 

enable/disable Data 

Redaction feature. 

N Default is FALSE. To enable 

DATA_REDACT, set this to 

TRUE 

Ensure this tag is not 
commented if you 
have uncommented 
<ADV_SEC_OPTIO
NS>/ 
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Tag Name/  
Attribute Name 

Description Mandatory 
(Y/N) 

Default Value/  
Permissible Value 

Comments 

<TABLESPACES> Parent tag to hold 

<TABLESPACE> 

elements 

N NA 
Uncomment the tag 
and edit. ONLY if 
tablespaces are to 
be created as part 
of the installation. 
 
For details, see the 
example following 
the table. 
 

Note: When TDE is 
TRUE in 
ADV_SEC_OPTION
S, then it is 
mandatory for the 
<TABLESPACES> 
tag to be present in 
the xml file. 

<TABLESPACE>/ 

NAME 

Logical Name of 

tablespace to be 

created. 

Y   
Name if specified 
should be referred 
in the <SCHEMA 
DEFAULTTABLES
PACE= 
“##NAME##”> 
attribute. 

Note the ## syntax. 

<TABLESPACE>/ 

VALUE 

Physical Name of 

the tablespace to be 

created 

Y NA 
Value if specified will 
be the actual name 
of the 
TABLESPACE. 

<TABLESPACE>/ 

DATAFILE 

Specifies the 

location of the data 

file on the server 

Y NA 
Enter the absolute 
path of the file to be 
created. 

<TABLESPACE>/ 

AUTOEXTEND 

Specifies if the 

tablespace should 

be extensible or 

have a hard limit 

Y ON or OFF 
Set to ON to ensure 
that the tablespace 
does not run out of 
space when full. 

<TABLESPACE>/ 

ENCRYPT 

Specifies if the 

tablespace(s) should 

be encrypted using 

TDE. 

Y ON or OFF 
Set to ON to ensure 
that the tablespaces 
when created are 
encrypted using 
TDE. 

 

*On successful execution of the utility, the entered passwords in the OFS_DM_SCHEMA_IN.xml file are nullified. 

Note: Encryption of tablespaces requires to enabling Transparent Data Encryption (TDE) on the 

Database Server.   
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Example: : (The following snippet shows that TDE is enabled and hence the tablespace has been shown 

with encryption ON.) 

<ADV_SEC_OPTIONS> 

<OPTION NAME="TDE" VALUE="FALSE"/> 

<OPTION NAME="DATA_REDACT" VALUE="FALSE" /> 

</ADV_SEC_OPTIONS> 

<TABLESPACES> 

<TABLESPACE NAME="OFS_AAI_TBSP_1" VALUE="TS_USERS1" 

DATAFILE="/scratch/ora12c/app/oracle/oradata/OFSPQA12CDB/ts_users1.dbf" 

SIZE="500M" AUTOEXTEND="ON" ENCRYPT="ON" />TABLESPACE 

NAME="OFS_AAI_TBSP_2" VALUE="TS_USERS2" 

DATAFILE="/scratch/ora12c/app/oracle/oradata/OFSPQA12CDB/ts_users2.dbf" 

SIZE="500M" AUTOEXTEND="ON" ENCRYPT="ON" /> 

</TABLESPACES> 

 

<SCHEMAS> 

<SCHEMA TYPE="CONFIG" NAME="ofsaaconf" PASSWORD="" APP_ID="OFS_AAI" 

DEFAULTTABLESPACE="##OFS_AAI_TBSP_1##" TEMPTABLESPACE="TEMP" 

QUOTA="unlimited"/> 

<SCHEMA TYPE="ATOMIC" NAME="ofsaaatm" PASSWORD="" APP_ID="OFS_AAAI" 

DEFAULTTABLESPACE="##OFS_AAI_TBSP_2##" TEMPTABLESPACE="TEMP" 

QUOTA="unlimited" INFODOM="OFSAAAIINFO"/> 

</SCHEMAS> 

21.2.1 Configuring OFS 

DM_SCHEMA_BIGDATA_IN.xml file 

OFS_DM_SCHEMA_IN.XML File template for DM 806 Hyrbid is,  

OFS DM_SCHEMA_BIGDATA_IN.xml.HYBRID.template. 

Creating HIVE schemas, objects within the schemas are the primary steps in the installation process 

of OFSAA Applications. The OFS_DM_SCHEMA_BIGDATA_IN.xml file contains details on the various 

application schemas that should be created/ referred prior to the Application Pack installation. 

Note: This file should be configured only in case of OFS DM Application Pack installation for HDFS 

ONLY target. This file is not required to be configured for an RDBMS ONLY target installation. 
 

The following table provides details about the various tags/ parameters available in the file and the 

values that have to be updated. 

Prior to executing the schema creator utility, it is mandatory to update this file. 
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OFS_DM_SCHEMA_BIGDATA _IN.XML Parameters 

Tag Name/  
Attribute Name 

Description Mandatory 
(Y/N) 

Default Value/  
Permissible Value 

Comments 

<APP_PACK_ ID> Seeded unique ID for 

the OFSAA Application 

Pack 

Y Seeded DO NOT modify this 

value. 

<JDBC_URL> Enter the JDBC URL 

Note: You can enter 

RAC/ NON-RAC 

enabled database 

connectivity URL. 

Y Example, 

jdbc:oracle:thin:@<HOST/ 

IP>:<PORT>:<SID> 

or 

jdbc:oracle:thin:@//[HOS 

T][:PORT]/SERVICE 

or 

jdbc:oracle:thin:@(DESCRI 

PTION=(ADDRESS_ 

LIST=(ADDRESS=(PROT 

OCOL=TCP)(HOST=[HO 

ST])(port=[PORT]))(ADD 

RESS=(PROTOCOL=TCP) 

(HOST=[HOST])(PORT=[ 

PORT]))(LOAD_ 

BALANCE=yes)(FAILOV 

ER=yes))(CONNECT_ 

DATA=(SERVICE_ 

NAME=[SERVICE]))) 

For example, 

jdbc:oracle:thin:@//dbhos 

t.server.com:1521/service 1 

or 

jdbc:oracle:thin:@//dbsho 

st.server.com:1521/scan-1 

or 

jdbc:oracle:thin:@(DESCRI 

PTION=(ADDRESS_ 

LIST=(ADDRESS=(PROT 

OCOL=TCP)(HOST=dbho 

st1.server.com)(port=1521) 

)(ADDRESS=(PROTOCO 

In case of an HDFS 

ONLY target 

installation, this URL 

should be of the 

RDBMS instance that 

hosts the Application’s 

METADOM. 
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Tag Name/  
Attribute Name 

Description Mandatory 
(Y/N) 

Default Value/  
Permissible Value 

Comments 

L=TCP)(HOST=dbhost2.s 

erver.com)(PORT=1521))( 

LOAD_ 

BALANCE=yes)(FAILOV 

ER=yes))(CONNECT_ 

DATA=(SERVICE_ 

NAME=service1))) 

<JDBC_ DRIVER> By default this driver 

name is seeded. 

Note: Do not edit this 

attribute value. 

Y Example, 

oracle.jdbc.driver.OracleD river 

Only JDBC Thin 

Driver is supported. 

DO NOT modify this 

value. 

<HOST> Enter the Hostname/ IP 

Address of the system 

on which you are 

installing the OFSAA 

components. 

Y Host Name/ IP Address  

<SETUPINFO>/ 

PREFIX_ SCHEMA_ 

NAME 

Identifies if the value 

specified in 

<SETUPINFO>/ NAME 

attribute should be 

prefixed to the schema 

name. 

N YES or NO Default value is YES. 

<SETUPINFO>/ NAME Enter the acronym for 

the type of 

implementation. This 

information will be 

displayed in the 

OFSAA Home Page. 

Note: On executing the 

schema creator utility, 

this value will be 

prefixed with each 

schema name. For 

example: dev_ 

ofsaaconf, 

uat_ofsaaatm. 

Y Accepts strings with a minimum 

length of two and maximum of 

four. 

Example, 

DEV, SIT, PROD 

This name would 

appear in the OFSAA 

Landing Page as 

"Connected To: xxxx" 

The schemas being 

created would get this 

prefix. For example, 

dev_ ofsaaconf, 

uat_ofsaaconf etc. 
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Tag Name/  
Attribute Name 

Description Mandatory 
(Y/N) 

Default Value/  
Permissible Value 

Comments 

<PASSWORD>/ 

DEFAULT* 

Enter the password if 

you want to set a 

default password for all 

schemas. 

Note: You also need to 

set 

APPLYSAMEFORALL 

attribute as Y to apply 

the default password 

for all the schemas. 

N The maximum length allowed is 

30 characters. Special 

characters are not allowed. 

Applies only to the 

RDBMS type 

METADOM 

schema(s). 

<PASSWORD>/ 

APPLYSAMEFO RALL 

Enter as Y if you want 

to apply the password 

specified in DEFAULT 

attribute for all the 

schemas. 

If you enter as N, you 

need to provide 

individual passwords 

for all schemas. 

Note: In case you have 

entered Y in 

APPLYSAMEFORALL 

attribute and also have 

specified individual 

passwords for all the 

schemas, then the 

specified individual 

passwords will take 

precedence. 

Y Default - N Permissible - Y or N Note: Setting this 

attribute value is 

mandatory, If 

DEFAULT attribute is 

set. 

Applies only to the 

RDBMS type 

METADOM 

schema(s). 

<SCHEMAS>/ 

TYPE=RDBMS 

Identifies the RDBMS 

schema details. 

Y Default names for schemas 

within the pack would be 

derived in absence of any value 

specified. 

In an HDFS ONLY 

target installation, the 

Application’s 

METADOM (that 

hosts the metadata) 

for an application is 

stored in RDBMS 

schema and the data 
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Tag Name/  
Attribute Name 

Description Mandatory 
(Y/N) 

Default Value/  
Permissible Value 

Comments 

model entities of the 

application are stored 

in the DATADOM 

(which would be on 

Hive). 

<SCHEMA>/ TYPE The different types of 

schemas that are 

supported in this 

release are ATOMIC, 

CONFIG, SANDBOX, 

and ADDON. 

By default, the 

schemas types are 

seeded based on the 

Application Pack. 

Note: Do not edit this 

attribute value. 

Y ATOMIC/CONFIG/SAN 

DBOX/ADDON 

Note: SANDBOX AND 

ADDON schemas are not 

applicable for OFS AAAI 

Application Pack. 

Only One CONFIG 

schema can exist in 

the file. 

This schema identifies 

as the 

CONFIGURATION 

schema that holds the 

OFSAA setup details 

and other metadata 

information. 

Multiple ATOMIC/ 

SANDBOX/ ADDON 

schemas can exist in 

the file. 

ATOMIC schema 

refers to the 

METADOM within the 

Information Domain 

schema. SANDBOX 

schema refers to the 

SANDBOX schema. 

ADDON schema 

refers to other 

miscellaneous 

schema (not 

applicable for this 

Application Pack). 

<SCHEMA>/ NAME By default, the 

schemas names are 

seeded based on the 

Application Pack. 

You can edit the 

Y The permissible length is 15 

characters and only 

alphanumeric characters 

allowed. No special characters 

allowed except underscore '_'. 

SETUPINFO/ NAME 

attribute value would 

be prefixed to the 

schema name being 

created. 
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Tag Name/  
Attribute Name 

Description Mandatory 
(Y/N) 

Default Value/  
Permissible Value 

Comments 

schema names if 

required. 

Note: 

The Schema Name will 

have a prefix of the 

SETUPINFO/ NAME 

attribute. 

SCHEMA NAME must 

be same for all the 

ATOMIC Schemas of 

applications within an 

Application Pack. 

For example, if name 

is set as 'ofsaaatm' 

and setupinfo as 'uat' 

then schema being 

created would be 

'uat_ofsaaatm'. 

NAME should be 

same where 

APP_GRP=1 for all 

SCHEMA tags (Not 

applicable for this 

Application Pack). 

<SCHEMA>/ 

PASSWORD 

Enter the password of 

the schema to be 

created. 

Note: 

If this attribute is left 

blank, then the 

password specified in 

the 

<PASSWORD>/DEFA

UL 

T attribute is applied as 

the Schema Password. 

N The maximum length allowed is 

30 characters. Special 

characters are not allowed. 

Note: You need to 

mandatorily enter the 

password if you have 

set the 

<PASSWORD>/ 

APPLYSAMEFORALL 

attribute as N. 

<SCHEMA>/ APP_ID By default, the 

Application ID is 

seeded based on the 

Application Pack. 

Note: Do not edit this 

attribute value. 

Y Unique Seeded Value Identifies the 

Application/ Product 

for which the schema 

is being created. 

DO NOT modify this 

value. 

<SCHEMA>/ 

DEFAULTTABL 

ESPACE 

Enter the available 

default tablespace for 

DB User. 

Note: 

If this attribute is left 

blank, then USERS is 

N Default - USERS 

Permissible - Any existing valid 

tablespace name. 

Modify this value to 

associate any valid 

tablespace with the 

schema. 
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Tag Name/  
Attribute Name 

Description Mandatory 
(Y/N) 

Default Value/  
Permissible Value 

Comments 

set as the default 

tablespace. 

<SCHEMA>/ 

TEMPTABLESP ACE 

If this attribute is left 

blank, then TEMP is 

set as the default 

tablespace. 

N Default - TEMP 

Permissible - Any existing valid 

temporary tablespace name. 

Modify this value to 

associate any valid 

tablespace with the 

schema. 

<SCHEMA>/ QUOTA Enter the quota to be 

set on 

DEFAULTTABLESPAC

E attribute for the 

schema/ user. By 

default, the quota size 

is set to 500M. 

Minimum: 500M or 

Unlimited on default 

Tablespace 

N 
Example, 

600M/m 

20G/g 

UNLIMITE

D/unlimited 

Modify this value to 
grant the specified 
quota on the 
mentioned 
tablespace to the 
user. 

<SCHEMAS>/ 

TYPE=HDFS 

Type of schemas being 

created. 

Y  Refers to the 

DATADOM of the 

Application Pack 

being installed. 

<HIVE_ SERVER_ 

HOST> 

IP/HostName of the 

server where HIVE is 

installed 

Y  
 

<HIVE_LIB_ PATH> Folder path where 

HIVE related drivers/jar 

files are copied 

Y  Should contain the list 

of jars mentioned in 

the  section Copying 

Jars to OFSAA 

Installation Folder and 

krb5.conf, keytab files. 

Manually copy the 

preceding listed files 

from CDH distribution 

to this identified folder. 

<SCHEMA>/ NAME By default, the 

schemas names are 

seeded based on the 

Y The permissible length is 20 

characters and only 

alphanumeric characters 

Schema Name 
should not be the 
same as Schema 
Name specified for 
Schema Type 
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Tag Name/  
Attribute Name 

Description Mandatory 
(Y/N) 

Default Value/  
Permissible Value 

Comments 

Application Pack. 

You can edit the 

schema names if 

required. 

Note: The Schema 

Name will have a prefix 

of the SETUPINFO/ 

NAME attribute. 

allowed. 
ATOMIC. 

<SCHEMA>/ TYPE Identifies the type of 

schema where the data 

model entities would 

reside. 

Y By default, the TYPE attribute in 

this tag is set to DATADOM. 

DO NOT modify this 
value. 

<SCHEMA>/ DB TYPE Identifies the type of 

driver to be used for 

connection. 

Y By default, the only supported 

type is HIVE in this release. 

In the upcoming 
releases, the type 
value can be HIVE/ 
IMPALA etc. 

<SCHEMA>/<P 

ROPERTY>/CO 

MMENT 

COMMENTS for HIVE 

schema 

N  
 

<SCHEMA>/<P 

ROPERTY>/LO 

CATION 

You can optionally 

specify a location for 

the table data 

N  
 

<CONNECTIO 
N_ PROPERTIES>/ 

<PROPERTY>/J 

DBC_DRIVER 

HIVE JDBC driver 

details 

Y com.cloudera.hive.j 

dbc4.HS2Driver 

The default cloudera 
HiveServer 2 driver 
name. 

<CONNECTIO 
N_ PROPERTIES>/ 

<PROPERTY>/J 

DBC_URL 

Enter HIVE JDBC URL Y JDBC URL format :                

jdbc:hive2://<FQDN>:<port>/<d

b>;AuthMech=1;KrbServiceNam

e=<KrbServiceName>;KrbHostF

QDN=<FQDN>;KrbRealm=<Krb

Realm> 

Example:                             

jdbc:hive2://abc.in.oracle.com:1

0000/GLDATADOM;AuthMech=

1;KrbServiceName=hive;KrbHo

stFQDN=abc.in.oracle.com;Krb

<db> name should 
be same as Datadom 
name given in 
<SCHEMA>/ NAME 
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Tag Name/  
Attribute Name 

Description Mandatory 
(Y/N) 

Default Value/  
Permissible Value 

Comments 

Realm=ABC.ORACLE.COM 

<CONNECTIO 
N_ PROPERTIES>/ 

<PROPERTY>/ 

AUTH_TYPE 

Authentication Type Y Permissible values: 

KERBEROS_WITH_ KEYTAB 

Only “Kerberos with 
keytab” based 
authentication 
supported in this 
release. 

<CONNECTIO 
N_ PROPERTIES>/ 

<PROPERTY>/ 

AUTH_ALIAS 

Alias name for 

authentication 

credentials 

Y  
An Alias name 
mapping to a 
principal and 
password 
combination 
specified in the 
following tags. 

<CONNECTIO 
N_ PROPERTIES>/ 

<PROPERTY>/ 

PRINCIPAL 

Authentication principal 

name 

Y  
Principal name used 
in authentication to 
connect to the Hive 
Server. 

<CONNECTIO 
N_ PROPERTIES>/ 

<PROPERTY>/ 

PASSWORD 

Authentication 

password 

Y  
Password used in 
authentication to 
connect to the Hive 
Server. 

<CONNECTIO 
N_ PROPERTIES>/ 

<PROPERTY>/ 

KRB_GSSJAAS_ 

FILE_NAME 

A keytab file containing 

pairs of Kerberos 

principals and an 

encrypted copy of that 

principal's key. 

Y  
This file should be 
copied to the location 
specified in 

<HIVE_LIB_PATH> 

<CONNECTIO 
N_ PROPERTIES>/ 

<PROPERTY>/ 

KRB_REALM_ 

FILE_NAME 

REALM configuration 

file 

Y  
This file should be 
copied to the location 
specified in 

<HIVE_LIB_PATH> 
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22 Appendix M: OFSAAI_InstallConfig.xml file 

22.1 Configuring OFSAAI_InstallConfig.xml file 

Perform the following steps to configure OFSAAI_InstallConfig.xml file: 

1. Navigate to OFS_DM_PACK/OFS_AAI/conf/ directory. 

2. Open the file OFSAAI_InstallConfig.xml in text editor. 

3. Configure the OFSAAI_InstallConfig.xml as mentioned in the below table: 

4. You need to manually set the InteractionVariable parameter values as mentioned in the table. 

If a value is not applicable, enter NA and ensure that the value is not entered as NULL. 

Interaction Variable Name Significance and Expected Value Mandatory 

<Layer name="GENERAL"> 

InteractionGroup name="WebServerType" 

WEBAPPSERVERTYPE Identifies the web application server on which the OFSAA Infrastructure 
web components would be deployed. 

The below numeric value should be set depending on the type: 

Apache Tomcat = 1 

IBM WebSphere Application Server = 2 

Oracle WebLogic Server = 3 

For example,  <InteractionVariable 
name="WEBAPPSERVERTYPE">3</InteractionVari able> 

Yes 

InteractionGroup name="OFSAA Infrastructure Server Details" 

DBSERVER_IP Identifies the hostname or IP address of the system on which the 
Database Engine is hosted. 

Note: For RAC Database , the value should be NA. 

For example, <InteractionVariable name="DBSERVER_ 
IP">14.15.16.17</InteractionVariable> or 

<InteractionVariable name="DBSERVER_ 
IP">dbhost.server.com</InteractionVariable 

> 

Yes 

InteractionGroup name="Database Details" 
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Interaction Variable Name Significance and Expected Value Mandatory 

ORACLE_SID/SERVICE_ 

NAME 

Identifies the Oracle DB Instance SID or SERVICE_NAME 

Note: The Oracle_SID value should be exactly the same as it is 
mentioned in JDBC_URL. 

For example, <InteractionVariable name="ORACLE_SID/SERVICE_ 

NAME">ofsaser</InteractionVariable> 

Yes 

ABS_DRIVER_PATH 
Identifies the directory where the JDBC driver (ojdbc<version>.jar) 
exists. This would typically be the 

$ORACLE_HOME/jdbc/lib 

For example, <InteractionVariable name="ABS_DRIVER_ 
PATH">">/oradata6/revwb7/oracle 

</InteractionVariable> 

Note: Refer Appendix N for identifying the correct “ojdbc<version>.jar” version 

to be copied. 

 

Yes 

InteractionGroup name="OLAP Detail" 

OLAP_SERVER_ 

IMPLEMENTATION 

Identifies if the OFSAA Infrastructure OLAP component needs to be 
configured depending on whether you intend to use the OLAP feature. 
The below numeric value should be set depending on the choice: 

YES - 1 

NO – 0 

No 

Note: If value for OLAP_SERVER_IMPLEMENTATION is set to 1, it checks for following environment variables are set in .profile: 

ARBORPATH, HYPERION_HOME and ESSBASEPATH. 

InteractionGroup name="SFTP Details" 

SFTP_ENABLE Identifies if the SFTP (Secure File Transfer Protocol) feature is to be enabled. 
The following numeric value should be set depending on the choice: 

■  For SFTP, set this field to 1 or -1.  – 1 

■  For FTP, set this field to  - 0 

Yes 

Note: The default value for SFTP_ENABLE is 1, which signifies that SFTP will be used. Oracle recommends using SFTP instead 
of FTP because SFTP is considered more secure. However, a client may choose to ignore this recommendation and to use FTP 
by setting SFTP_ENABLE to 0. You can change this selection later by using the OFSAAI administration interface. 

Set SFTP_ENABLE to -1 to configure ftpshare and weblocal path as local path mounted for OFSAAI server. 
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Interaction Variable Name Significance and Expected Value Mandatory 

FILE_TRANSFER_PORT 
Identifies the port used for the file transfer service. The default value 
specified is 22 (SFTP). Specify default value as 21 (FTP) if 
SFTP_ENABLE is 0.  Alternatively, this value can be any Port 
configured by System Administrators to support SFTP/FTP. 

For example, <InteractionVariable name="FILE_TRANSFER_ 
PORT">21</InteractionVariable> 

Yes 

InteractionGroup name="Locale Detail" 

LOCALE 
Identifies the locale information to be used during the installation. This 
release of the OFSAA Infrastructure supports only US English. 

For example, <InteractionVariable 
name="LOCALE">en_US</InteractionVariable> 

Yes 

InteractionGroup name="OFSAA Infrastructure Communicating ports" 

Note: The below ports are used internally by the various OFSAA Infrastructure services. The default values mentioned below 
are set in the installation. If you intend to specify a different value, update the parameter value accordingly and ensure this port 
value is in the range of 1025  to 65535          and the respective port is enabled. 

JAVAPORT 9999 Yes 

NATIVEPORT 6666 Yes 

AGENTPORT 6510 Yes 

ICCPORT 6507 Yes 

ICCNATIVEPORT 6509 Yes 

OLAPPORT 10101 Yes 

MSGPORT 6501 Yes 

ROUTERPORT 6500 Yes 

AMPORT 6505 Yes 

InteractionGroup name="Web Details" 

Note: If value for HTTPS_ENABLE is set to 1, ensure you have a valid certificate available from a trusted CA and the same is 
configured on your web application server.  
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Interaction Variable Name Significance and Expected Value Mandatory 

HTTPS_ENABLE Identifies if the UI should be accessed using HTTP or HTTPS scheme. The 

default value set is 0. The below numeric value should be set depending on the 

choice: 

YES - 1 

NO - 0 

For example, <InteractionVariable 

name="HTTPS_ENABLE">0</InteractionVariable> 

 

Yes 

WEB_SERVER_IP 
Identifies the HTTP Server IP/ Hostname or Web Application Server IP/ 
Hostname, to be used for accessing the UI. This IP would typically be 
the HTTP Server IP. 

If no separate HTTP Server is available, the value should be Web 
Application Server IP/Hostname. 

For example, <InteractionVariable name="WEB_SERVER_ 

IP">10.11.12.13</InteractionVariable> 

or 

<InteractionVariable name="WEB_SERVER_ 

IP">myweb.server.com</InteractionVariable> 

No 

WEB_SERVER_PORT 
Identifies the Web Server Port. This would typically be 80 for non SSL 
and 443 for SSL. If no separate HTTP Server exists, the value should 
be the port configured for Web Server. 

Note: The port value will not be accepted as 80 if HTTPS_ENABLE is 1 
and as 443, if HTTPS_ENABLE is 0. 

For example, <InteractionVariable name="WEB_ 
SERVER_PORT">80</InteractionVariable> 

No 
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Interaction Variable Name Significance and Expected Value Mandatory 

CONTEXT_NAME Identifies the web application context name which will be used to built the URL 

to access the OFSAA applications. The context name can be identified from a 

URL as below: 

<scheme>://<host>:<port>/<context-name>/lo gin.jsp 

Sample URL: 

https://myweb:443/ofsaadev/login.jsp 

For example, <InteractionVariable name="CONTEXT_ 

NAME">ofsaadev</InteractionVariable> 

Yes 

WEBAPP_CONTEXT_PATH 
Identifies the absolute path of the exploded .ear file on the web 
application server. 

For Tomcat, specify the Tomcat directory path till 

/webapps, such as 

/oradata6/revwb7/tomcat/webapps/. 

For WebSphere, enter the WebSphere path as 

<WebSphere profile directory>/installedApps/ 

<NodeCellName>. For example, 

/data2/test//WebSphere/AppServer/profiles/ 

<Profile_ 

Name>/installedApps/aix-imfNode01Cell. Where aix-imf is Host name. 

For WebLogic, provide the WebLogic home directory path as 
/<WebLogic home directory path>/bea/wlserver_10.3 

Yes 

WEB_LOCAL_PATH 
Identifies the absolute path to any directory on the web application 
server that can hold temporary files being uploaded as part of the 
applications usage. 

Note: In case of a clustered deployment, ensure this path and directory 
is same on all the nodes. 

Yes 

InteractionGroup name="Weblogic Setup Details" 

WEBLOGIC_DOMAIN_HOME 
Identifies the WebLogic Domain Home. Specify the value only if 
WEBSERVERTYPE is set as 3 (WebLogic). 

For example, <InteractionVariable name="WEBLOGIC_DOMAIN_ 

HOME">/home/weblogic/bea/user_ projects/domains/mydomain 

</InteractionVariable> 

No 

InteractionGroup name="OFSAAI FTP Details" 
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Interaction Variable Name Significance and Expected Value Mandatory 

OFSAAI_FTPSHARE_PATH 
Identifies the absolute path to the directory identified as file system 
stage area. 

Note:  

The directory should exist on the same system on which the OFSAA 
Infrastructure is being installed (can be on a separate mount). 

The user mentioned in APP_SFTP_USER_ID parameter below should 
have RWX permission on the directory. 

For example, <InteractionVariable 
name="APP_FTPSHARE_PATH">">/oradata6/revwb7/ftpshare</Interac
tionVariable> 

Yes 

OFSAAI_SFTP_USER_ID 
Identifies the user who has RWX permissions on the directory identified 
under parameter APP_FTPSHARE_PATH above. 

Yes 

OFSAAI_SFTP_ 

PRIVATE_KEY 

Identifies the SFTP private key for OFSAAI. For example,  

<InteractionVariable name="OFSAAI_SFTP_PRIVATE_ 
KEY">/home/ofsaapp/.ssh/id_rsa</InteractionVariable> 

By default, the value is NA, which indicates password will be prompted 
for the user <OFSAAI_SFTP_USER_ ID> for authentication.  

For more information on generating SFTP Private key, see the Setting 
Up SFTP Private Key section. 

No 

OFSAAI_SFTP_ PASSPHRASE 
Identifies the passphrase for the SFTP private key for OFSAAI. For 
example,  

InteractionVariable name="OFSAAI_SFTP_PASSPHRASE">enter a 
pass phrase here</InteractionVariable> 

By default, the value is NA.  

If OFSAAI_SFTP_PRIVATE_KEY value is given and this is kept as NA, 
then it is assumed as empty passphrase. 

No 

InteractionGroup name="Hive Details"  

The default value set for the interaction variables under this group is set as NA. These are required only for Hive Configuration. 

HIVE_ SERVER_PORT 
Identifies the port used for the file transfer service. The default value set 
is 22 (SFTP). Set this value as 21 for FTP. 

For example,  

InteractionVariable name="HIVE_SERVER_ 
PORT">22</InteractionVariable> 

Yes, only for HIVE 
Configuration 

HIVE_SERVER_ FTPDRIVE 
Identifies the absolute path to the directory identified as file system 
stage area of HIVE server. 

For example,  

InteractionVariable name="HIVE_SERVER_ 
FTPDRIVE">/scratch/ofsaa/ftpshare</InteractionVariable> 

Yes, only for HIVE 
Configuration 
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Interaction Variable Name Significance and Expected Value Mandatory 

HIVE_SERVER_FTP_ USERID 
Identifies the user who has RWX permissions on the directory identified 
under the preceding parameter HIVE_SERVER_FTPDRIVE. 

For example,  

InteractionVariable name="HIVE_SERVER_FTP_ 
USERID">ofsaa</InteractionVariable> 

Yes, only for HIVE 
Configuration 

HIVE_SERVER_FTP_ 

PROTOCOL 

If the HIVE_SERVER_PORT is 21, then set value as FTP, else set it as 
SFTP. 

For example,  

InteractionVariable name="HIVE_SERVER_FTP_ 
PROTOCOL">SFTP</InteractionVariable> 

Yes, only for HIVE 
Configuration 

HIVE_SFTP_PRIVATE_ KEY 
Identifies the SFTP private key for the HIVE server. For example,  

<InteractionVariable name="HIVE_SFTP_PRIVATE_ 
KEY">/scratch/testuser/.ssh/id_rsa</InteractionVariable> 

By default, the value is NA, which indicates password will be prompted 
for the user <HIVE_SERVER_FTP_USERID> for authentication.  

For more information on generating SFTP Private key, see the Setting 
Up SFTP Private Key section. 

Yes, only for HIVE 
Configuration 

HIVE_SFTP_ PASSPHRASE 
Identifies the passphrase for the SFTP private key for HIVE. For 
example,  

<InteractionVariable name="HIVE_SFTP_ 
PASSPHRASE">NA</InteractionVariable> By default, the value is NA.  

If HIVE_SFTP_PRIVATE_KEY value is given and this is kept as NA, 
then it is assumed as empty passphrase. 

Yes, only for HIVE 
Configuration 
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23 Appendix N: Migration for Excel Upload 

This appendix provides detailed instructions to migrate for excel upload. 

23.1.1 Prerequisites 

• Data model in ATOMIC schemas should be same on the source and target setups. 

• OFS AAI (platform) patch level version should be same on the source and target setups. 

• PL/SQL Developer to connect and query the database. 

• WinSCP to connect and access server file system. 

23.1.2 Migration for Excel Upload 

To migrate, perform the following steps: 

1. Open PL/SQL Developer and log in to the source setup’s configuration (CONFIG) schema 

with assigned Username and Password. 

2. Query the data of table EXCEL_MAPPING_MASTER in a new SQL window. 

3. Open a new session in PL/SQL developer and log in to the target setup’s configuration 

(CONFIG) schema with assigned Username and Password.  

4. Insert the records from Step 1 to this table. 

5. Update the infodom name with the target infodom name in V_INFODOM column of 

EXCEL_MAPPING_MASTER table.  

NOTE:  If all the mappings can work out of the single target Infodom, update same Infodom value 

across all rows. If only few mappings work out of the target infodom, update the 

infodom value for selective records. Kindly note, excel upload mappings work only if the 

target infodom has same data model entities as used in the mappings defined on 

source setup. 

6. Update V_CREATED_BY column with the name of any user present in the target setup that 

has appropriate roles to perform Excel Upload tasks. 

NOTE:  It is mandatory to update values for V_INFODOM and V_CREATED_BY columns. 

7. Open WinSCP and login a new session by entering the host name, port number, user name 

and password to access the source setup.  

8. Navigate to FTPSHARE directory. 
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9. Copy the excel-entity mapping xml file(s) which are located in this directory according to their 

directory structure on to your desktop. For example: /ftpshare 

/STAGE/ExcelUpload/$SOURCE_INFODOM_NAME/$EXCEL_FILE_NAME.xml 

NOTE:  Actual file name of Excel Sheet is mentioned in the V_EXCEL_NAME column of 

EXCEL_MAPPING_MASTER table. 

10. Copy the excel templates (.xls/ .xlsx) file(s) which are located in this directory according to 

their directory structure on to your desktop. For example: 

/ftpshare/STAGE/ExcelUpload/TEMPLATE/*.xls or *.xlsx 

NOTE:  Ignore this step if files are not present at the location. 

11. Log in to a new session in WinSCP with the host name, port number, user name and 

password to access the target setup.  

12. Copy  the xml file(s) from Step3 to the below location in the target setup. For example: 

/ftpshare/STAGE/ExcelUpload/$TARGET_INFODOM_NAME/$EXCEL_FILE_NAME.xml 

NOTE:  $TARGET_INFODOM_NAME should be target setup infodom in which you have uploaded the 

appropriate data model and the name should be same as the V_INFODOM column 

value updated in EXCEL_MAPPING_MASTER table. 

13. Copy the xls/ xlsx file(s) from Step 3 to the below location in target setup. For example: 

/ftpshare/STAGE/ExcelUpload/TEMPLATE/*.xls or *.xlsx 

NOTE:  Ignore this step if files are not present at the location. 
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24 Appendix O: JDBC Jar Files 

The ojdbc<version>.jar file should be copied based on Database & Java version. Refer to 

the following table for details.  

Oracle Database 
Version 

JDK Version Supported JDBC Jar files specific to 
the release 

12.1 or 12cR1 JDK 7 and JDK 8 ojdbc7.jar for JDK 7/JDK 8 

11.2 or 11gR2 JDK 7 and JDK 8 supported in 11.2.0.3 and 
11.2.0.4 

ojdbc6.jar for JDK 7 / JDK 8 
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25 Appendix P: Upgrading an Existing OFSAA 8.0.x Java 7 Instance 

to Java 8 

This section explains the configurations required to upgrade an existing OFSAA 8.0.x Java 7 

instance to Java 8. It consists of the following topics: 

• Prerequisites 

• Steps for upgrading OFSAA 8.0.x Java 7 instance to Java 8 

• Web Application Server Configurations 

• OFSAA Generic Configurations 

• OFSAA Configurations for New Web Application Server Installation 

25.1 Prerequisites 

The following are the prerequisites for upgrading OFSAA 8.0.x Java 7 instance to Java 8: 

• Java 8 should be installed on the OFSAA server and Web Application Server. 

NOTE:  IBM WebSphere 8.6.x (Full Profile) on Java 8 is not available. 

25.2 Steps for upgrading OFSAA 8.0.x Java 7 instance to Java 8 

To upgrade OFSAA 8.0.x Java 7 instance to Java 8, perform the following steps: 

1. Configure Web Application Server to Java 8. For more information, see Web Application 

Server Configurations. 

2. Configure the OFSAA instance to Java 8. For more information, see OFSAA Generic 

Configurations. For a newly installed Web Application Server, see OFSAA Configurations for 

New Web Application Server Installation 

3. Restart the OFSAA services. For more information, see the Start/Stop Infrastructure Services 

section in Appendix D 

4. Generate the application EAR/WAR file and redeploy the application onto your configured 

web application server. For more information on generating and deploying EAR / WAR file, 

see Appendix C. 

25.3 Web Application Server Configurations 

This section describes the changes to be made in the Web Application Server. Following are the 

two options to perform Web Application Server Configurations which are listed as follows: 

• Upgrade the existing Web Application Server installation to Java 8 

• Install a new instance of the Web Application Server with Java 8 

This section consists of the following topics: 

• Oracle WebLogic Server Updates 
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• Apache Tomcat Server Updates 

25.3.1 Oracle WebLogic Server Updates 

Perform the following configurations to upgrade the existing WebLogic server instance to Java 8: 

1. Navigate to <WLS_HOME>/Middleware/Oracle_Home/wlserver. 

2. Edit the product.properties file. Set JAVA_HOME, WLS_JAVA_HOME, JAVAHOME 

properties to the new Java path and java.vm.version to the new Java version. For 

example, 

JAVA_HOME=/usr/java/jdk1.8.0_45 

WLS_JAVA_HOME=/usr/java/jdk1.8.0_45 

JAVAHOME=/usr/java/jdk1.8.0_45 

java.vm.version=1.8.0_45 

3. Navigate to 

<WLS_HOME>/Middleware/Oracle_Home/user_projects/domains/<domain>/bin. 

Update SUN_JAVA_HOME, DEFAULT_JAVA_HOME, JAVA_HOME in the setDomainEnv.sh 

file to point to the new Java path. For example, 

SUN_JAVA_HOME="/usr/java/jdk1.8.0_45" 

DEFAULT_SUN_JAVA_HOME="/usr/java/jdk1.8.0_45" 

JAVA_HOME="/usr/java/jdk1.8.0_45" 

4. Clear the Application cache. Navigate to the following path and delete the files: 

<Weblogic installation location>/domains/<Domain 

name>/servers/<Server name>/tmp/_WL_user/<Application 

name>/qaelce/jsp_servlet 

If you wish to install a new instance of the Oracle WebLogic Server, perform the following steps: 

1. Install Oracle WebLogic Server 12.1.3.x on Java 8. 

2. Perform the configurations for the newly installed WebLogic server. For more information see 

Configuring Resource Reference in Weblogic Application Server. 

NOTE:  While creating WebLogic Domain, the Listen Port should be set same as that of the existing 

Domain. Note down the new Domain path to perform OFSAA Configurations. 

25.3.2 Apache Tomcat Server Updates 

Perform the following configurations to upgrade the existing Apache Tomcat Server from Java 7 

to Java 8: 

1. Login to the Apache Tomcat Server as a non-root user. 

2. Edit the user .profile. Update the value for JAVA_HOME from JRE 1.7 to JRE 1.8. For 

Example,x 

JAVA_HOME=/usr/java/jre1.8.0_45 
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3. Clear the Application cache. Navigate to the following path and delete the files: 

<Tomcat installation directory>/work/Catalina/localhost/<Application 

name>/org/apache/jsp 

If you wish to install a new instance of the Apache Tomcat Server, perform the following steps: 

1. Install Apache Tomcat Server 8 with Java 8. 

2. Perform the configurations for the newly installed Tomcat server. For more information see 

Configuring Resource Reference in Tomcat Application Server. 

NOTE:  Update the Connector Port in /apache-tomcat-8.0.21/conf/server.xml file to that of 

the existing Tomcat instance. 

Note down the new deployment path to perform OFSAA Configurations. 

25.4 OFSAA Generic Configurations 

This section consists of the following topics: 

• User .profile Settings 

25.4.1 User .profile Settings 

Perform the following configurations: 

1. Login to the OFSAA Server as a non-root user. 

2. Edit the user .profile. Update the value for PATH variable from JRE 1.7 to JRE 1.8. For 

Example: 

PATH=/usr/java/jdk1.8.0_45/jre 

JAVA_BIN=/usr/java/jdk1.8.0_45/jre/bin 

LD_LIBRARY_PATH=$LD_LIBRARY_PATH:/usr/java/jdk1.8.0_45/jre/lib/amd64

/server 

25.5 OFSAA Configurations for New Web Application Server Installation 

This configuration is required only if you have freshly installed Oracle WebLogic 12.1.3 or Apache 

Tomcat Server 8.0. Perform the following steps: 

1. Modify the following parameters in the Configuration table present in the Config Schema with 

the new Domain Path in case of WebLogic or with the new deployment path in case of 

Tomcat: 

• DeFiHome 

• REV_IMG_PATH 

• EMBEDDED_JSP_JS_PATH 

2. Login to the OFSAA Server as a non-root user. 
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3. Navigate to $FIC_HOME/ficweb/webroot/WEB_INF and update the following parameters 

in the web.xml file with the new Domain path in case of WebLogic or with the new 

deployment path in case of Tomcat: 

• FIC_PHYSICAL_HOME_LOC 

• FIC_HOME 

• ICC_SERVLET_LOG_FILE 

4. Navigate to $FIC_HOME/ficweb/webroot/conf and update the Domain path in case of 

WebLogic or with the new deployment path in case of Tomcat: 

• OFSAALogger.xml 

• MDBLogger.xml 

• RevLog4jConfig.xml 

• RFDLogger.xml 

• ExportLog4jConfig.xml 

• RFDLogger.xml 

• PR2Logger.xml 
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26 Appendix Q: Removing OFSAA 

This appendix includes the following sections: 

• Uninstalling OFSAA Infrastructure 

• Uninstalling EAR Files in WebSphere 

• Uninstalling EAR Files in WebLogic 

• Uninstalling WAR Files in Tomcat 

26.1 Uninstalling OFSAA Infrastructure 

This section guides you through the necessary steps to uninstall the OFSAA Infrastructure 

product. Before you start the uninstallation process, ensure that no open connections exist to the 

OFSAA Infrastructure Config and Atomic Schemas and Infrastructure services are brought down. 

To uninstall OFSAA Infrastructure: 

1. Log in to the system as non-root user. 

2. Navigate to the $FIC_HOME directory and execute the command: 

./Uninstall.sh 

3. Enter the password for OFSAAI Configuration Schema when prompted as shown in the 

following figure. 

 

NOTE:  Uninstallation does not remove the Infrastructure application from the Web Application Server. 

This has to be done manually. The entries in the .profile file must be removed 

manually. The files/ directories under the file system staging area (ftpshare) have to be 

deleted manually. All the Database objects from Atomic Schemas have to be dropped 

manually. 
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26.2 Uninstalling EAR Files in WebSphere 

Following are the steps to uninstall any previously deployed application: 

1. Open the URL in the browser window: http://<ipaddress>:<Administrative 

Console Port>/ibm/console (https, if SSL is enabled). The Login window is displayed. 

2. Login with the user ID that has admin rights. 

3. Expand Applications → Application Types → WebSphere Enterprise Applications from 

the LHS. The Enterprise Applications window is displayed with all the deployed applications. 

 

4. Select the checkbox adjacent to the application to be uninstalled and click Stop. 

5. Click Uninstall. The Uninstall Application window is displayed. 

 

6. Click OK to confirm. 

7. Click Save to save the master file configuration. 
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26.3 Uninstalling EAR Files in WebLogic 

On the machine that hosts WebLogic, perform the following steps to uninstall any previously 

deployed application: 

1. Open the URL in the browser window: http://<ipaddress>:<admin server 

port>/console (https, if SSL is enabled). The Login window of the WebLogic Server 

Administration Console is displayed. 

2. Login with the WebLogic user credentials having administrator privileges. 

3. From the Domain Structure LHS menu, click Deployments. The Summary of Deployments 

screen is displayed. 

 

4. Select the checkbox adjacent to the application to be uninstalled and click  

Stop → Force Stop Now. 

5. Click Yes in the confirmation dialog to stop the selected deployment. 

 



OFSDM 8.0.6.0.0 Installation Guide 

Oracle Financial Services Software 

 

 

268 

 

6. Select the checkbox adjacent to the application and click Delete to delete the selected 

deployment. 

7. Click Yes in the confirmation dialog to remove the selected deployment from the domain 

configuration. 

26.4 Uninstalling WAR Files in Tomcat 

On the machine that hosts Tomcat, perform the following steps to uninstall any previously 

deployed application: 

1. Comment out Context path section from server.xml file in $CATALINA_HOME/conf 

directory to avoid conflict during undeploy and re-deploy of the WAR file. 

Place comment <!-- --> in between the context path section. For 

example: 

<!-- 

<Context path ="/pr2test" docBase="/home/perfuser/tomcat-

7.0.19/webapps/pr2test" debug="0" reloadable="true" 

crossContext="true"> 

<Resource auth="Container" 

name="jdbc/PR2ATM" 

type="javax.sql.DataSource" 

driverClassName="oracle.jdbc.driver.OracleDriver" 

username="pr2atm" 

password="pr2atm" 

url="jdbc:oracle:thin:@10.184.74.99:1521:PERFTEST" 

maxActive="100" 

maxIdle="30" 

maxWait="10000"/> 

</Context> 

--> 

Restart the Tomcat service by doing the following: 

a. Login to the "Unix server" through a terminal emulator. 

b. Navigate to $catalina_home/bin directory. 

c. Stop the tomcat services using the./shutdown.sh command. 

d. Start the tomcat services using the./startup.sh command. 

2. Open the URL in a browser window: http://<IP address>:<Tomcat server port> 

(https, if SSL is enabled). The Tomcat Home window is displayed. 

3. Click Manager App. The Connect To window is displayed. 
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4. Login with the user credentials having admin rights. The Tomcat Web Application Manager 

window is displayed with the list of all applications deployed in Tomcat. 

 

5. Click the Undeploy link against the deployed Infrastructure application. A confirmation 

message is displayed on the application /Infrastructure being uninstalled. 
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27 Appendix R: Configuring Transparent Data Encryption (TDE) and, 

Data Redaction in OFSAA 

Two features comprise Oracle Advanced Security: Transparent Data Encryption and Oracle Data 

Redaction. 

This section details about the configurations required in case you want to enable TDE or Data 

Redaction in OFSAA applications. 

27.1 Transparent Data Encryption (TDE)  

Transparent Data Encryption (TDE) enables you to encrypt sensitive data, such as Personally 

Identifiable Information (PII), that you store in tables and tablespaces. After the data is encrypted, 

this data is transparently decrypted for authorized users or applications when they access this 

data. To prevent unauthorized decryption, TDE stores the encryption keys in a security module 

external to the database, called a Keystore. For more details on TDE, see the Database 

Advanced Security Guide.  

TDE tablespace encryption enables you to encrypt all of the data stored in a tablespace. To 

control the encryption, you use a Keystore and TDE master encryption key. Oracle Database 

supports both software keystores and hardware, or HSM-based, keystores. A software keystore 

is a container for the TDE master encryption key, and it resides in the software file system.   

27.1.1 Configuring TDE During OFS DM Installation Using Full Installer   

This section provides information on how to help enable TDE (Transparent Data Encryption) in 

the database. , Data Redaction and its corresponding settings in OFSAA. This section consists of 

the following sub sections: 

• Configuring Software Keystore and Encrypted Tablespace Creation 

• Running the Schema Creator Utility 

• Testing the Encryption 

27.1.1.1 Configuring a Software Keystore and Encrypted Tablespace Creation 

A software keystore is a container for the TDE master encryption key, and it resides in the 

software file system. You must define a location for the key in the sqlnet.ora file so that the 

database locates the keystore (one per database) by checking the keystore location in the 

sqlnet.ora file. After defining the location, create the keystore and open it. Set the TDE master 

key after opening it and then encrypt the data.  

To find whether a wallet is already existing, check the following entries: 

1. The location specified by the ENCRYPTION_WALLET_LOCATION parameter in the 

sqlnet.ora file. 
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2. The location specified by the WALLET_LOCATION parameter in the sqlnet.ora file. 

Encrypted tablespaces can share the default database wallet. However, Oracle recommends that 

you use a separate wallet for transparent data encryption functionality by specifying the 

ENCRYPTION_WALLET_LOCATION parameter in the sqlnet.ora file. 

NOTE: You should have proper privileges to perform the following actions.  

For details to configure the software keystore, perform the following steps:  

Step 1: Set the Software keystore location in the sqlnet.ora file 

The first step is to designate a location for software keystore in the sqlnet.ora file. The Oracle 

Database will check the sqlnet.ora file for the directory location of the keystore to determine 

whether it is a software keystore or a hardware module security (HSM) keystore. 

NOTE: Ensure that the directory location which you want to set for software keystore exists 

beforehand. Preferably, this directory should be empty. 

In a multitenant environment, the keystore location is set for the entire multitenant container 

database (CDB), not for individual pluggable databases (PDBs). 

By default, the sqlnet.ora file is located in the ORACLE_HOME/network/admin directory or in 

the location set by the TNS_ADMIN environment variable. Ensure that you have properly set the 

TNS_ADMIN environment variable to point to the correct sqlnet.ora file. 

To create a software keystore on a regular file system, use the following format when you edit the 

sqlnet.ora file: 

ENCRYPTION_WALLET_LOCATION= 

  (SOURCE= 

    (METHOD=FILE) 

    (METHOD_DATA= 

    (DIRECTORY=<<path to keystore>>))) 

Examples: 

For regular file system in which the database name is orclb: 

ENCRYPTION_WALLET_LOCATION= 

  (SOURCE= 

   (METHOD=FILE) 

    (METHOD_DATA= 

     (DIRECTORY=/etc/ORACLE/WALLETS/orcl))) 

When multiple databases share the sqlnet.ora file: 
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ENCRYPTION_WALLET_LOCATION= 

  (SOURCE= 

   (METHOD=FILE) 

    (METHOD_DATA= 

     (DIRECTORY=/etc/ORACLE/WALLETS/orcl))) 

When Oracle Automatic Storage Management (ASM) is configured:   

ENCRYPTION_WALLET_LOCATION= 

 (SOURCE= 

  (METHOD=FILE) 

   (METHOD_DATA= 

    (DIRECTORY=+disk1/mydb/wallet))) 

For ASM Diskgroup: 

ENCRYPTION_WALLET_LOCATION= 

 (SOURCE= 

  (METHOD=FILE) 

   (METHOD_DATA= 

    (DIRECTORY=+ASM_file_path_of_the_diskgroup))) 

Step 2: Create the Software Keystore 

There are three different types of Software Keystores: 

• Password-based Software Keystores 

• Auto-login Software Keystores 

• Local Auto-login Software Keystores 

Perform the following steps to create a software keystore: 

1. Login as sysdba or user with ADMINISTER KEY  MANAGEMENT or SYSKM privilege. 

2. Use the following command to create password-based software keystore: 

CONN sys/password@serviceid AS SYSDBA 

ADMINISTER KEY MANAGEMENT CREATE KEYSTORE 'keystore_location' 

IDENTIFIED BY software_keystore_password; 

• keystore_location is the path of the keystore directory you 

want to create 
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• software_keystore_password is the password of the keystore 

that you want to create. 

For example, to create the keystore in the /etc/ORACLE/WALLETS/orcl directory: 

ADMINISTER KEY MANAGEMENT CREATE KEYSTORE '/etc/ORACLE/WALLETS/orcl' 

IDENTIFIED BY password; 

After you run this statement, the ewallet.p12 file, which is the keystore, appears in the keystore 

location. 

• Alternatively, you can create an Auto-Login or Local-Login Keystore to avoid opening the 

Keystore manually every time. Use the following command: 

ADMINISTER KEY MANAGEMENT CREATE [LOCAL] AUTO_LOGIN KEYSTORE FROM 

KEYSTORE 'keystore_location' IDENTIFIED BY keystore_password; 

• LOCAL enables you to create a local auto-login software keystore. Otherwise, omit this 

clause if you want the keystore to be accessible by other computers. 

After you run this statement, the cwallet.sso file appears in the keystore location. 

NOTE: It is important to remember the master key password (<keystore_password>) used during 

creation of the keystore. There are no ways to retrieve the password if forgotten. 

Step 3: Open the Software Keystore 

Depending on the type of keystore you create, you must manually open the keystore before you 

can use it. 

You do not need to manually open auto-login or local auto-login software keystores. These 

keystore are automatically opened when it is required, that is, when an encryption operation must 

access the key. If necessary, you can explicitly close any of these types of keystores. You can 

check the status of whether a keystore is open, closed, open but with no master key, or open but 

with an unknown master key by querying the STATUS column of the V$ENCRYPTION_WALLET 

view. 

NOTE: After you open a keystore, it remains open until you manually close it. Each time you 

restart a database instance, you must manually open the password keystore to re-enable 

encryption and decryption operations. 

Perform the following steps to open the software wallet: 

1. Login as sysdba or user with ADMINISTER KEY  MANAGEMENT or SYSKM privilege. 

2. Use the following command to open password-based software keystore: 

CONN sys/password@serviceid AS SYSDBA 

ADMINISTER KEY MANAGEMENT SET KEYSTORE OPEN IDENTIFIED BY 

software_keystore_password [CONTAINER = ALL | CURRENT]; 
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• software_keystore_password is the same password that you used to create the 

keystore in "Step 2: Create the Software Keystore". 

• CONTAINER is for use in a multitenant environment. Enter ALL to set the keystore in all of 

the PDBs in this CDB, or CURRENT for the current PDB. 

NOTE: In a CDB, open the Keystore in the ROOT (CDB$ROOT) container and in all the 

associated PDBs, where TDE is enabled.  

You do not need to manually open auto-login or local auto-login software Keystores. 

Step 4: Set the Software TDE Master Encryption Key 

Once the keystore is open, you can set a TDE master encryption key for it. The TDE master 

encryption key is stored in the keystore. This key protects the TDE table keys and tablespace 

encryption keys. By default, the TDE master encryption key is a key that Transparent Data 

Encryption (TDE) generates. 

In a multitenant environment, you can create and manage the TDE master encryption key from 

either the root or the PDB. 

Ensure that the database OPEN_MODE is set as READ WRITE. To find the status for a non-

multitenant environment, query the OPEN_MODE column of the V$DATABASE dynamic view. If 

you are using a multitenant environment, then query the V$PDBS view. (If you cannot access 

these views, then connect as SYSDBA and try the query again. In order to connect as SYSKM for 

this type of query, you must create a password file for it. See Oracle Database Administrator's 

Guide for more information.) 

Perform the following steps to set the encryption key: 

1. Login as sysdba or user with ADMINISTER KEY  MANAGEMENT or SYSKM privilege. 

2. Use the following command to set the encryption key: 

CONN sys/password@serviceid AS SYSDBA 

ADMINISTER KEY MANAGEMENT SET KEY [USING TAG 'tag'] IDENTIFIED BY 

password [WITH BACKUP [USING 'backup_identifier']] [CONTAINER = ALL 

| CURRENT]; 

• tag is the associated attributes and information that you define. Enclose this setting in 

single quotation marks (' '). 

• password is the mandatory keystore password that you created when you created the 

keystore in "Step 2: Create the Software Keystore". 

• WITH BACKUP creates a backup of the keystore. You must use this option for password-

based keystores. Optionally, you can use the USING clause to add a brief description of 

the backup. Enclose this description in single quotation marks (' '). This identifier is 

appended to the named keystore file (for example, 
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ewallet_time_stamp_emp_key_backup.p12, with emp_key_backup being the backup 

identifier). Follow the file naming conventions that your operating system uses. 

• CONTAINER is for use in a multitenant environment. Enter ALL to set the key in all of the 

PDBs in this CDB, or CURRENT for the current PDB. 

For example, 

ADMINISTER KEY MANAGEMENT SET KEY IDENTIFIED BY password WITH BACKUP 

USING 'emp_key_backup'; 

Step 5: Encrypting your Data 

After completing the keystore configuration, encrypt the data. You can encrypt individual columns 

in a table or entire tablespaces. OFSAA recommends encrypting entire tablespaces and the 

description in this section covers encrypting entire tablespaces. 

Note the following restrictions on using Transparent Data Encryption when you encrypt a 

tablespace: 

• Transparent Data Encryption (TDE) tablespace encryption encrypts or decrypts data during 

read and write operations, as compared to TDE column encryption, which encrypts and 

decrypts data at the SQL layer. This means that most restrictions that apply to TDE column 

encryption, such as data type restrictions and index type restrictions, do not apply to TDE 

tablespace encryption. 

• To perform import and export operations, use Oracle Data Pump. 

Encrypting data involves the following steps: 

Step 1: Setting the COMPATIBLE initialization parameter for tablespace encryption 

Step 2: Setting the tablespace TDE master encryption key 

Step 3: Creating the Encrypted Tablespace 

Step 1: Setting the COMPATIBLE initialization parameter for tablespace encryption 

Prerequisite- You must set the COMPATIBLE initialization parameter for the database to 11.2.0.0 

or later.  Once you set this parameter to 11.2.0.0, the change is irreversible. 

Perform the following steps to set the COMPATIBLE initialization parameter: 

1. Log into the database instance. In a multitenant environment, log into the PDB.  

2. Check the current setting of the COMPATIBLE parameter. 
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For example: 

SHOW PARAMETER COMPATIBLE 

 NAME                                 TYPE        VALUE 

------------------------------------ ----------- ------- 

compatible                          string      12.0.0.0 

noncdbcompatible                    BOOLEAN     FALSE 

3. If you want to change the COMPATIBLE parameter, perform the following steps: 

a. Locate the initialization parameter file for the database instance. 

• UNIX systems: This file is in the ORACLE_HOME/dbs directory and is named 

initORACLE_SID.ora (for example, initmydb.ora). 

b. In SQL*Plus, connect as a user who has the SYSDBA administrative privilege, and then 

shut down the database. 

For example: 

CONNECT /AS SYSDBA 

SHUTDOWN 

c. Edit the initialization parameter file to use the correct COMPATIBLE setting. 

For example: 

COMPATIBLE = 12.2.0.0 

d. In SQL*Plus, ensure that you are connected as a user who has the SYSDBA 

administrative privilege, and then start the database. 

For example: 

CONNECT /AS SYSDBA 

STARTUP 

e. If tablespace encryption is in use, then open the keystore at the database mount. The 

keystore must be open before you can access data in an encrypted tablespace. 

STARTUP MOUNT; 

ADMINISTER KEY MANAGEMENT SET KEYSTORE OPEN IDENTIFIED BY 

password; 

ALTER DATABASE OPEN; 
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Step 2: Setting the tablespace TDE master encryption key 

Make sure that you have configured the TDE master encryption key as shown in Step 4: Setting 

the software TDE master encryption key. 

Step 3: Creating the Encrypted Tablespace 

After you have set the COMPATIBLE initialization parameter, you are ready to create the 

encrypted tablespace.  

Follow the instruction given in Running the Schema Creator Utility with Encryption section for 

configuring the schema creator file to create tablespaces.  

If you are enabling TDE in case of upgrade or you did not enable it during installation and want to 

enable at a later point of time, see the following reference link for details on manually creating 

encrypted tablespaces: 

https://docs.oracle.com/cloud/latest/db121/ASOAG/asotrans_config.htm#ASOAG9555 

27.1.1.2 Running the Schema Creator Utility with Encryption 

This section is applicable only if you want to enable TDE during installation. 

Run the schema creator utility by including the encrypt=on option in the Tablespace tag in the 

DM_SCHEMA_IN.xml Schema in xml file. You have to perform this procedure manually as it is’s 

not a part of the schema DM_SCHEMA_IN.xml.TEMPLATE template originally. 

Following is an example for OFS _AAAI_PACK_ SCHEMA_IN.xml  

<APPPACKSCHEMA> 

<APP_PACK_ID>OFS_AAAI_PACK</APP_PACK_ID> 

<JDBC_URL>jdbc:oracle:thin:@whf00ajn<DB_Server_IP>:1521:OFSPQA12CDB<DB_

NAME></JDBC_URL> 

<JDBC_DRIVER>oracle.jdbc.driver.OracleDriver</JDBC_DRIVER> 

<HOST>ofss220608<OFSAA_Server_IP/HOST Name></HOST> 

<SETUPINFO NAME="t608<PREFIX_NAME>" PREFIX_SCHEMA_NAME="Y"/> 

<PASSWORD APPLYSAMEFORALL="Y" DEFAULT="password123<PASSWORD>"/>  

<TABLESPACES> 

<TABLESPACE NAME="OFS_AAI_TBSP" VALUE="TS_USERS1" 

DATAFILE="/scratch/ora12c/app/oracle/oradata/OFSPQA12CDB<ABSOLUTE PATH 

to TABLESPACE>/ts_users1<TABLESPACE_DATA_FILE_NAME>.dbf" SIZE="500M" 

AUTOEXTEND="OFF" ENCRYPT="ON" /> 

</TABLESPACES> 

https://docs.oracle.com/cloud/latest/db121/ASOAG/asotrans_config.htm#ASOAG9555
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<SCHEMAS> 

<SCHEMA TYPE="CONFIG" NAME="ofsaaconf" PASSWORD="" APP_ID="OFS_AAI" 

DEFAULTTABLESPACE="TS_USERS1##OFS_AAI_TBSP##" TEMPTABLESPACE="TEMP" 

QUOTA="unlimited"/> 

<SCHEMA TYPE="ATOMIC" NAME="ofsaaatm" PASSWORD="" APP_ID="OFS_AAAI" 

DEFAULTTABLESPACE="##OFS_AAI_TBSP##TS_USERS1" TEMPTABLESPACE="TEMP" 

QUOTA="unlimited" INFODOM="OFSAAAIINFO"/> 

<SCHEMA TYPE="ATOMIC" NAME="ofsaaatm" PASSWORD="" APP_ID="OFS_IPE" 

DEFAULTTABLESPACE="##OFS_AAI_TBSP##TS_USERS1" TEMPTABLESPACE="TEMP" 

QUOTA="unlimited" INFODOM="OFSAAAIINFO"/> 

</SCHEMAS> 

</APPPACKSCHEMA> 

27.1.1.3 Testing the Encryption 

Test the encryption by checking if a tablespace is encrypted or not. Execute the following query to 

check: 

SELECT tablespace_name, encrypted FROM dba_tablespaces; 

The following result is displayed, which indicates whether the TABLESPACE is encrypted 

(ENCRYPTED TS  - YES) or not (ENCRYPTED TS  - NO)  in the ENCRYPTED column: 

TABLESPACE_NAME             ENCRYPTED 

------------------------------ --- 

SYSTEM                     NO 

SYSAUX                        NO 

UNDOTBS1                     NO 

TEMP                         NO 

USERS                         NO 

ENCRYPTED_TS                  YES 

6 rows selected. 

The above example indicates TABLESPACE  ENCRYPTED_TS is created with Encryption ON. 

27.1.2 Configuring TDE in case of Upgrade  

This section details about the configurations required in case you want to enable TDE in OFSAA 

applications after upgrade to OFSAA 8.0.6.0.0 version from a previous version. Additionally, 
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these configurations are required in case you did not enable TDE during 8.0.6.0.0 installation and 

want to enable at a later point of time.  

1. Create a new PDB (12c)/ instance (11g) on same or different Database Server for TDE. For 

more information, see Configuring Software Keystore and Encrypted Tablespace Creation.  

2. Shutdown the OFSAAI Services. 

3. Export all Configuration, Atomic and Sandbox Schemas as per the applications installed in 

your OFSAA instance. 

For example: 

expdp SYSTEM/oracle@OFSA12C2DB  DIRECTORY=data_pump_dir 

DUMPFILE=ofsaaconf_ofsaaatm_%U.dmp filesize=2G 

SCHEMAS=ofsaaconf,ofsaaatm LOGFILE=ofsaaconf_ofsaaatm_exp.log 

NOTE: The above command will create data dumps as files of 2GB size each (multiples). Any 

other commands/ tools as appropriate may be used to archive the schemas. 

4. Import all schemas that are exported using the above command, into the new DB instance. 

For example:  

impdp SYSTEM/oracle@OFSA12nDB  DIRECTORY=data_pump_dir 

DUMPFILE=ofsaaconf_ofsaaatm_%U.dmp  SCHEMAS=ofsaaconf,ofsaaatm 

LOGFILE=ofsaaconf_ofsaaatm_imp.log 

NOTE: Restoring the exported dumps creates Configuration and Atomic Schema(s) with the 

same user credentials as that of the source, along with the existing grants.  

NOTE: If schemas are restored using a tool/ mechanism other than as mentioned in the Step 1 

and 2, retain the user credentials of Configuration and Atomic Schemas same as in the Source 

environment, along with the Schema grants. 

5. Provide select grants on sys.V_$parameter to view Configuration and Atomic Schemas of 

Target Environment database 

For example: 

Login as sys user: 

SQL> GRANT SELECT ON SYS.V_$PARAMETER TO ofsaaconf; 

Grant succeeded 

SQL> GRANT SELECT ON SYS.V_$PARAMETER TO ofsaaatm; 

Grant succeeded 

6. Update .profile for ORACLE_SID environment variable with new ORACLE_SID. 
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7. Update JDBC URL by executing Port Changer utility. For details on how to execute Port 

Changer utility, see Changing IP/ Hostname, Ports, Deployed paths, Protocol of the OFSAA 

Instance section under Generic Configurations chapter in OFS Analytical Applications 

Infrastructure Administration Guide 8.0.6.0.0. 

8. Navigate to the $FIC_WEB_HOME directory and execute the following command to trigger the 

creation of EAR/WAR file: 

./ant.sh 

9. The EAR/WAR file - <contextname>.ear/.war - is created in $FIC_WEB_HOME directory. 

10. On completion of EAR/WAR file creation, the message "BUILD SUCCESSFUL" will be 

displayed. 

11. Edit the existing Connection Pool settings to point to new JDBC URL and verify connections. 

12. Clear the webserver cache and redeploy the application onto your configured web application 

server. 

13. Restart the OFSAA Services. For more information, refer to the Start/Stop Infrastructure 

Services section in the Oracle Financial Services Advanced Analytical Applications 

Infrastructure Application Pack Installation and Configuration Guide 8.0.2.0.0 

27.2 Data Redaction 

OFSAA is enhanced to enable masking of sensitive data and Personal Identification Information (PII) to 

adhere to Regulations and Privacy Policies. Oracle Data Redaction provides selective, on-the-fly 

redaction of sensitive data in database query results prior to display by applications so that unauthorized 

users cannot view the sensitive data. The stored data remains unaltered, while displayed data is 

transformed to a pattern that does not contain any identifiable information. 

27.2.1 Enabling Data Redaction in case of Upgrade 

This section details about the configurations required in case you want to enable Data Redaction in 

OFSAA applications after upgrade to OFSAA 8.0.6.0.0 version from a previous version. Additionally, 

these configurations are required in case you did not enable TDE during OFS DM 8.0.6.0.0 installation 

and want to enable at a later point of time. 

Perform the following steps: 

1. Login as SYSDBA into the database. 

2. Execute the file 

$FIC_HOME/utility/data_security/scripts/create_data_sec_roles.sql only 

once per database (PDB in case of 12c). 

3. Execute the following sql statement to find out the list of atomic users from the table: 

select v_schema_name from aai_db_detail where V_DB_NAME <> 'CONFIG' AND 

V_DB_TYPE = 'ORACLE' 

https://docs.oracle.com/cd/E60058_01/PDF/8.0.6.x/8.0.6.0.0/OFSAAI_Administration_Guide_8.0.6.0.0.pdf
https://docs.oracle.com/cd/E60058_01/PDF/8.0.6.x/8.0.6.0.0/OFSAAI_Administration_Guide_8.0.6.0.0.pdf
http://docs.oracle.com/cd/E60058_01/PDF/8.0.2.x/8.0.2.0.0/ig_ofs_aaai_app_pack.pdf
http://docs.oracle.com/cd/E60058_01/PDF/8.0.2.x/8.0.2.0.0/ig_ofs_aaai_app_pack.pdf
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4. Execute the file  

$FIC_HOME/utility/data_security/scripts/grant_data_sec_roles.sql for all 

atomic users found in the previous step. 

5. From the Configuration window in the System Configuration module, select the Allow Data 

Redaction checkbox. 

6. Run the Data Redaction utility. For more details on how to run the utility, see Data Redaction 

section under Data Security and Data Privacy chapter in OFS Analytical Applications 

Infrastructure Administration Guide 8.0.6.0.0. 
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28 Configuring Work Manager in Web Application Servers 

Process Modelling framework requires creation of Work Manager and mapping it to OFSAA 

instance. This configuration is required for WebSphere and WebLogic Web Application Server 

types. 

This section covers the following topics: 

• Configuring Work Manager in WebSphere Application Server 

• Configuring Work Manager in WebLogic Application Server 

28.1 Configuring Work Manager in WebSphere Application Server 

This section is applicable only when the Web Application Server type is WebSphere. 

This section covers the following topics: 

• Creating Work Manager 

• Mapping Work Manager to OFSAA WebSphere Instance 

28.1.1 Creating Work Manager  

6. Open the WebSphere admin console in the browser window: 

http://<ipaddress>:<administrative console port>/ibm/console. (https if SSL is enabled). 

The Login window is displayed. 

 

7. Login with the user id that has admin rights.  
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8. From the LHS menu, expand Resources > Asynchronous beans and select Work 

Managers. 

 

9. Select the required Scope from the drop-down list.  

For example, Node=whf00aqnNode01, Server=server1. 

10. Click New in the Preferences section. 
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11. Enter the Name as ‘wm’ and JNDI name as ‘wm/WorkManager ‘ in the respective 

fields.  

12. Enter the Thread pool properties. 

13. Click Apply. 
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14. Click Save.  

 

After creating work manager successfully, you have to map it to OFSAA instance. 

28.1.2 Mapping Work Manager to OFSAA WebSphere Instance 

15. From the LHS menu, expand Applications > Application Types and select 

WebSphere enterprise applications. 
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16. Click OFSAAI instance hyperlink. 

 

17. Click Resource references link under References section. 



OFSDM 8.0.6.0.0 Installation Guide 

Oracle Financial Services Software 

 

 

287 

 

 

18. Click Browse corresponding to the Work Manager Resource Reference. The available 

resources are displayed. 

 

19.  Select the newly created Work Manager (‘wm’) and click Apply. 
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20. Select the Work Manager (‘wm/WorkManager’) and click OK. 

 

21. Click Save. 
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28.2 Configuring Work Manager in WebLogic Application Server 

This section is applicable only when the Web Application Server type is WebLogic. 

28.2.1 Creating Work Manager 

22. Open the WebLogic admin console in the browser window: 

http://<ipaddress>:<administrative console port>/console. (https if 

SSL is enabled). The Welcome window is displayed. 

 

23. Login with the user id that has admin rights.  

24. From the Domain Structure menu in the LHS, expand Environment and select Work 

Managers. The Summary of Work Managers window is displayed. 
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25. Click New to create a new work manager component. 

 

26. Select Work Manager and click Next.  

 

27. Enter the Name as ‘wm/WorkManager’. 

28. Click Next. 
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29. Select the required deployment target and click Finish.  
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29 Appendix S: FAQs and Error Dictionary 

This appendix consists of resolution to the frequently asked questions and error codes noticed 

during OFSAAI installation. 

• Frequently Asked Questions 

• Error Dictionary 

OFSAAI installer performs all the pre-requisite validation check during installation. Any errors 

encountered in the process are displayed with an appropriate Error Code. You can refer to the 

Error Dictionary to find the exact cause and resolution to rectify the error. 

29.1 Frequently Asked Questions 

You can refer to the Frequently Asked Questions which has been developed with the interest to 

help you resolve some of the OFSAAI Installation and configuration issues. This intends to share 

the knowledge of problem resolution to a few of the known issues. This is not an official support 

document and just attempts to share the knowledge of problem resolution to a few of the known 

issues. 

This section includes the following topics: 

• OFSAAI FAQs 

• Application Pack 8.0.6.0.0 FAQs 

29.1.1 OFSAAI FAQs 

What are the different components that get installed during OFSAAI? 

The different components of OFSAAI are illustrated in Figure in Components of OFSAAI. 

What are the different modes of OFSAAI installation? 

OFSAAI can be installed in two modes, Silent Mode, and GUI mode. 

Can the OFSAA Infrastructure components be installed on multi-tier? 

No. OFSAA Infrastructure components (ficapp, ficweb, ficdb) cannot be installed on multi-tier. By 

default, they will be installed on single-tier. However, OFSAA Infrastructure can be deployed 

within the n-Tier architecture where the Database, Web Server and Web Application Server is 

installed on separate tiers. 

Is JDK (Java Development Kit) required during installation of OFSAA? Can it be 

uninstalled after OFSAA installation? 

JDK is not required during installation of OFSAA and only a run time is needed. For details, see 

Hardware and Software Requirements, Java Runtime Environment section. 
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Is JRE required during installation of OFSAA? Can it be uninstalled after OFSAAI 

installation? 

Only JRE (Java Runtime Environment) is required during installation of OFSAA and cannot be 

uninstalled as the JRE is used by the OFSAA system to work. 

How do I know what are the Operating system, webservers and other software versions 

that OFSAA supports? 

Refer to OFSAA Technology Stack Matrices. 

What are the different files required to install OFSAAI? 

The following files are required: 

• setup.sh. 

• envCheck.sh 

• preinstallcheck.sh 

• VerInfo.txt 

• OFSAAInfrastructure.bin 

• validatedXMLinputs.jar 

• MyResources_en_US.properties 

• log4j.xml 

• OFSAAI_PostInstallConfig.xml 

• OFSAAI_InstallConfig.xml 

• privileges_config_user.sql 

• privileges_atomic_user.sql 

What should I do if I get the following error message during installation: 

"Execute Permission denied"? 

Check whether all the files provided for OFSAAI installation has execute permissions. 

To give execute permissions, 

• Navigate to the path OFSAAI_80200 and execute the command 

chmod 755 

"Graphical installers are not.." 

If error resembles "Graphical installers are not supported by the VM. The console mode will be 

used instead..." then check whether any of the X-windows software has been installed. 

Example: Hummingbird Exceed is started and configured to Graphical mode installation. 
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NOTE:  Type 'xclock' from prompt and this should display clock in graphical mode. 

"No Java virtual machine could be…" 

If the error message reads "No Java virtual machine could be found from your PATH environment 

variable. You must install a VM prior to running this program", then 

• Check whether "java path" is set in PATH variable. See the  Table 3–1, " Prerequisite 

Information"section in this document. 

• Check whether sufficient temporary space is available. 

• Ensure that the movement of OFSAAI Installer text files to the target system is done in the 

Text mode so that setup.sh file does not contain control line feed characters (^M). 

What should I do if I get the following error message during installation, "OracleDriver 

Files Not Found, Please Choose the Right Path To Continue"? 

Check whether the provided path for Oracle Driver files is correct and whether the user has 

permissions to access the files. 

What should I do if I get the following error message during installation, "User must have 

CREATE TABLE, CREATE VIEW, CREATE TRIGGER, CREATE INDEX, CREATE 

SEQUENCE, CREATE PROCEDURE" even though the oracle schema user created has the 

mentioned privileges? 

OFSAAI installer validates the database details provided during installation, so ensure: 

• Whether the oracle schema user has the required set of privileges for successful installation. 

• Whether the oracle schema user has been created with quota privileges on tablespace to 

create database objects. 

See the Table 3–1, "Prerequisite Information" section in this document. 

Installation of OFSAAI was completed successfully! What next? 

Post the successful completion of OFSAAI installation, one has to perform the Post Installation 

steps. See Post Installation Configurations. 

What is to be done when OFSAAI Installation is unsuccessful? 

OFSAAI installer generates log file OFSAAInfrastructure_Install.log in the Infrastructure 

Installation Directory. There is also another log file created in the path configured in Log4j.xml. 

If the logs of any of these reported Warnings, Non Fatal Errors, Fatal Errors or Exceptions, they 

should be brought to the notice of the OFSAAI Oracle Support Services. It is recommended not to 

proceed, until the reported problems are adequately addressed. 

How do I completely uninstall OFSAAI? 

OFSAAI can be completely uninstalled by performing the steps provided in Uninstalling OFSAA 

Infrastructure section in this guide. 
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Can OFSAAI config and atomic schemas be on different databases? 

OFSAAI requires both config and atomic schemas to be present on the same database instance. 

How do I grant privileges if a new information domain is created? 

If you are creating a new information domain, provide a set of privileges (database permissions) 

to the new Atomic schema. 

1. Log into the database as sys and connect as sysdba user. 

2. Execute the file privileges_config_user.sql available under $FIC_HOME 

directory 

3. Enter the database schema for which you want to grant privileges. 

When should I run the MLS utility? 

See the Multiple Language Support (MLS) Utility section in OFS AAI Administration Guide 

available on OTN. 

Does OFSAAI support Oracle Linux versions other than 5.5? 

OFSAAI supports the Oracle Linux versions from 5.5 up to 5.10 and also from 6.0 and above. 

What should I do if I get the following error message on the UNIX System terminal while 

executing ./setup.sh, "Insert New Media. Please insert Disk1 or type its location"? 

1. Login as root user on the Unix machine where OFSAAI is getting installed. 

2. Navigate to the path /etc/security/. 

3. Edit the file limits.conf to add/edit a row for the unix user installing OFSAA: 

<Unix User> soft nofile 9216 

4. After saving the changes, log in as unix user with which OFSAAI is getting installed and 

execute the command: 

ulimit -n 

The command should return the value 9216. 

How do I verify if the system environment is ready for OFSAAI installation? 

To verify the system environment meets the minimum requirements for the installation, a Pre-

Install Check utility is available within the Install Kit archive file. This utility can also be obtained 

separately by contacting Oracle Support. 

See Verifying System Environment section for additional information. 

How do I know if the installation is completed successfully? 

http://docs.oracle.com/cd/E60058_01/homepage.htm


OFSDM 8.0.6.0.0 Installation Guide 

Oracle Financial Services Software 

 

 

296 

 

The OFSAA Infrastructure installation performs a post install health check automatically on 

successful installation of the product. To rerun the post install verification at a later time, perform 

the following steps: 

1. Navigate to the path $FIC_HOME (Product Installation Directory). 

2. Execute the command: 

./piverify.sh 

What should I do if the installation in GUI mode is not invoked? 

There are set of configuration steps required to be performed during the installation in GUI mode. 

Verify whether the steps mentioned under Configuration for GUI Mode Installation section are 

done correctly. 

What should I do if there are any exceptions or errors in installation and how to proceed? 

1. Backup the installation logs. 

2. Share the backup logs with Oracle Support Services. 

What should I do if I get the following error message during OFSAAI installation on Solaris 

11 system?: 

"Error: OFSAAI-1108 

ORA-00604: error occurred at recursive SQL level 1 ORA-01882: timezone region not 

found" 

Or 

"Time zone cannot be set as null or 'localtime' " 

This happens if the time zone is not set, that is NULL or it is set as ’localtime’. Set the 

environment variable TZ to a valid time zone region in the .profile file. For example, 

TZ=Asia/Calcutta  

export TZ 

What should I do if the installation process is abruptly terminated or aborted? 

If the installation process is abruptly terminated, then the installation will be incomplete. To 

recover from this, follow these steps: 

1. Drop the DB objects in the config schema created by OFSAAI installation. 

2. Open the .profile and remove the entries made by the OFSAAI installation which are 

made between the comment statements, #Beginning of entries by OFSAA 

Infrastructure installation and #End of entries by OFSAA Infrastructure installation. 

3. Delete the OFSAA install directory created by the OFSAAI installer. 
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4. Perform the OFSAAI installation again. 

Does OFSAA support any other web server types, other than the ones stated in Tech 

Matrix and Installation Guide? 

No, all the supported softwares and versions are stated in the OFSAA Technology Stack 

Matrices. 

What should I do if the database connection from connection pool displays the following 

error message, "java.sql.SQLRecoverableException: IO Error: Connection reset"? 

This happens while running several database intensive tasks in parallel. To correct this error, add 

the line securerandom.source=file:/dev/./urandom in the java.security configuration file 

available in $JAVA_HOME/jre/lib/security/ path. 

NOTE:  This needs to be configured on all the machines or VMs where the OFSAAI components are 

installed. 

If the issue is not resolved even with the preceding settings, check the MTU (Maximum 

Transmission Unit) settings on the linux box. For details on MTU settings and updating them, 

contact your system Administrator. 

What should I do when I get syntax errors/file not found error messages while invoking 

setup.sh file from my install archive? 

This could mostly happen: 

• When installer was not unzipped rightly or corrupted during unzip. 

• setup.sh file which resides within the install archive was not transferred in ASCII or text 

mode, which could have corrupted the file. 

To correct this, follow the steps: 

1. Copy the installer (in BINARY mode) to the system on which the OFSAA Infrastructure 

components will be installed. 

2. Unzip the installer using the command: 

unzip <OFSAAI_Installer>.zip 

3. The corrupted setup.sh file would have introduced certain ^M characters into the file. 

You can remove ^M characters from setup.sh file by following these steps: 

a. Login to the server where the installer is copied. 

b. Navigate to the directory OFSAAI_80200. 

c. Open the setup.sh file in the vi editor using the command: vi setup.sh. 

d. Inside vi editor in Esc mode, type: %s/^M//g 

http://docs.oracle.com/cd/E55339_01/homepage.htm
http://docs.oracle.com/cd/E55339_01/homepage.htm
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NOTE:  To enter ^M, hold the CTRL key then press V and M in succession. 

e. Save the setup.sh file by typing: wq! 

Does OFSAA support Oracle DB 11g Standard edition? 

The OCI client and the jdbc driver does not change depending on whether it is a standard or 

enterprise edition. So, OFSAAI will work with standard edition as well. 

We do not recommend standard edition because it will not scale and does not support partition 

pack, database security vault, or advanced analytics. 

What should I do if I get the following error message while executing ./startofsaai.sh file on 

the UNIX System terminal "./startofsaai.sh: /java: Execute permission denied"? 

• Ensure JAVA_BIN environment variable path is set on the "unix user" terminal from where 

the startofsaai.sh file is invoked. 

• Ensure the .profile where the environment/ path settings are made has been executed 

successfully. 

What should I do if the OFSAAI Application Server does not proceed even after providing 

the system password? 

Ensure that, the System Password provided when prompted is "password0" provided during 

installation. Also check whether the connection to the "configuration schema" can be established 

through sqlplus. 

Although the OFSAAI installation has completed successfully, when OFSAAI servers are 

started, and the application URL is accessed, it gives an error message "the page cannot 

be found or displayed" or "Could not retrieve list of languages from Server. Please contact 

the system administrator". What should one do? 

Ensure OFSAAI servers have been started and are running successfully. For details on start up 

parameters options, see Starting Infrastructure Services section. 

For more details on the issue, refer to the Revappserver log in $FIC_APP_ 

HOME/common/FICServer/logs directory or the Web Server log files. 

Is it necessary to provide the specified grants to the Oracle schema user before 

installation? If yes, can it be revoked after completing the installation? 

The "Oracle schema" user requires the necessary grants specified before, during, and after the 

installation process. Grants provided should never be revoked as the application makes use of 

these grants all the time. 

Can we have distributed OFSAAI Application Server for load balancing? 
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OFSAAI Application server can be scaled out/distributed across different JVM's (machines) 

based on the various services and Information Domains, in other words, Load balancing could be 

achieved with distribution of services. 

Why do we need FTPSHARE on all the layers? Can we have ftpshare on another machine 

other than the machines where OFSAAI is installed? 

FTPSHARE is a Metadata Repository directory. All the metadata related files used in 

Infrastructure are stored in the FTPSHARE directory. The ftpshare contains folders for each 

Information Domain, with each Information Domain folders holding Erwin, log, and scripts folder. 

The transfer of data among the Web, Application, and Database servers in Infrastructure takes 

place through FTP/SFTP. 

You need to configure FTP/SFTP and enable communication between the servers by providing 

App server's FTP/SFTP credentials to the Web server and DB server users. 

Yes, you can have FTPSHARE on another machine other than the machines where OFSAAI is 

installed. 

Is it mandatory to provide the FTP/SFTP password? 

Yes, OFSAAI needs credentials of the user who has complete permissions on FTPSHARE 

directory, and the user should be able to independently login to the unix server. 

What are the permissions required for FTPSHARE and when should I give them? 

It is recommended to provide permissions on FTPSHARE in case of installations done across 

different machines or VMs (multitier installation). 

In case of single tier installation, 770 permissions can be provided if the Unix users of OFSAAI 

and web server belong to the same Unix group. 

Additionally, any new file that is created in the FTPSHARE folder of any installation layer should 

be granted specific/explicit permission. 

Port Change utility can be used to have the Port number modified, which are currently being used 

by the Infrastructure application. For more information, refer Changing IP/ Hostname, Ports, 

Deployed Paths of the OFSAA Instance section in OFS Analytical Applications Infrastructure 

Administration Guide in OTN. 

Are there any in-built system administration users within OFSAAI Application? 

The three in-built system administration users are provided to configure and setup OFSAAI. 

• SYSADMN 

• SYSAUTH 

• GUEST 

Does OFSAAI Application support both FTP and SFTP? 

http://docs.oracle.com/cd/E60058_01/homepage.htm
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OFSAAI supports both FTP and SFTP configuration. 

Is it necessary to enable the FTP/SFTP services to use the OFSAAI? 

Yes, enabling of FTP/SFTP services and its ports is a pre-requisite step towards using the 

OFSAAI. 

OFSAAI Configuration: Unable to save the server details? 

• Ensure the input User ID, Password, and Share Name are correct. 

• Ensure FTP/SFTP services are enabled. 

• Have a test FTP/SFTP connection made and confirm if they are successful. 

What should I do if I get the following message while creating Information Domain, "Please 

create a database and then create the information domain"? 

Information Domain is mapped to only one Database; and thus before the creation of Information 

Domain, at least one database details should exist. 

What should I do if I get the following message during the startup of backend engine 

message server, "ConnectToDatabase: FatalError, could not connect to the DB server"? 

• Verify whether connection to the Configuration Schema can be established through 

SQL*PLUS. 

• Verify Configuration Schema password is modified post installation. 

• Ensure Oracle Database Alias Name created for Oracle Instance and Oracle Service Name 

are same. 

• On a multi tier installation mode, ensure TNSNAME and SID are same in both the Application 

and Database Layers. 

What should I do if I get the following message during the startup of backend engine 

message server, "Fatal Error, failed to get user ID from LibSmsConnect"? 

Ensure Reveleus.sec file exist under the $FIC_HOME/conf directory where the Database 

components are installed. 

Does OFSAAI Application support LDAP authentication? 

OFSAAI supports LDAP configuration and authentication. 

Does OFSAAI support multiple languages? 

Yes, OFSAAI supports multiple languages. 

Does OFSAAI provide any data back-up features? 

OFSAAI does not have built-in back up facility. External Storage Infrastructure is recommended 

for back-up. 
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What kind of security features does the OFSAAI provide? 

OFSAAI provides security at: 

• Segment Level - Users can access only the segment they are mapped to. 

• Application Level - Users can perform an operation only if mapped to appropriate role and 

functions. 

Does OFSAAI have the ability to enforce periodic password change? 

OFSAAI provides configurable parameters to define number of days after which the user 

password would expire and then the user is forced to change the password after expiration 

period. 

What is the password policy followed in OFSAAI? 

OFSAAI enforces a minimum password length with a combination of Upper and Lower case 

characters and alpha-numeric strings. 

Which version of Erwin Data Modeller does OFSAAI support? 

OFSAAI now supports ERwin version 9.2 and 9.5 generated xmls in addition to ERwin 4.1, ERwin 

7.1, ERwin 7.3 and ERwin 9.0 formats. 

Does OFSAAI provide the mechanism to upload Business Data model? 

OFSAAI provides two mechanisms for business data model upload: 

• Easy to use GUI based Model upload mechanism to upload the Business Data Model 

through Data Model Management -->Data Model Maintenance --> Import Model. 

• OFSAAI also provides a model upload utility "upload.sh" for uploading the business data 

model through the command line parameter by executing this shell script file under the path  

<FIC_HOME>/ficapp/common/FICServer/bin. 

For more details, see Configuration for Model Upload Utility section of the OFS Analytical 

Applications Infrastructure User Guide available on OTN. 

How do I apply incremental change to the existing model when the Business Data model 

undergoes a change? 

Modified data model can be uploaded into the system and OFSAAI has the ability to compare the 

changes within the data model with respect to the one already present in the system and enables 

propagation of incremental changes in a consistent manner. 

What are the different types of uploading a business data Model? 

OFSAAI supports uploading of business data model from client desktop and also by picking up 

the data model from the server location. 

Can the OFSAAI Configuration Schema password be modified post installation? 

http://docs.oracle.com/cd/E60058_01/homepage.htm
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The OFSAAI Configuration Schema password can be modified post installation. OFSAAI 

application stores the password in the database and few configuration files, thus any changes to 

the Configuration Schema password will require updating in those files. For more information, see 

OFSAA Infrastructure Config Schema Password Modification. 

Can the OFSAAI Atomic Schema password be modified? 

The OFSAAI Atomic Schema password can be modified. OFSAAI application stores the atomic 

schema password in the database and few configuration files, thus any change to the atomic 

schema password will require updating those files. 

To change the Atomic Schema password, follow the steps: 

1. Login to OFSAA. 

2. Navigate to System Configuration > Database Details window. Select the appropriate 

connection, provide the modified password and save. 

3. Based on the  Web Server installed, follow the steps: 

a. If you are using Apache  as Web server: 

 Update the <Context> -> Resource tag details in server.xml file from the 

$CATALINA_HOME/conf folder. (In case of Tomcat only Atomic <Resource> will 

exist). 

b. If you are using WebSphere as Web server: 

 Login to the WebSphere Administration Console from the left side menu. 

Navigate to Resources >JDBC >Data Sources. A list of data sources will be populated 

on the right side. 

Select the appropriate Data Source and edit the connection details. (In this case, both 

Config and Atomic data sources need to be modified). 

c. If you are using WebLogic as Web server: 

Login to the WebLogic Administration Console from the left side menu. 

Under Domain Structure list box, expand the appropriate Domain and navigate to 

Services > JDBC >Data Sources. A list of data sources will be populated on the 

right side. 

Select the appropriate Data Source and edit the connection details. (In this case, both 

Config and Atomic data sources need to be modified). 

4. Restart the OFSAAI services 

NOTE:  If the modified passwords are not updated, OFSAAI logs display the message ORA-28000: 

the account is locked. 
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Does the upload of Business Data model depend on Java Memory? 

Business data model upload through OFSAAI depends on the Java memory settings on the client 

and server machines. Java memory setting varies with the data model size and the available 

RAM. Contact Oracle Support Services for more details. 

Why do the Business Metadata Management screens (Business Processors screen) in 

User Interface, take more time to load than other screens? 

The Log file in DynamicServices.xml which resides in $FIC_HOME/conf is continuously being 

updated/refreshed to cache metadata. This can be observed when you are starting startofsaai.sh 

and if any of the log file (For example, SMSService.log) in DynamicServices.xml is being 

continuously refreshed for longer time. 

By default, the Metadata Log file cache size is set to 1000. If in case the log is being updated 

beyond this limit, retrospectively the preceding entries are overwritten. For example, the 1001th 

entry is overwritten by deleting the first entry. This results in the application window taking a 

longer time to load. 

Increase the cache size limit in Dynamicservices.xml located at <FIC_HOME>/conf, depending 

on the currently logged count for the specific metadata. 

1. Generate the Log report by executing the following query in config schema. 

select count(1), t.metadata_name, m.dsn_id  

from metadata_master m, metadata_type_master t  

where m.metadata_type = t.metadata_type 

group by t.metadata_name, m.dsn_id 

2. The preceding query returns a list of codes with their respective metadata count. You 

can refer to "metadata_type_master" table to identify the metadata name. 

3. View the log report to identify the metadata which is being updated/refreshed beyond 

the specified cache size limit. Accordingly increase the cache size limit in 

Dynamicservices.xml depending on the currently logged count for the specific 

metadata. 

For example, if the "MEASURE_CACHE_SIZE" is set to 1000 and total measure reported 

in log is 1022, increase the limit to 2000 (approximately). 

4. Restart Reveleus/OFSAAI servers (Web and APP) and check the issue. 

What should I do if I get OutOfMemoryError while deploying EAR file in WebSphere 

application server? 

The Java memory needs to be increased in ejbdeploy.sh file which is present under <WebSphere 

Install directory>/AppServer/deploytool/itp. For example, 
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$JAVA_CMD \ 

-Xbootclasspath/a:$ejbd_bootpath \  

Xms256m -Xmx1024m \ 

What configurations should I ensure if my data model size is greater than 2GB? 

In order to upload data model of size greater than 2GB from OFSAAI Data Model Management --

>Data Model Maintenance--> Import Model, you need to configure the required model size in 

struts.xml file available in the path $FIC_WEB_ HOME/webroot/WEB-INF/classes. 

NOTE:  The size requirements have to be always specified in bytes. 

For example, if you need to configure for model size of 2.5GB, then you can approximately set 

the max size to 3GB (3221225472 bytes) as follows, in order to avoid size constraints during 

model upload. 

<constant name="struts.multipart.maxSize" value="3221225472"/> 

After configuring struts.xml file, generate the application EAR/WAR file and redeploy the 

application onto your configured web application server. For more information on generating and 

deploying EAR / WAR file, see Appendix C. 

What should I do if my Hierarchy filter is not reflecting correctly after I make changes to 

the underlying Hierarchy? 

In some cases, the Hierarchy Filters do not save the edits correctly if the underlying Hierarchy 

has been changed. This can occur in hierarchy maintenance, where you have moved a member 

to another hierarchy branch, and that member was explicitly selected in the Filter and is now a 

child of a node which is already selected in the Filter. Refer Support Note for the workaround. 

Can I install an Application Pack on an existing Atomic schema/ Information Domain 

created manually? 

No, you cannot install an Application Pack on existing Atomic schema/Information Domain 

created manually. Application Packs can be installed only on Atomic Schemas/Information 

Domain created using schema creator utility and/ or the Application Pack installer. 

What should I do if I get the following exception while trying to view the model outputs in 

Model Outputs screen, "Exception ->Local Path/STAGE/Output file name (No such file or 

directory)"? 

Ensure you have created a folder "STAGE" under the path mentioned as "Local Path" in the web 

server details window. This folder needs to be created under the local path on every node, in 

case of web application server clustering. 

What should I do if I get the following exception during OFSAA services startup, 

"Exception in thread "main" java.lang.UnsatisfiedLinkError: net (Not a directory)"? 
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Ensure the JRE referred in .profile is not a symbolic link. Correct the path reference to point to a 

physical JRE installed. 

What is the optimized memory settings required for "New" model upload? 

The following table lists the optimized memory settings required for "New" model upload. 

Model Upload Options Size of Data Model 
XML File 

X_ARGS_APP ENV 

Variable in OFSAAI 
APP Layer Pick from Server 106 MB "-Xms1024m 

-Xmx1024m 

36 MB "-Xms2048m 

-Xmx2048m 

815 MB "-Xms4096m 

-Xmx4096m 

1243 MB "-Xms6144m 

-Xmx6144m 

Model Upload Utility 106 MB 
"-Xms1024m 

-Xmx1024m"-Xms2048 

m -Xmx2048m 

336 MB 
"-Xms4096m 

-Xmx4096m 

815 MB 
"-Xms4096m 

-Xmx4096m 

1243 MB 
"-Xms6144m 

-Xmx6144m 

Save New Erwin file in 

Server 

106 MB 
"-Xms1024m 

-Xmx1024m 

336 MB 
"-Xms2048m 

-Xmx2048m 
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"-Xms4096m 

-Xmx4096m 

 
"-Xms6144m 

-Xmx6144m 

I did not enable OFS Inline Processing Engine Application license during the installation. 

However, I have enabled it post installation, using the Manage OFSAA Product License(s) 

in the Admin UI. Are there any other additional configurations that I need to do? 

Yes. Follow the instructions explained in the OFS Inline Processing Engine Configuration Guide 

available on OTN. 

I get an error when I try to build an Oracle OLAP cube. What should I do? 

Execute the following grant on the appropriate ATOMIC schema 

grant olap_user to &database_username 

How do you turn off unused Information Domains (Infodoms) from caching? 

Follow these steps to turn off unused infodoms from caching: 

1. Navigate to $FIC_HOME/conf in the APP layer of your OFSAAI installation. 

2. In the DynamicServices.xml file, identify the section for <Service code="20">. 

3. Modify the value of parameter CACHE_ON_STARTUP to 0 (default is 1). 

4. Repeat the same in the WEB layer too. Generate the application EAR/WAR file and 

redeploy the application onto your configured web application server. For more 

information on generating and deploying EAR / WAR file, see the Appendix C section. 

5. Restart the OFSAAI Services (APP and WEB). For more information, see the Starting 

Infrastructure Services section. 

NOTE:  This setting will cache the Infodom metadata only for the infodoms that get accessed upon 

user login. Infodoms which do not get accessed, will not be cached. 

Sample code is as follows: 

<SERVICE CODE="20" 

CLASS="com.iflex.fic.metadata.services.MetadataServiceProvider" 

NAME="BMD" 

SERVERID="DEFAULT" PATH=" " LOGGERNAME="UMMLOGGER" LOGGERLEVEL="10"> 

<PARAMETERS> 

<PARAMETER NAME="CACHE_ON_STARTUP" VALUE="0" /> 

<PARAMETER NAME="BACKUP_XML" VALUE="1" /> 

http://docs.oracle.com/cd/E60058_01/homepage.htm
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<PARAMETER NAME="MAX_BACKUP_XML" VALUE="2" /> 

<PARAMETER NAME="PC_NONBI_BI_SWITCH" VALUE="2048" /> 

<PARAMETER NAME="HIERARCHY_NODE_LIMIT" VALUE="2000" /> 

<PARAMETER NAME="ALIAS_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="DATASET_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="MEASURE_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="HIERARCHY_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="DIMENSION_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="HIERARCHYATTRIBUTE_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="CUBE_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="RDM_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="BUSINESSPROCESSOR_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="DERIVEDENTITY_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="LOG_GET_METADATA" VALUE="false" /> 

<PARAMETER NAME="METADATA_PARALLEL_CACHING" VALUE="0" /> 

</PARAMETERS> 

</SERVICE> 

While creating an Excel Mapping, after specifying the excel worksheet, the target table, and 

mapping each column in the worksheet to a target table, I click Save and nothing happens. 

But when I click Cancel, a message pops up informing me that all changes will be discarded", 

what is to be done. 

Check if the version of Internet Explorer and JRE Plugin are as mentioned in the Desktop 

Requirements section of this manual. If not, use the qualified versions as mentioned. 

Can multiple OFSAA Infrastructure instances share the same Config Schema? 

No, only one OFSAA environment can be installed using one Config Schema. 

Can Atomic Schema be shared? 

Yes, it can be shared between two OFSAA instances. 

While setting a firewall, which ports should be opened for communication between the Web 

Server (Apache HTTP Server/ Oracle HTTP Server/ IBM HTTP Server) and the Web Application 

Server (WebSphere/ WebLogic/ Tomcat) for OFSAAI to operate properly? 

The OFSAA Servlet port which is same as Web server port should be open. Also the web application 

port should be open. 

Can I modify the NLS_LENGTH_SEMANTICS to BYTE from CHAR for the Database where 

older versions of OFSAA is Installed? 

Yes, NLS_LENGTH_SEMANTICS can be modified to BYTE from CHAR if you are not intending to 

use multi language support. 
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Can I install already installed application in a different infodom? 

No, it is not possible to install the same application in two different infodoms. 

How can I configure the OFSAA application for High Availability? 

OFSAA can have active-passive high availability. For more details, refer Configuration for High 

Availability- Best Practices Guide. 

During OFSAA installation should I provide web application server's IP /Hostname and port 

or web server's IP/Hostname and port, if the Apache HTTP Server/ Oracle HTTP Server/ IBM 

HTTP Server are configured? 

In case the web server is configured, you should enter the Web Server IP Address/Hostname and 

Port details during OFSAA installation. Here the Servlet port should be same as the Web Server 

port. 

If Web Server is not configured, the Web Application Server's IP Address/ Hostname and Port is 

required during the installation process. Here the Servlet port should be same as the Web 

application Server port. 

Is "ReveleusAdminConsoleAgent" applicable for OFSAAI 8.0.6.0.0 and higher versions? 

No, ReveleusAdminConsoleAgent is not applicable starting OFSAAI 7.3.3.0.0. There is a change in 

the way agentservers are managed through AGENTSTARTUP.SH and AGENTSHUTDOWN.SH. 

What should I do when the message server process does not open and I get the following 

error message, "CI18NProvider::CI18NProvider, Error, unable to connect to the config 

database"? 

This error is displayed due to the following reasons: 

The Config Schema password is already expired. 

If the Config Schema password is going to expire soon and the message like "ORA-28002: the password 

will expire within 6 days" displays while connecting to Config Schema through SQLPlus. 

The Config Schema password is modified. 

To resolve the error, re-set the Config Schema password to the old password. Else, if the Config 

Schema password is modified to something else then follow these steps: 

1. Delete the $FIC_HOME/conf/Reveleus.SEC file. 

2. Shutdown the OFSAAI App service: cd $FIC_APP_ 

HOME/common/FICServer/bin ./stopofsaai.sh 

3. Shutdown the OFSAAI App service: cd $FIC_APP_ 

HOME/common/FICServer/bin ./stopofsaai.sh 

4. Start the Infrastructure Server in foreground directly on the server or through 

XWindows software using the command: ./startofsaai.sh 

5. Enter System Password. 
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6. Enter the new Config schema password. The service starts and initializes if it is able to 

successfully connect to the DB and generates the Reveleus.SEC file. 

7. Post successful startup of the service, if required, the Infrastructure server may be shut 

down and restarted in the background using nohup mode. 

What is the mechanism of Log File sizing and backup? 

OFSAAI Log files created under $FIC_APP_HOME/common/FICServer/logs & 

<OFSAAI_DEPLOYED_AREA>/<CONTEXT.war>/logs is configurable in RevLog4jConfig.xml. 

The default size of the log files (MaxFileSize) is set to 5000kb and number of maximum backup log 

files (MaxBackupIndex) retained is set to 5, both of which are configurable. Increasing these 

parameters to a higher value should depend on the server hardware configurations and may reduce 

the performance. 

To configure the Logs file size on OFSAA Application server, follow these steps: 

1. Navigate to $FIC_HOME/conf where OFSAA is installed. 

2. Edit the following parameters in the file RevLog4jConfig.xml 

 param name="file" : Enter the path where the Logs are to be generated. 

 param name="MaxFileSize" : Provide the required file size. 

param name="MaxBackupIndex" : Provide the required number of backup files to be 

created. 

Example: 

<appender name="REVSERVERAPPENDER" 

class="org.apache.log4j.RollingFileAppender"> 

<param name="file" value="$FIC_ 

HOME/ficapp/common/FICServer/logs/RevAppserver.log"/> 

<param name="Append" value="true" /> 

<param name="MaxFileSize" value="5000kb" /> 

<param name="MaxBackupIndex" value="5" /> 

<layout class="org.apache.log4j.PatternLayout"> 

<param name="ConversionPattern" value="[REVELEUSLOG] %m%n"/> 

</layout> 

</appender> 

To configure the Deployed area logs file, follow these steps: 

1. Navigate to <EAR/WAR Deploy area>/conf folder. 

2. Repeat step 2 from the preceding section. 

Can we modify the Log file path? 
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Yes, Log file path is configurable, it can be configured in RevLog4jConfig.xml file. The default log file 

path (file) is set by the installer. This can be configured to another path. 

Can I point the environment with HTTP enabled to HTTPS after installation and vice versa? 

Follow these steps: 

1. Create SSL related certificates and import to respective servers. 

2. Enable SSL on a desired Port (example 9443) on your existing and already deployed 

web application servers. 

3. Replace the protocol as https and new ssl port (FIC_SERVLET_PORT) configured and 

in all the URLs specified on the following files: 

$FIC_HOME/ficapp/common/FICServer/conf/FICWeb.cfg and 

$FIC_HOME/ficweb/webroot/conf/FICWeb.cfg 

$FIC_HOME/ficapp/icc/conf/WSMREService.properties 

$FIC_HOME/ficweb/webroot/conf/ModelExecution.properties 

$FIC_HOME/ficdb/conf/MDBPublishExecution.properties 

$FIC_HOME/ficdb/conf/ObjAppMap.properties 

$FIC_HOME/utility/Migration/conf/WSMigration.properties 

$FIC_HOME/utility/WSExecution/conf/WSExecution.properties 

$FIC_HOME/EXEWebService/WebSphere/ROOT/WEB-INF/wsdl/EXEWebSe 

rviceImpl.wsdl 

$FIC_HOME/EXEWebService/Tomcat/ROOT/WEB-INF/wsdl/EXEWebServic 

eImpl.wsdl 

$FIC_HOME/EXEWebService/weblogic/ROOT/WEB-

INF/wsdl/EXEWebServiceIm pl.wsdl 

4. Replace XML attribute/Node values as specified on the following files: 

$FIC_HOME/ficweb/webroot/WEB-INF/web.xml 

FIC_WEBSERVER_PORT=9443 

FIC_WEBPROTOCOL=https 

$FIC_HOME/conf/LookUpServices.xml and $FIC_ 

HOME/ficweb/webroot/conf/LookUpServices.xml 

PORT="9443" PROTOCOL="https:" 

5. Login to Config Schema and execute the following SQL command to replace protocol 

and SSL port. 
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SQL> update configuration cn set cn.paramvalue='9443' where 

cn.paramname='SERVLET_ENGINE_PORT'; 

SQL> update configuration cn set 

cn.paramvalue=replace(cn.paramvalue,'http:','https:') where 

cn.paramname='FormsManagerCacheReload'; 

SQL> update web_server_info ws set 

ws.servletport='9443',ws.servletprotocol='https'; 

6. Create EAR/WAR file and Re-Deploy. 

What should I do if my HIVE connection fails with the following exception: 

java.sql.SQLException: [Cloudera][HiveJDBCDriver](500164) Error 

initialized or created transport for authentication: 

[Cloudera][HiveJDBCDriver](500168) Unable to connect to server: GSS 

initiate failed. 

com.ibm.security.krb5.KrbException, status code: 37 

message: PROCESS_TGS at 

com.ibm.security.krb5.KrbTgsRep.<init>(KrbTgsRep.java:20) 

This happens if there is a clock skew between the client and the KDC server. To resolve 

this, there are two solutions: 

 Solution 1: 

Synchronize the clocks between the servers. For more information, see 

http://docs.oracle.com/cd/E19253-01/816-4557/setup-192/index.html 

 Solution 2: 

1. Set clockskew parameter on the server side (KDC) krb5.conf file and replace the 

same file in HIVE_LIBRARY_PATH folder. Parameter value should be decided on 

the basis of the time difference between the two machines. 

2. Get the epoch time on the two servers by firing “date +%s” on the command line. 

3. Clockskew param value should be chosen as a value sufficiently larger than the 

difference of the preceding two calculated values. 

4. Set “clockskew = <value>” in the /etc/krb5.conf on the KDC server. 

5. Restart Kerberos services. 

What should I do if my schema creator log has the following exception:  

Failed to detect a valid hadoop home directory java.io.IOException: 

HADOOP_HOME or hadoop.home.dir are not set. at 

org.apache.hadoop.util.Shell.checkHadoopHome(Shell.java:302) 

at org.apache.hadoop.util.Shell.<clinit>(Shell.java:327) 

http://docs.oracle.com/cd/E19253-01/816-4557/setup-192/index.html
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at org.apache.hadoop.util.StringUtils.<clinit>(StringUtils.java:79)  

at org.apache.hadoop.security.Groups.parseStaticMapping(Groups.java:130) 

at org.apache.hadoop.security.Groups.<init>(Groups.java:94)  

at org.apache.hadoop.security.Groups.<init>(Groups.java:74)  

at org.apache.hadoop.security.Groups.getUserToGroupsMappingService(Groups.java:30 

3) 

at org.apache.hadoop.security.UserGroupInformation.initialize(UserGroupInformation.ja 

va:283) 

at org.apache.hadoop.security.UserGroupInformation.setConfiguration(UserGroupInfor 

mation.java:311) 

at HdfsDbUtil.connect(HdfsDbUtil.java:162) 

at SchemaParserUtil.validateHiveConnection(SchemaParserUtil.java:1359) at      

SchemaParserUtil.checkAllPreChecks(SchemaParserUtil.java:1011) 

at Main.execute(Main.java:317) 

at Main.main(Main.java:145) 

This occurs when HADOOP_HOME environment variable is not set. You can ignore this 

exception since we do not mandate to install HIVE where OFSAA is installed. 

What should I do if the sliced data model upload takes a long time to complete? 

If the metadata cache size is set to a lower value than the actual count of each metadata 

type (hierarchy, dataset, dimension etc), then it gets into performance degrade issues. We 

have to increase the cache size for each metadata type according to the count in the 

environment. 

Following are the parameters in DynamicServices.xml to be configured depends on the 

metadata count in your environment. 

<PARAMETER NAME="HIERARCHY_NODE_LIMIT" VALUE="2000"/> 

<PARAMETER NAME="ALIAS_CACHE_SIZE" VALUE="1000"/> 

<PARAMETER NAME="DATASET_CACHE_SIZE" VALUE="2000"/> 

<PARAMETER NAME="MEASURE_CACHE_SIZE" VALUE="3000"/> 

<PARAMETER NAME="HIERARCHY_CACHE_SIZE" VALUE="2000"/> 

<PARAMETER NAME="DIMENSION_CACHE_SIZE" VALUE="2000"/> 

<PARAMETER NAME="CUBE_CACHE_SIZE" VALUE="1000"/> 

<PARAMETER NAME="BUSINESSPROCESSOR_CACHE_SIZE" VALUE="2000"/> 

<PARAMETER NAME="DERIVEDENTITY_CACHE_SIZE" VALUE="1000"/> 

Metadata count can be derived based on the following queries: 

select count(1) from metadata_master where metadata_version=0  --- 

for all metadata 
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select count(1) from metadata_master where metadata_version=0 and 

metadata_type=1  --- for measure 

select count(1) from metadata_master where metadata_version=0 and 

metadata_type=2  --- for Dimension 

select count(1) from metadata_master where metadata_version=0 and 

metadata_type=3  -- for HCY 

select count(1) from metadata_master where metadata_version=0 and 

metadata_type=4  --- for DATASET 

select count(1) from metadata_master where metadata_version=0 and 

metadata_type=59  --- for BP's 

select count(1) from metadata_master where metadata_version=0 and 

metadata_type=54  --- for Alias 

select count(1) from metadata_master where metadata_version=0 and 

metadata_type=5  --- for CUBES 

select count(1) from metadata_master where metadata_version=0 and 

metadata_type=856 --- for Derived Entity 

For LDAP authentication, which server connects with the LDAP server, the 

Application server (where ofsaai is installed), or Web Application server (where EAR 

is deployed)? 

For LDAP authentication, the Application server (ficapp) connects with the LDAP server. 

The LDAP server in the setup listens on secure protocol ldaps (port 636). I have the root 

certificate of the LDAP server for SSL, and would like to know where to offload this 

certificate? 

You need to import the certificate into the JDK/JVM used by Reveleus server in ficapp 

layer. 

How to relocate FTPSHARE folder? 

You can run the PortC.jar utility. For more details, refer Changing IP/ Hostname, Ports, 

Deployed Paths of the OFSAA Instance section in the OFSAAI Admin Guide available on 

OTN. 

How do we identify the list of ports that are used by/configured in an OFSAA 

environment? 

1. Navigate to $FIC_HOME folder on Target. 

2. Run the PortC.jar utitlity using the command: 

java -jarPortC.jar DMP 

A file with the name DefaultPorts.properties will be created under $FIC_ HOME directory 

which will contain the ports. For more information, refer Changing IP/ Hostname, Ports, 

http://docs.oracle.com/cd/E60058_01/homepage.htm
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Deployed Paths of the OFSAA Instance section in the OFSAAI Admin Guide available on 

OTN. 

NOTE:  This feature is available only after applying 7.3.5.2.0 Minor Release patch. 

What should I do if I get the following error message, "Error while fetching open 

cursor value Status : FAIL"? 

This error occurs while executing envCheck.sh because the user does not have access to 

V$parameter. This error does not occur due to sysdba or non sysdba privileges provided 

they have access/grants to V$parameter. 

What should I do when an entity containing many attributes (>100 columns) is 

selected as Source entity and the Data Mapping (T2T definition) save operation takes 

longer than expected with the hourglass in the UI continuously rotating? 

The workaround is: 

1. Locate the webserver deployed area webroot/conf/excludeURLList.cfg file. 

2. Modify the following entries: 

• [SQLIA]./dataIntegrator/ to [ALL]./dataIntegrator/ 

• [SQLIA]./ETLExtractionServlet to 

• [ALL]./ETLExtractionServlet 

3. Save the changes and restart the webserver. 

4. Resave the definition. 

What should I do if I get the following error message when I try to start the OLAP 

server: 

./olapdataserver: error while loading shared libraries: 

libessapinu.so:  

cannot open shared object file: No such file or directory FATAL 

ERROR :- OLAP DATA SERVER start up failed. 

This error occurs when OLAP component is not configured and OLAP feature in 

OFSAA is not used. However, this error can be ignored. 

29.1.2 Application Pack 8.0.6.0.0 FAQs 

What is an Application pack? 

An Application Pack is suite of products. For more information, see Application Packs. 

Can I get a standalone installer for OFSAAI 8.0? 

No. AAI is part of every application pack and installs automatically. 

How does OFSAA 8.0 Application pack relate to OFSAA 7.x series? 

http://docs.oracle.com/cd/E60058_01/homepage.htm
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8.0 is a new major release consolidating all products from OFSAA product suite. 

Can existing OFSAA 7.x customers upgrade to OFSAA 8.0 Application Pack?  

There is no upgrade path available. However, we have migration kit / path for every product to 8.0 

application pack. Further details are available with Oracle Support. 

Does OFSAA 8.0 Application pack UPGRADE’s automatically existing environments? 

No.  OFSAA 8.0 application pack has to be installed in a new environment and subsequently 

migration path / migration kit needs to be run to migrate from 7.x to 8.0. Please note we have 

migration path only from the previously released version of OFSAA products. 

Where can I download OFSAA 8.0 Application Pack? 

You can download the OFSAAI 8.0 Application Pack from Oracle Software Delivery Cloud 

(OSDC). 

What are the minimum system and software requirements for OFSAA 8.0 Application 

Pack? 

See installation guide section Hardware and Software Requirements section. 

Is my environment compatible with OFSAA 8.0 Application Pack?  

Environment Check utility performs the task. It is part of install and can also be run separately. 

Has OFSAA 8.0 Application Pack is supports all Operating systems? 

LINUX, AIX, SOLARIS 10, 11. Refer to Technology Matrix for the technology matrix that OFSAA 

suite products are to be qualified. 

How can I install OFSAA 8.0 Application Pack? 

Refer to Installation and Configuration Guide published in OTN for the application pack installers. 

Do we need any License Key to install? 

No, you do not need any License Key to install. 

Does this installation require any Third party Software?  

Oracle Financial Services Advanced Analytical Infrastructure Installation and Configuration Guide 

published in OTN lists the third party software that needs to be installed. 

What languages are supported during OFSAA 8.0 Application Pack installation? 

US English is the language supported. 

What mode of installations OFSAA Application Pack supports? [i.e., Silent , GUI] 

OFSAA Application Packs supports both, GUI and Silent Mode. 

Does OFSAA 8.0 Application Pack support Multi tier Installations? 

OFSAA 8.0 does single tier installation.  

https://edelivery.oracle.com/osdc/faces/Home.jspx
http://docs.oracle.com/cd/E55339_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm


OFSDM 8.0.6.0.0 Installation Guide 

Oracle Financial Services Software 

 

 

316 

 

Does this Application Pack validate all Pre-requisites required for this installation i.e., 

Memory, Disk Space etc.? 

Yes.  The pre-requisite checks are done by the respective application pack installer. 

What happens if it aborts during installation of any application with in Application pack? 

Customer needs to restore the system and retrigger the installation. 

Does this Application pack ‘Rolls Back’ if any of application installation fails due to 

errors? 

Rollback of installation is not supported. 

Does the Application pack installs all applications bundled? 

All application pack system files are installed but there is an option to enable the licensed 

products. 

How can I re-install any of the Application Pack? 

You can retrigger in case of failure. 

Does Application pack allow enabling / disabling any of the applications installed? 

Yes.  You cannot disable once the product is enabled in an environment. 

I have installed one application in a Application pack and can I install any of new 

applications within the Application pack later point of time? 

No, installation is not required.  Enabling the application is an option to use it later. 

How many OFSAA Infrastructures can be installed in a single server? 

There is no issue in installing separate OFSAAI installations, each with their own PFT/FTP 

installations and separate associated database instances and separate Web Server installations 

on the same server as long as adequate memory is allocated for each instance and as long as 

each OFSAAI installation is installed using a separate UNIX user and profile. Care should be 

taken if running multiple OFSAAI installations on a single server. Adequate memory is required 

for each installation as several OFSAAI processes (model upload, DEFQ services, etc) take 

significant amounts of memory. So it depends on your server memory. 

Is it possible to Install OFSAA 8.0 Application pack on any one of the existing ‘infodom’ 

where another OFSAA 8.0 application is installed? 

Yes. However, Behavioral Detection Application Pack and Compliance Regulatory Reporting 

Application Pack, are the exceptions. They must be installed in a different infodom. 

Is there any option in Application pack for the user to select Infodom during installations? 

Yes. You can select or change the required infodom.  
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Can I install all Application Packs in a ‘Single Infodom’? 

Yes.  But Behavioral Detection Pack, Compliance Regulatory Reporting Pack, Asset 

Liability Management Application Pack and Profitability Application Pack are the 

exceptions. They must be installed in a different infodom. 

Is it possible to install applications on different Infodom within the Application pack? (That 

is if you want to install LRM & MR in two infodoms) 

Applications within application pack have to be installed in the same information domain in the 

same environment. 

How many Infodoms can be created over a single OFSAA Infrastructure of 8.0.1.0.0? 

You can install only one infodom during installation. But after installation, you can create multiple 

infodoms. 

Is the ‘Data Model’ bundled specific to an Application Pack or to an individual application? 

A merged data model for all applications within the application pack is bundled and uploaded. 

Is it possible to install OFS Enterprise Modeling later? 

OFS Enterprise Modeling is a separate product and can be enabled as an option later from any 

application pack that bundles Enterprise Modeling. 

Does OFS Enterprise Modeling is required for all applications? 

This product is enabled depending on the applications that use the features of OFS Enterprise 

Modeling. 

Application pack creates sandbox automatically for the required applications? 

Yes, Sandbox creation is part of application install process. 

Do we have upgrade Kits for individual applications or it’s an Application Pack Upgrade? 

Maintenance Level (ML)/ Minor Release (ML)/ upgrades are available across all applications.  

Can I upgrade AAI only? 

Yes, you can upgrade AAI alone. 

Can I upgrade one application within the Application Pack? That is, LRM is upgraded in 

Treasury Application Pack, but MR is not upgraded. 

No. Not possible. Upgrade is applied across packs. 

Is it possible to uninstall any Application from the Application Pack? 

No, it is not possible to uninstall any Application from the Application Pack. 

Can I uninstall entire Application Pack? 

No, you cannot uninstall the Application Pack. 
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Is it possible to uninstall only application and retain AAI in the installed environment? 

No, you cannot uninstall only the application and retain AAI in the installed environment. 

Does Application Pack contain all Language Packs supported? 

Language Packs are installed on top of 8.0 Application Pack. Releases are planned post the 8.0 

availability. 

Can I install an Application Pack over another Application Pack (that is same infodom or 

different infodom)? 

Yes, you can install an Application Pack over another Application Pack in the same information 

domain or different information domain. But Behavioral Detection Application Pack and 

Compliance Regulatory Reporting Application Pack, Asset Liability Management Application Pack 

and Profitability Application Pack are the exceptions. They must be installed in a different 

infodom. 

Can I use an existing manually created schema as information domain for application pack 

installation? 

No. Schemas required by OFSAA applications have to be created using Schema Creator Utility. 

Does OFSAA 8.0 support on WebLogic 10.3.6 with Oracle 12c? 

Yes, OFSAA 8.0 supports WebLogic 10.3.6 with Oracle 12c. WebLogic 10.3.6 supports oracle 

12c with some additional configurations. See the link 

http://docs.oracle.com/cd/E28280_01/web.1111/e13737/ds_12cdriver.htm#JDBCA655 for 

additional configurations. 

While running the schema creator utility, I get an error “HostName in input xml is not 

matching with the local hostname”? 

One possible reason could be the machine is configured for zonal partitioning. Ensure all the 

known IP Addresses of the machine are present in the /etc/hosts file. 

"While creating an Excel Mapping, after specifying the excel worksheet, the target table, 

and mapping each column in the worksheet to a target table, I click SAVE and nothing 

happens. But when I click CANCEL, a message pops up informing me that all changes be 

discarded", what is to be done. 

Check if the excel mapping creation is done using I.E 8 with JRE 1.4 plug in enabled on machine. 

If so, upgrade the JRE plug in to 1.7+ 

What are the Java versions supported in OFS DM Application Pack version 8.0.6.0.0? 

OFS DM Application Pack supports Java 1.6.x, 1.7.x and 1.8.x. 

http://docs.oracle.com/cd/E28280_01/web.1111/e13737/ds_12cdriver.htm#JDBCA655
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Is this release of the OFS DM Application Pack version 8.0.6.0.0 supported on Java 8? 

Yes. To install this release of the OFS DM Application Pack version 8.0.6.0.0 on Java 8. For more 

information, refer to specific notes mentioned in the sections Installer and Installation 

Prerequisites, Configurations supported for Java 8, Configuring the Schema Creator Utility, GUI 

Mode Installation, SILENT Mode Installation. 

What should I do when I get "[ERROR] - Error : APP Setup bin file failed." Message during 

OFS_Application_PACK installation? 

This is a generic error message that appears during application installation failure. You should 

check the installation log files for more information about what failed the installation. However, if 

the message is displayed and the log files are not generated, it could be that it is a temp directory 

issue. The resolution is that your UNIX administrator has to disable the NOEXEC option. The 

installers extract the installation files into the /tmp directory, and if NOEXEC is enabled, execution 

of binaries will not happen in the directory and the installation fails. Re-run the installer after the 

configuration is changed. For detailed information, see the support note at  

https://support.oracle.com/epmos/faces/DocumentDisplay?id=2340045.1.https://support.oracle.co

m/epmos/faces/DocumentDisplay?id=2340045.1 

29.2 Error Dictionary 

The content of this section has been created with the interest to help you resolve the installation 

issues if any. There is a compilation of all the possible errors that might arise during the 

installation process with the possible cause and the resolution to quickly fix the issue and proceed 

further with the installation. 

29.2.1 Accessing Error Dictionary 

Instead of scrolling through the document to find the error code, you can use the pdf search 

functionality. In the "Find" dialog available in any of the Adobe Acrobat version that you are using 

to view the pdf document, follow the below instructions to quickly find the error resolution. 

1. With the Installation PDF open, press Ctrl+F or select Edit → Find. 

The Find dialog is displayed. 

2. Enter the error code that is displayed on screen during Infrastructure installation. 

3. Press Enter. The search results are displayed and highlighted as follows. 

https://support.oracle.com/epmos/faces/DocumentDisplay?id=2340045.1
https://support.oracle.com/epmos/faces/DocumentDisplay?id=2340045.1
https://support.oracle.com/epmos/faces/DocumentDisplay?id=2340045.1
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Error Dictionary 

View the details of the issues, its cause, and resolution specific to the error code. Repeat the 

step to find an answer to any other errors that you notice during installation. If you are not 

able to resolve the issue even after following the steps provided in resolution, you can contact 

support.oracle.com along with log files and appropriate screen shots. 

29.2.2 Error Code Dictionary 

29.2.2.1 Error Code - OFSAAI-1001 

Cause Unix shell is not "korn" shell. 

Resolution Change the shell type to "korn". Use chsh unix command to change SHELL 

type. 

Shell type can also be changed by specifying shell path for the Unix user in 

/etc/passwd file. 

Note: chsh command is not available in Solaris OS.Cause 

29.2.2.2 Error Code - OFSAAI-1002 

Cause No proper arguments are available. 

Resolution Provide proper arguments. Invoke Setup.sh using either SILENT or GUI mode. 

Example: ./Setup.sh SILENT or ./Setup.sh GUI 

29.2.2.3 Error Code - OFSAAI-1004  

Cause File .profile is not present in $HOME. 

Resolution Create .profile in $HOME, i.e. in the home directory of user. 
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29.2.2.4 Error Code - OFSAAI-1005 

Cause File OFSAAInfrastructure.bin is not present in current directory. 

Resolution Copy OFSAAInfrastructure.bin into installation kit directory. 

29.2.2.5 Error Code - OFSAAI-1006 

Cause File CustReg.DAT is not present in current directory. 

Resolution Copy CustReg.DAT into installation kit directory. 

29.2.2.6 Error Code - OFSAAI-1007 

Cause File OFSAAI_InstallConfig.xml is not present in current directory. 

Resolution Copy OFSAAI_InstallConfig.xml into installation kit directory. 

29.2.2.7 Error Code - OFSAAI-1008 

Cause File validateXMLInputs.jar is not present in current directory. 

Resolution Copy validateXMLInputs.jar into installation kit directory. 

29.2.2.8 Error Code - OFSAAI-1009 

Cause File log4j.xml is not present in current directory. 

Resolution Copy log4j.xml into installation kit directory. 

29.2.2.9 Error Code - OFSAAI-1010 

Cause Unknown error occurred. 

Resolution Make sure to provide proper argument (SILENT or GUI) to the Setup.sh file. 

29.2.2.10 Error Code - OFSAAI-1011 

Cause XML validation failed. 
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Resolution Check InfrastructurePreValidations.Log for more details. 

29.2.2.11 Error Code - OFSAAI-1012 

Cause Property file with locale name does not exist. 

Resolution Copy MyResources_en_US.properties to the setup kit directory and keep 

en_US in LOCALE tag of OFSAAI_InstallConfig.xml 

29.2.2.12 Error Code - OFSAAI-1013 

Cause File OFSAAI_InstallConfig.xml/OFSAAI_PostInstallConfig.xml 

not found. 

Resolution Copy OFSAAI_InstallConfig.xml/OFSAAI_PostInstallConfig.xml 

to the setup kit directory. 

29.2.2.13 Error Code - OFSAAI-1014 

Cause XML node value is blank. 

Resolution Make sure all node values except SMTPSERVER, PROXYHOST, 

PROXYPORT, PROXYUSERNAME, PROXYPASSWORD, 

NONPROXYHOST, or RAC_URL are not blank. 

29.2.2.14 Error Code - OFSAAI-1015 

Cause XML is not well formed. 

Resolution Execute the command dos2unix OFSAAI_InstallConfig.xml to convert 

plain text file from DOS/MAC format to UNIX format. 

OR 

Make sure that OFSAAI_InstallConfig.xml is valid. Try to open the file 

through Internet Explorer for a quick way to check validity. If it is not getting 

opened, create new OFSAAI_InstallConfig.xml using the 

XML_Utility.jar. 
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29.2.2.15 Error Code - OFSAAI-1016 

Cause User installation directory contain blank spaces. 

Resolution Provide an installation path that does not contain spaces. Check the tag 

USER_INSTALL_DIR in OFSAAI_InstallConfig.xml file. This path should 

not contain any spaces. 

29.2.2.16 Error Code - OFSAAI-1017 

Cause User installation directory is invalid. 

Resolution Provide a valid installation path. Check if you are able to create the directory 

mentioned in USER_INSTALL_DIR tag value of 

OFSAAI_InstallConfig.xml file. 
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